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阅读指南

如何阅读本手册

本手册中的每个条目都遵循相同的结构。左侧列出操作路径和技术细节, 右侧以暖色侧栏始终
提供简单易懂的说明。每行开头的小图标会让您 一眼就能识别接下来是哪种类型的信息。

四种图标

在哪里能找到? 应用程序中具体的点击路径 —— 菜单栏、检查器章节 或新手模式的步
骤。相应的键盘快捷键也列在这里。图标是一个地图 图钉,表示:此功能在用户界面中的
位置。

详细信息。 默认值、取值范围和代码路径。主要出现在并非菜单 项目而是数值参数的
训练设置中。图标是一张小型规格卡。

技术细节。 该功能在内部的工作方式、哪些参数会产生作用、 它对什么作出反应以及
具有哪些副作用。面向想了解幕后发生 什么的读者。图标是一组滑杆,象征着引擎盖下
的调节旋钮。

简单地说。 用清晰的语言表达核心内容 —— 没有专业术语,也没有 代码。如果您只想快
速知道某个功能的用途以及何时需要它,请先 阅读这一节。图标是一个对话气泡,代表“直
击要点”。这一列始终 以温暖的沙色为底色,让眼睛能迅速找到它。

章节颜色

每个章节都有自己的强调色,您可以从 ID 标识 (例如 M1 ) 以及每个条目标题左侧的小图标上
辨认出来。在翻阅时您可以 立刻看出自己正处于哪一章。

1 菜单 2 检查器 3 设置 4 辅助窗口 6 训练

7 预设 8 导出 9 SfM 10 新手模式

导航提示

快速入门。 如果您只关心操作方法,请直接跳到 第 10 章 —— 新手模式。 它是仅含四个
步骤的引导版本,完全不需要任何先备知识。

深入了解。 第 2 章 —— 检查器 和 第 7 章 —— 预设 介绍了在专家 模式下可用的操作元
素和预设的质量配置文件。



查阅参考。 通过目录和 PDF 全文搜索即可找到特定功能。 您不必从头到尾通读整本
手册。



R A D I A N C E K I T

章

引言 — 您应该了解的内容

什么是 RadianceKit?

RadianceKit 是一款原生 macOS 应用,可以将一系列普通照片或一段视频 转化为可漫游的 3D 
重建。输入例如是您围绕物体、穿过房间或越过风景 拍摄的 50 到 500 张照片。输出是所谓
的 Gaussian Splatting 场景 —— 一个 3D 模型,您可以在 Mac 上实时从任何视角观察它,可以
导出 并嵌入网页,而且在主要方面看起来如照片般真实。

应用程序完全在您的 Mac 上本地运行 —— 不会有任何图像上传到云端, 不要求登录,也没有订
阅。它会大量使用您 Apple Silicon Mac (M 系列) 的 GPU:根据场景和预设的不同,完整的训练
时间可能在两分钟到数小时 之间。计算期间您可以在 Mac 上照常工作,RadianceKit 在后台继
续运行, 完成时会通知您。

有两种操作模式:新手模式 (Simple Mode) 通过四个步骤引导您 完成“导入 → 选择预设 → 训练 
→ 导出”的工作流程。专家模式 (Expert Mode) 则会打开一个大型的检查器,其中包含所有的调
节项、 一个实时预览窗口以及诊断图表。您可以随时在两种模式之间切换; 场景中的数据将
保留。

什么是 Gaussian Splatting?

Gaussian Splatting (通常简称 3DGS 或就是 Splatting) 是一种相对较新的照片级真实感 3D 
表示方法,于 2023 年由格拉茨与 INRIA 的一篇论文提出。其核心思想是:不是将场景建模为经
典的多边形 网格 (三角形) 或体素网格,而是由数百万个小而柔软的 3D 云朵 组合而成 —— 每一
团云都是一个 3D 高斯分布 (这就是名字的由来), 拥有自己的位置、大小、形状、颜色和透明
度。这些云朵经过训练, 使其从输入照片的各个视角组合起来时正好得到正确的图像。

实际上这意味着:Gaussian Splatting 能够以经典 3D 建模无法实现或 仅能以极大代价才能
实现的方式表现反射、高光、柔软的树叶、头发 或窗帘。代价是,结果并不是经典意义上可
编辑的 3D 模型 —— 您不能 简单地移动单独一面墙或挪动一个花瓶。它更像是一段空间的 冻
结快照,您可以在其中自由穿行。对于许多应用 —— 建筑 可视化、产品展示、虚拟游览、取证、
文化遗产 —— 这恰好是它的 正确强项。

要从输入图像生成 3D 场景,需要两个步骤。首先,应用程序通过一种 名为 Structure-from-
Motion (SfM) 的方法计算出每张照片 拍摄时相机所处的位置。在此过程中会顺带生成场景的
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粗略点云。然后 开始真正的 Gaussian Splatting 训练:从这粗略的点云出发,数百万 3D 云朵被
逐步分布、放大、细化,并对位置和颜色进行调整,直至 它们从所有输入视角都能呈现出匹配的
图像。

要使用 RadianceKit,您完全不需要了解上述两者中的任何内容。新手 模式将这些步骤完全隐藏
起来。但如果您想理解专家模式中诊断数字 (Iteration、Loss、Gaussians、SSIM …) 的含义,
或想知道为什么有些 场景比另一些更出色,那么本手册后续章节中会找到答案。
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章

第 1 章 — 菜单栏

RadianceKit 的菜单栏汇集了所有不直接位于主窗口或检查器中的功能。 主要是作用于整
个场景的操作 (打开、保存、新建项目)、控制训练 (开始、暂停、继续)、操作视口 (自动旋转、
截图、背景颜色) 以及 触发到各种 3D 与媒体格式的导出。此外还有指向所有辅助窗口 (User 
Guide、Pareto Dashboard、Holdout Analysis、BayesOpt Console) 的快捷入口。

键盘快捷键显示在每个菜单条目右侧。约定: ⌘  表示 Command 键 (苹果键), ⇧  是 Shift, ⌥  
是 Option (Alt), ⌃  是 Control。 例如: ⇧⌘T  表示 Shift+Command+T。此处记录的所有快捷
键还可 通过 Help → Keyboard Shortcuts (⌘/​) 在专门的概览窗口中 查看。

下面 42 个条目按照清单顺序 (M1–M42) 记录,按所属顶级菜单 分组。所有条目均已对照
当前代码状态在 (175–477 行) 中 验证。没有条目被移除或相对清单过时;新的 Edit 菜单
条目 (对应“Remove Image”的 Cmd-Z) 由系统 NSUndoManager 框架接管, 因此不会出现在 
RadianceKitApp 代码中 (参见本章末尾的注释)。

File 菜单

图 1  已展开的文件菜单 — 条目 M1 至 M6

File 菜单将 Apple 的标准“New Window”条目替换为项目特有的操作。 它包括加载/保存场景、
一个动态的最近列表、Workspace 导入,以及 硬性重置到空状态。

5 / 167



R A D I A N C E K I T 第 1 章 — 菜单栏

M1 File > Open Scene…

位置

菜单栏 → File → Open Scene… (⌘O)。

技术细节

打开一个文件对话框,支持 RadianceScene  包、
.ply 、 .splat  和 .spz  格式。单选, 可同时显示文
件和目录 (用于包格式)。选择成功后,路径会被加入 最近
列表,场景被异步加载 —— 之前的场景被替换,训练流
水线 以加载的状态初始化。PLY/SPZ/Splat 文件通过
相应的格式加载器 读取; .radiancescene  包是一个含 
manifest、点云快照和 SfM 结果的目录。

简单地说

这样您可以将已训练的场景重新加

载到 应用中。支持 RadianceKit 自
有格式以及其他 Splatting 程序生
成的 标准格式 PLY、SPLAT、SPZ。当
您例如让一个场景通宵训练,第二天 
想继续或导出时,使用此功能。打开
时主窗口中的原状态会被替换 —— 
若当前场景对您仍有用,请先保存。
路径会自动出现在“Open Recent” 
(M3) 中,以便下次更快访问。

M2 File > Save Scene…

位置

菜单栏 → File → Save Scene… (⌘S)。

技术细节

打开一个文件保存对话框,Content-
Type 为 RadianceScene  包,文件名预填为 
scene.radiancescene。 写出一个目录包,包含 
manifest.json 、序列化的 Gaussian-Cloud (PLY 快
照) 以及 SfM 结果的转储,使得重新打开后也能继续训
练。 若尚不存在 Gaussians,此条目被禁用。不保存到训
练日志路径, 而是保存到对话框指向的位置 —— 通常是 
~/​Documents/​ 下。

简单地说

将当前场景保存为文件 (确切地说: 
保存为看起来像文件的包目录)。
只有这样,您之后才能再次通过 
“Open Scene…” (M1) 打开此场景。
包中既包含 Gaussian-Cloud 也包
含 SfM 结果,因此之后还可以接着
进行继续训练 (M12–M14)。 在尚
未完成任何训练时,该条目灰显。默
认名为 scene.radiancescene 
—— 您也可以在保存对话框中指定
自己的名称。

M3 File > Open Recent > [场景名称]

位置

菜单栏 → File → Open Recent → (列表)。

技术细节

动态子菜单,根据最近打开过的 路径列表 (存储在设置中) 
生成。每个列表条目以文件名命名, 单击即加载。列表为
空时,出现禁用标签“No Recent Scenes”。 按 Apple 惯
例,列表保留最近 N 个打开过的场景 —— 限制在 写入设
置时发生,而非菜单构建时。

简单地说

在此查看最近打开过的场景, 一键
即可重新进入,无需经过文件对话
框。如果您刚开始使用, 列表为空,
会以灰色显示在菜单中。每个通过

“Open Scene…” (M1) 打开的场景
都会自动进入此列表。如果列表过

长或您出于隐私考虑 想清空,使用
“Clear Recent” (M4)。
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M4 File > Open Recent > Clear Recent

位置

菜单栏 → File → Open Recent → Clear Recent。

技术细节

清空设置中的最近列表。立即生效, 没有确认对话框。该
条目仅在最近列表中有条目时出现在子菜单中 (位于路径
之后的一个分隔线下)。

简单地说

删除最近打开场景的列表。当您测

试过 一些数据集并不想再看到这些
路径时很实用。场景文件本身不会

被 删除 —— 仅删除菜单中的链接。
操作立即生效,无需确认;之后 子菜
单中显示“No Recent Scenes”。仅
当列表中确实有场景时 该条目才会
出现 —— 列表为空时不可见。

M5 File > Import COLMAP / Metashape Workspace…

位置

菜单栏 → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I)。

技术细节

打开文件夹选择器。期望一个具有 COLMAP 
Workspace 布局的文件夹 (例如 sparse/​0/​cameras.
{bin,txt} 加 images/​)。选择后会对 Workspace 进行
预检 —— 识别三种布局 (sparse/​0/​、sparse/​、根目

录) 以及重建是二进制 ( cameras.bin ) 还是 ETH3D 文
本 ( cameras.txt )。成功后导入 Workspace;否则 仅
在应用日志中出现警告。完整流水线逻辑见第 9 章“SfM 
后端”中 的 Q6。

简单地说

如果您使用 Metashape、COLMAP、 
RealityCapture 或类似软件进行相
机重建并拥有一个导出, 将该文
件夹拖入这里。RadianceKit 将跳
过 SfM 阶段并直接开始 训练 —— 
在大型场景中能节省数小时。拖

放到主窗口同样可以。 期望一个
具有 COLMAP 布局的文件夹 (即 
sparse/​0/​ 含 cameras.*  加 
images/​ 文件夹)。关于支持的布
局和工作流程的更多内容, 见第 9 
章“SfM 后端”。

M6 File > New Project

位置

菜单栏 → File → New Project (⇧⌘N)。

技术细节

检查是否有未保存的工作。如果有, 在丢失任何数据前出
现确认对话框。如果没有要保存的内容, 直接执行重
置 —— 清空导入的图像、SfM 结果、Gaussian-Cloud、 
训练状态以及所有相关的 UI 指示器。注意:用户创建
的预设库 保留下来,因为它位于应用设置中而非项目状态
中。

简单地说

将一切重置回空白起点 —— 就像
您刚 打开应用一样。如果您还有未
保存的工作,应用会先询问。 当您
要开始一个完全不同的场景时使用

此功能。导入的图像、 SfM 结果、
Gaussian-Cloud 和训练状态会被
完全清空。您自己的 预设保留,因
为它们位于应用设置中而非属于场

景。

7 / 167



R A D I A N C E K I T 第 1 章 — 菜单栏

Mode 菜单

图 2  模式菜单,带 Simple 与 Expert Mode 切换

两个在引导式 Simple Mode (向导式,4 步) 和完整 Expert Mode (带所有调节项的经典检查器
布局) 之间切换的简单开关。

M7 Mode > Simple Mode

位置

菜单栏 → Mode → Simple Mode (⌘1)。

技术细节

将应用状态切换到 Simple Mode。 应用的主区域随即显
示引导式工作流程而非专家布局。模式状态 保存在设置
中 (参见第 3 章设置中的 S1″Default Mode“)。

简单地说

切换到分步变体,应用会引导您完成 
导入、处理、预览和导出。如果您

刚开始或需要快速结果,推荐使用。 
多数详细调节项被隐藏 —— 您使
用合理的预设工作。如果之后您想 
更深入,只需切换到 Expert Mode 
(M8)。应用启动时使用哪种模式 可
以在设置中 (第 3 章 S1) 设定。
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M8 Mode > Expert Mode

位置

菜单栏 → Mode → Expert Mode (⌘2)。

技术细节

将应用状态切换到 Expert Mode。 随即
出现具有所有 Section 的完整检查器布
局 (Presets、 TrainingConfig、Enhancements、
Metrics、LossChart、ProjectNavigator)。 在 Expert 
Mode 中,所有训练参数、COLMAP 选择器、Mid-
Compact 开关和诊断功能均可访问。Live-Preview 也
仅在此模式中可用。

简单地说

切换到带所有调节项的完整视图。 
您可在此实时查看 Loss 图表,精调
所有参数,并通过预设并行 管理多
个对比配置。如果您想了解训练内

部在做什么,或要有 针对性地试验,
推荐使用。Live-Preview、COLMAP 
选择器和 诊断也只在此处可访问。
如果您感到过于复杂,可通过 M7 返
回 Simple Mode —— 场景将保留。

Training 菜单

图 3  训练菜单,含 Continue 子菜单 — 条目 M9 至 M14

围绕训练运行的四个操作:开始、暂停、取消,以及延长指定的 迭代次数。所有三个 Continue 
条目均受 IAP 限制 (在免费试用版 中无法点击)。
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M9 Training > Start Training

位置

菜单栏 → Training → Start Training (⇧⌘T)。

技术细节

异步启动训练流水线。前提:存在 SfM 结果且当前没有
其他流水线在运行。任一条件不满足都会 禁用此条目。
启动时读取当前配置值,在 ~/​Documents/​RadianceKit/​
Logs/​training_​YYYY-MM-DD_​HHmmss.jsonl 处创建新
的 JSONL 日志,并根据策略选择执行 Classic 或 MCMC 
路径。训练状态从“idle”切换到“training”。

简单地说

按下那个大绿色按钮 —— 一旦
您导入 了照片并完成了相机重
建,实际的 Gaussian Splatting 训
练就此 开始。让应用继续运行;
根据预设,从 1 分钟 (Quick) 到数
小时 (MCMC Quality) 不等。条目
在尚无 SfM 结果或有其他流水线
在 运行时灰显。每次运行都会
顺带写一个日志到 ~/​Documents/​
RadianceKit/​Logs/​,您之后可
通过 Pareto Dashboard (M40) 进
行分析。

M10 Training > Pause Training

位置

菜单栏 → Training → Pause Training。

技术细节

暂停正在运行的训练。仅在训练 状态为“training”时
启用。暂停会在下一个安全同步点处停止 迭代循环,
保留完整的 GPU 状态 (Gaussian-Buffer、Optimizer 
矩、Scheduler 位置),并切换到“paused”。再次按下即
恢复 (条目标题是静态的 —— 但应用在实际逻辑中
切换 Pause/Resume)。 暂停的训练不会在应用退出后
保留;此时请保存场景,稍后通过 Continue Training 条目 
(M12–M14) 扩展。

简单地说

短暂暂停训练而不丢失进度。 在
您临时需要电脑做更重要的事情时

很实用。再次点击恢复。 不能跨
越应用重启 —— 如果您真要稍后
继续,用 Cancel (M11) 结束训练,用 
Save Scene (M2) 保存场景,然后使
用 Continue Training (M12–M14)。
暂停期间 GPU 完全空闲;但内存仍
然占用。

M11 Training > Cancel Training

位置

菜单栏 → Training → Cancel Training。

技术细节

取消正在运行的训练。在训练 状态不为“idle”时启
用。在训练引擎中设置 Cancel 标志, 使迭代循环在
下一个同步点干净地结束,在 JSONL 日志中写入 最终的 
Summary 条目,并将状态重置为“idle”。已经训练的点云 
保留 (可保存或导出),但被标记为“cancelled”。

简单地说

永久终止正在运行的训练。已有 
进度保留 —— 因此如果您在几千
次迭代后已有可展示的结果, 仍可
导出。如果您只想短暂中断,改用 
Pause (M10)。在训练 日志中,该运
行被标记为“cancelled”,最终 Loss 
值也会被一起 写入。被取消的场景
之后也可通过 Continue Training 
(M12–M14) 继续,只要应用未在中
途退出。
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M12 Training > Continue Training > +5 000 iterations

位置

菜单栏 → Training → Continue Training → +5,000 
iterations。

技术细节

将训练继续 5 000 次迭代。 仅当已完成的训练可继
续且完整版已解锁时启用。当存在已完成 训练且完
整的 Optimizer 状态仍在内存中时可继续。继续时, 
Adam 矩与 LR-Scheduler 接续,使继续表现得像一次性
的 25K/45K/60K 运行而非重新启动。JSONL 日志获得
一个带增量设置 的新 Config 条目。仅在完整版中可用。

简单地说

追加 5 000 个训练步。当第一次运
行 后的结果接近理想但尚未足够
清晰时使用。仅在付费完整版中可

用。 与全新运行不同,Optimizer 状
态保留,使继续运行感觉像连续运
行。 如果您需要超过 5 000 步,直
接使用 M13 (+10 000) 或 M14 (+20 
000)。

M13 Training > Continue Training > +10 000 iterations

位置

菜单栏 → Training → Continue Training → +10,000 
iterations。

技术细节

与 M12 相同,但增加 10 000 次 迭代。相同的前提条件,
相同的 LR-Scheduler 路径。当初始 训练使用中等档位
预设运行且您希望看到显著质量提升而不必 完全重新开
始时推荐。

简单地说

将训练延长 10 000 步 —— 三个 可
用 Continue 值中的中间项。当第
一次运行还行但您想更清晰 地变好
时是个好选择。和 M12、M14 一样,
学习率走势是无缝 继续而非重新开
始。仅在完整版中可用。

M14 Training > Continue Training > +20 000 iterations

位置

菜单栏 → Training → Continue Training → +20,000 
iterations。

技术细节

与 M12 / M13 相同,但增加 20 000 次迭代。是预设最大
的 Continue 跨度。在 MCMC 训练中,这往往 能决定“够
用”和“基准级”的差别;在 Classic 训练中,从 35–40K 之
后经验上提升不大。

简单地说

追加 20 000 个训练步,最大的 
Continue 值。当您真的想榨干最
后一点质量时使用。在经典训练 
40 000 步之后通常作用不大 —— 
而在 MCMC 中往往值得,因为 那里
收敛较慢。根据场景预估明显增加

运行时间。和 M12、M13 一样,此条
目仅在完整版中可用。
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Viewport 菜单

图 4  视口菜单,带 Edit Mode、相机控制和背景子菜单

控制 3D 视口:用于 Gaussian 选择和清理的 Edit Mode、相机 控制 (自动旋转、Playback、
Recording)、截图、背景颜色和 重置。

M15 Viewport > Enter/Exit Edit Mode

位置

菜单栏 → Viewport → Enter Edit Mode (或 “Exit Edit 
Mode”,视状态而定)。⇧⌘E。

技术细节

该条目标题是动态的,根据状态 显示“Exit Edit Mode”或
“Enter Edit Mode”。按下时在视口 渲染器上切换 Edit 
Mode。退出 Edit Mode 时同时重置当前选择。 Edit 
Mode 启用 Gaussian 的单击选择、Box-Selection 以及
对 已标记 Gaussian 的删除 (参见 UI 的编辑区域)。在
尚未连接 视口渲染器时禁用。

简单地说

在常规 3D 视图与一个可标记并删
除 单个 Gaussians (例如背景中的
漂浮物或离群点) 的编辑模式之间 
切换。退出时选择会自动重置。在

视口中尚无场景可见时该条目 灰
显。标题根据状态在“Enter Edit 
Mode”和“Exit Edit Mode” 之间切
换 —— 您始终能看到当前所处模
式。
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M16 Viewport > Toggle Auto-Rotation

位置

菜单栏 → Viewport → Toggle Auto-Rotation (⌘⌥T)。

技术细节

开启或关闭视口相机围绕通过 场景中心的垂直轴的持续
旋转。轴和速度来自相机控制配置。 自动旋转是纯视口
效果,不影响训练或录制 —— 如果您同时使用 Turntable 
Video Recorder (M18),自动旋转正好提供 Recorder 捕
获的路径。

简单地说

让相机持续缓慢围绕场景旋转, 使
您能从各个方向观察而无需用鼠标

拖动。再次点击停止旋转。 在评
估训练完成的场景或作为现场演示

的背景动画时很实用。 若您并行
录制视频 (M18),自动旋转正好提供 
Recorder 捕获的 运动轨迹。

M17 Viewport > Toggle Camera Playback

位置

菜单栏 → Viewport → Toggle Camera Playback。

技术细节

切换相机路径回放。如果存在 已录制的相机路径 (例如
来自先前的录制或因加载了 transforms.json ), 该路
径开始播放 —— 视口相机不再响应鼠标/触控板输入,而
是 逐帧再现该轨迹。再次按下暂停回放。

简单地说

让之前录制或导入的相机运动 开始
播放。这样您可以重现拍摄场景时

使用的原始路径,或在 视频导出前
查看预设的轨道运动。回放期间,鼠
标和触控板输入 被禁用 —— 相机
严格沿路径运动。再次单击暂停回

放。如果您 没有加载或录制相机路
径,则不会有任何效果。

M18 Viewport > Record Turntable Video

位置

菜单栏 → Viewport → Record Turntable Video。

技术细节

切换视口录制。首次按下时 开始将帧录制到临时路
径;再次按下时结束录制,编码并写入 MP4 路径 (通过
保存对话框询问路径)。与 Export → Media → Orbit 
Video (M31) 不同 (它在可设置时长下生成固定 360° 路
径),Turntable Recorder 实时录制您在视口中看到的内
容 —— 因此您也可以录制手动相机运动。

简单地说

直接在视口中录制视频。无论相

机 自动旋转还是您自己用鼠标移动 
—— 您看到的一切都会保存到一个 
MP4 文件中。与“Orbit Video”导
出 (M31) 不同,这里由您自己 决定
相机运动。第一次单击开始录制,第
二次单击结束并询问 保存位置。当
您要展示某个无法用刚性轨道运动

呈现的细节 摇移时很实用。
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M19 Viewport > Save Screenshot

位置

菜单栏 → Viewport → Save Screenshot (⇧⌘S)。

技术细节

以完整渲染分辨率 (即并非 窗口像素布局,而是完整 
Render-Target 的内容) 捕获单个视口帧 并保存为 PNG 
文件。路径通过保存对话框询问。背景颜色 (M21–M23) 
一并烤入图像。Enhancements 中的 MetalFX/MPS 
Upscaling 设置 (见 I27/I28) 若启用则生效 —— 截图显
示放大后 的输出。

简单地说

将当前 3D 视图的快照保存为 PNG 
图片。对营销材料或快速比较很

实用。注意:背景是图像的一部
分 —— 如果您需要透明度,最好
导出场景文件。分辨率对应内部 
Render-Target 而非您的窗口大小 
—— 因此图像通常比窗口中看到 
的更清晰。已启用的 Upscaling 设
置 (检查器 → Enhancements) 也一
同生效。

M20 Viewport > Copy Camera Info

位置

菜单栏 → Viewport → Copy Camera Info。

技术细节

读取当前视口相机位姿 (位置、 Look-At 点、Up 向量) 
以及相机控制中的 FOV 值,并将其以 多行文本写入剪贴
板。格式是人类可读 (每行 label = value), 而非 JSON。
对调试目的重现特定视角或与支持人员共享很实用。

简单地说

将当前相机位置和视线方向作为 文
本复制到剪贴板。例如,如果您想向
同事展示场景中某处看起来 怪异的
视角,只需将该文本粘贴到邮件或聊
天窗口中。格式是 人类可读的 (每
行一个值),不是 JSON。主要用于 
bug 报告或 技术支持请求。

M21 Viewport > Background > Dark Gray

位置

菜单栏 → Viewport → Background → Dark Gray。

技术细节

将视口背景颜色设为深灰 (RGB 0.1/0.1/0.1)。渲染器使
用此颜色作为 Gaussians 合成的背景。 应用启动时的默
认颜色由设置选项 S3″Default Viewport Background
“ 控制。

简单地说

将 3D 视口背景染为深灰色。 适
用于多数场景的标准选择 —— 对
亮和暗的 Gaussians 都提供 良好
对比,而不会让眼睛被纯黑或纯白
表面紧紧吸住。该颜色 也会被截
图 (M19) 和 Orbit Video (M31) 采
用。如果您觉得 Dark Gray 不够引
人注目,可对比试试 Black (M22) 或 
White (M23)。应用启动时使用哪
种颜色,可在设置中 (S3) 设定。
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M22 Viewport > Background > Black

位置

菜单栏 → Viewport → Background → Black。

技术细节

将视口背景颜色设为纯黑 (RGB 0/0/0)。当场景有许
多亮的漂浮物且您想识别它们时,或为带 深色感的营销材
料,很有帮助。

简单地说

黑色背景。适合非常亮的场景,或 
当您想进入 Edit Mode 寻找在灰色
中难以察觉的小亮 Gaussians (漂
浮物) 时。也非常适合带深色戏剧
效果的营销素材。颜色会 烤入截图
与 Orbit Video —— 如果您需要透
明度用于后期合成, 黑色是最差的
选择。对于暗色漂浮物,改向另一方
向选 White (M23)。

M23 Viewport > Background > White

位置

菜单栏 → Viewport → Background → White。

技术细节

将视口背景颜色设为纯白 (RGB 1/1/1)。当场景以暗色内
容为主并且您想看到暗色漂浮物 (典型的户外背景噪声) 
时有用。

简单地说

白色背景。当主题以亮对暗显示 更
好,或要找到您之后想在 Edit Mode 
(M15) 中移除的暗色离群点 时很实
用。在户外场景中白色往往比黑色

更有用,因为典型的户外 漂浮物多
为暗色。与其他背景选项一样,颜色
会被截图和视频 采用。

M24 Viewport > Reset Camera

位置

菜单栏 → Viewport → Reset Camera。

技术细节

重置视口相机,退出 Training Camera 视图,并停止自动
旋转。这样相机回到初始位置 (典型: 位于场景前方略微
俯视),自动旋转关闭,如果渲染器当前显示 的是 Training 
Camera (SfM 位姿之一),则回到自由相机。

简单地说

将视口相机带回初始位置。 如果您
在转动时迷失方向或将场景推出画

面 —— 在这里点击一下, 您就能重
新看到应该看到的内容。同时关闭

可能正在运行的自动 旋转,并从冻
结的训练相机回到自由视图。这样

您始终获得 视图的干净重启。
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Export 菜单

图 5  导出菜单,带三组子菜单 — 3D Formats、Media 和 Photogrammetry

八个导出目标加两个 Photogrammetry 导出,分为三个部分 (3D Formats、Media、
Photogrammetry)。前六个通过共享的辅助 例程构建,各自打开保存对话框并在格式目录中注
册导出。 Photogrammetry 条目有独立逻辑。所有 Photogrammetry 以及 部分 3D 导出仅在
完整版中可用。

M25 Export > 3D Formats > Export PLY…

位置

菜单栏 → Export → 3D Formats → PLY (⌘E)。

技术细节

打开默认文件名为 gaussians.ply  的保存对话框。
确定后将当前 Gaussian-Cloud 写入标准的 ASCII/
Binary PLY 格式 —— 兼容 SuperSplat、PolyCam、
PlayCanvas 以及所有常见 3DGS 查看器。完整的 
SH 系数、完整精度 (每字段 Float32)。在 ≥ 500K 
Gaussians 时文件大小常达数百 MB。

简单地说

将您的 3D 场景保存为标准 PLY 文
件。这是最通用的格式 —— 几乎
所有软件都能加载,从 SuperSplat 
到 PolyCam 再到 PlayCanvas。但
文件较大,常达数百兆字节。 当您
要以完整质量继续或归档时使用 
PLY。若要通过 Web 共享场景, 最
好看看 SPZ (M27) 或 Compressed 
PLY (M26) —— 它们小得多。
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M26 Export > 3D Formats > Export Compressed PLY…

位置

菜单栏 → Export → 3D Formats → Compressed PLY。

技术细节

以 Compressed-PLY 格式写出 Gaussian-Cloud,带
对位置、Scale、Rotation 和 SH 字段的 自定义
量化。比未压缩 PLY (M25) 小 5–10 倍,视觉损
失极小。 兼容 SuperSplat (它读取 Compressed-
PLY 标准) 和 PlayCanvas。 标准文件名 gaussians_​
compressed.ply。

简单地说

类似普通 PLY,但小 5–10 倍。 质量
几乎保持不变。当您要在线分享文

件或通过电子邮件发送时 使用。直
接与 SuperSplat 和 PlayCanvas 工
作。但如果您的目标 系统需要更
小的文件 (移动、浏览器演示),改用 
SPZ (M27) —— 它压缩得更彻底。
要获得完整的编辑质量,使用未压缩
的 PLY (M25)。

M27 Export > 3D Formats > Export SPZ…

位置

菜单栏 → Export → 3D Formats → SPZ。

技术细节

以 SPZ 格式写出 Gaussian-Cloud —— Niantic 发布的
压缩 Splat 格式,带激进量化 (比未压缩 PLY 小 ~90 
%)。主要为 Web 查看器和移动应用优化。兼容 Niantic 
Splatt3R、gsplat.js 和 Niantic 浏览器查看器。

简单地说

最小的格式之一。约比普通 PLY 
小 10 倍。主要用于您想在浏览器
中展示或通过手机应用查看 场景
时。对于最高质量,PLY 是更好的
选择。SPZ 由 Niantic 开发, 直接与 
gsplat.js、Splatt3R 和 Niantic Web 
查看器协同工作。 由于强压缩,SPZ 
文件无法直接继续训练 —— 用于
编辑请使用 PLY。

M28 Export > 3D Formats > Export glTF…

位置

菜单栏 → Export → 3D Formats → glTF。

技术细节

写出一个带 KHR_gaussian_splatting 扩展的 
.glb  文件 (Binary-glTF)。符合标准,适合使用 

glTF 引擎 (如 Babylon.js 或 Three.js) 并实现 
KHR_gaussian_splatting 扩展的流水线。

简单地说

以多个 3D 程序和 Web 引擎可以 理
解的 glTF 格式保存场景 —— 前提
是它们支持 Gaussian Splatting 扩
展。如果您有特定的 3D 流水线 (例
如 Three.js 或 Babylon.js) 能识别
它,这就是您的格式。文件以二进制 
.glb  输出 —— 一个 包含一切的
单一包。对于经典的 Splatting 工
作流程,通常 PLY 或 SPZ 是更好选
择,因为更多工具直接支持它们。
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M29 Export > 3D Formats > Export .splat…

位置

菜单栏 → Export → 3D Formats → .splat。

技术细节

写出 Antimatter15 的 .splat  格式 —— 每 Gaussian 
固定 32 字节 (位置 3× Float32、Scale 3× Float32、
Rotation 4× Uint8 归一化四元数、RGB+Opacity 4× 
Uint8)。不存储高于 DC 的 SH 系数。最小的具备浏览
器直接 兼容性的文件。用于 gsplat.js 和 antimatter15 
在线演示查看器。

简单地说

最简单的 Web 查看器格式。小且 
可立即在任何浏览器中显示。但

会丢失细节光照 (更高的 SH 系
数 丢失 —— Splat 从每个视角
看起来一样,而不会对光线作出
反应)。 对最大 Web 性能很好,
对照片真实感最好使用 SPZ 或 
PLY。 与 antimatter15 在线查看
器和 gsplat.js 配合工作。每个 
Gaussian 固定占用 32 字节,这使格
式简单且兼容 —— 但代价 是细节
深度。

M30 Export > 3D Formats > Export SOG…

位置

菜单栏 → Export → 3D Formats → SOG。

技术细节

以 SOG 格式写出 Gaussian-Cloud。 SOG (“Self-
Organizing Gaussian”) 是 PlayCanvas 格式,带 
Texture-Atlas 布局和量化数据的 WebP 压缩。比 PLY 
的尺寸 比好 15–20 倍。导出内部调用 cwebp  作为外
部工具 —— 因此在沙盒变体 (App Store) 中可能受限。

简单地说

适用于 PlayCanvas 工作流程的 非
常小的格式。约比 PLY 小 15–20 
倍,因为数据被打包到一个 Texture-
Atlas 布局并用 WebP 压缩。如果
您没有 PlayCanvas 工作流程,SPZ 
或 Compressed PLY 通常是更好选
择。导出在 内部调用 cwebp  作
为外部工具 —— 在 App Store 版
本 (沙盒) 中此步可能受限。

M31 Export > Media > Export Orbit Video…

位置

菜单栏 → Export → Media → Orbit Video。

技术细节

围绕场景中心渲染一个 360° 轨道 并将其编码为 MP4 
(H.264) 或 MOV (HEVC,根据系统默认值)。 与 M18 
(实时录制) 不同,这里的路径是固定的 —— 时长在设置中 
或 Simple Mode Export 步骤中选择。

简单地说

自动生成围绕您场景的旋转视

频。 无需手动移动。适合社交媒
体或快速演示。如果您想自己控制 
相机,改用 Record Turntable Video 
(M18)。路径固定:围绕 场景中心
的完整 360° 轨道,时长在设置或 
Simple Mode Export 步骤中选择。
视频根据系统作为 H.264-MP4 或 
HEVC-MOV 输出。
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M32 Export > Media > Export Web Viewer…

位置

菜单栏 → Export → Media → Web Viewer。

技术细节

将一个独立的 HTML 查看器 (基于 gsplat.js) 加上 
base64 编码的 Gaussian 数据打包到 单个 .html  文
件中。该文件在任何现代浏览器中离线运行 —— 无服务
器依赖,无外部 URL。文件大小比 SPZ 变体大约 1.3 倍 
(因 base64 开销)。

简单地说

将您的场景保存为可自启动的 网
页。双击 HTML 文件 → 浏览器打
开 → 完整的交互 3D 场景。 无需
联网,可通过邮件发送,是与朋友或
客户分享结果的最简单 方式。该
文件包含完整的 gsplat.js 查看器
和 Gaussian 数据, 位于单个文档中 
—— 不从 Web 加载任何内容。文
件大小约比 SPZ 导出大三分之一,
但接收者无需额外软件。

M33 Export > Photogrammetry > Export SfM (transforms.json)…

位置

菜单栏 → Export → Photogrammetry → Export SfM 
(transforms.json)。

技术细节

独立的导出路径 (不经过共享 辅助例程),因为导出
的不是 Gaussian-Cloud 而是 SfM 结果。 打开一
个默认为 transforms.json  的保存对话框,Content-
Type 为 json 。确定后写出一个与 nerfstudio 兼容的 
transforms.json , 含相机内参、位姿 (作为 NeRF 约
定下的 4×4 矩阵) 和帧路径。 UI 中的帮助文本提示需
将训练图像作为同级 images/​ 文件夹 一起复制。仅在存
在 SfM 结果且完整版已解锁时启用。

简单地说

如果您要将 SfM 结果在其他软
件 中继续使用 (如 nerfstudio、
Brush、gsplat 或 OpenSplat), 在此
导出相机位置。另外将训练图像

放入 transforms.json  旁边
的 images/​ 文件夹中 —— 否则
目标程序无法关联图像。 在尚
无 SfM 结果时该条目灰显,在免费
试用版中被锁定。 对于 COLMAP 
Workspace 工作流,改用 M34。
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

位置

菜单栏 → Export → Photogrammetry → Export SfM 
(COLMAP Workspace)。

技术细节

打开默认名为 colmap-workspace  (没有扩展名,
因为是文件夹) 的保存对话框。写出一个标准
的 COLMAP Workspace,含 sparse/​0/​cameras.bin、
images.bin 、 points3D.bin 。允许在 Postshot、

Nerfstudio 或 Meshroom 等其他工具中打开在 
RadianceKit 中计算或导入的 SfM 重建, 或在 A/B 重新
运行时作为已计算的输入重新加载到 RadianceKit 本身 
(通过 M5) —— 节省计算时间。仅在存在 SfM 结果且完
整版 已解锁时启用。

简单地说

类似 M33,但格式为 COLMAP 而非 
nerfstudio。如果您使用 Postshot、
Meshroom、Nerfstudio 或其他 
COLMAP 工作流的工具,这就是您的
导出。一个实用的 副作用:您之后
可以通过 M5 将该文件夹重新载入 
RadianceKit, 节省下次运行的 SfM 
计算时间 —— 在大型场景中,这是
数小时 的时间节省。和 M33 一样,
仅在存在 SfM 结果时可用,在 免费
试用版中被锁定。

Help 菜单

图 6  帮助菜单,带文档、文件夹和分析条目

七个条目:两个文档窗口 (User Guide、Keyboard Shortcuts)、 三个文件夹快捷方
式 (Training Logs、Exports、Storage),以及 三个分析窗口 (Pareto Dashboard、Holdout 
Analysis、BayesOpt Console)。按 Apple 惯例,Help 菜单出现在最右侧。标准 Help 菜单被 
RadianceKit 自有变体完全取代。
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M35 Help > User Guide

位置

菜单栏 → Help → User Guide (⌘?)。

技术细节

打开 User Guide 窗口。它显示 带主题侧边栏和滚动
详情区的导航,默认尺寸 860×640。内容 是静态嵌入的 
(不从 Markdown 解析)。

简单地说

打开应用内置的说明。如果您 不想
在本手册中查阅一切,可在程序中直
接找到最重要的步骤。 说明以独立
窗口形式构建,带主题侧边栏 —— 
您可以有针对性地 跳到各个主题。
内容比本手册简短,集中于最常见的
工作流程。

M36 Help > Keyboard Shortcuts

位置

菜单栏 → Help → Keyboard Shortcuts (⌘/)。

技术细节

打开 Keyboard Shortcuts 窗口 —— 一个简单的滚动布
局,列出所有应用快捷键,按顶级菜单 分组。默认尺寸 
440×560。内容同样为静态嵌入。

简单地说

打开一个包含所有键盘快捷键 完整
列表的窗口。例如,如果您不记得是
哪个键启动训练,就来 此查看。本
章末尾也有概览。列表按顶级菜单

分组,以便您快速 跳到正确区域。
当您正从鼠标风格转向键盘风格时

很有帮助。

M37 Help > Open Training Logs…

位置

菜单栏 → Help → Open Training Logs… (⇧⌘L)。

技术细节

将日志文件夹计算为 ~/​Documents/​RadianceKit/​Logs,
必要时创建,并在 Finder 中打开。每次训练运行都会在
那里写入一个独立的 JSONL 文件 training_​YYYY-MM-
DD_​HHmmss.jsonl。

简单地说

在 Finder 中打开所有以往训练 记
录所在的文件夹。如果出了问题或

您想查看训练何时收敛到 什么值,
可以在这里的 JSONL 文件中找到
答案。每次训练运行 恰好生成一
个带时间戳的文件 —— 您也可以
在其他工具中读取 它或通过邮件
发送给技术支持。若需要图形分

析,Pareto Dashboard (M40) 是更
好入口。
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M38 Help > Open Exports Folder…

位置

菜单栏 → Help → Open Exports Folder…

技术细节

类似 M37,但使用 ~/​Documents/​RadianceKit/​Exports。
在首次自动测试运行或 首次点击时创建;之后所有自
动测试导出的标准路径会落在那里 (例如 autotest_​
<timestamp>.ply)。通过保存对话框手动选择 的导出不
一定进入此处,而是用户保存的位置 —— 因此此文件夹 
主要对自动测试有意义。

简单地说

打开应用存放自有导出 (主要是 自
动测试运行) 的文件夹。如果您手
动用保存对话框将导出放在 其他地
方,它就在那里,而不在此文件夹中。
便于清理或查看 早先的测试导出占
用多少空间。如果您需要包括日志

和场景包的 完整概览,改用 Manage 
Storage (M39)。

M39 Help > Manage Storage…

位置

菜单栏 → Help → Manage Storage…

技术细节

打开 Storage 浏览器 (参见 第 4 章辅助窗口,IDs W7–
W12)。列出 ~/​Documents/​RadianceKit/​ 中所有持久化
的场景、训练日志、导出和缓存及大小,允许 对每个条目
执行 Reveal-in-Finder 和 Move-to-Trash。

简单地说

打开一个窗口浏览器,显示 
RadianceKit 在您磁盘上占用的空
间 —— 按场景、日志和导出。 您
可以直接删除单项,而无需进入 
Finder。长时间使用后, 当磁盘变
满时很实用 —— 以往日志和自动
测试导出可累计达 数 GB。通过 
Reveal-in-Finder 随时也可进入经
典视图。

M40 Help > Pareto Dashboard…

位置

菜单栏 → Help → Pareto Dashboard… (⇧⌘D)。

技术细节

打开 Pareto Dashboard (参见 第 4 章,IDs W13–W22)。
该 Dashboard 从 ~/​Documents/​RadianceKit/​Logs/​ 加
载所有 JSONL 训练日志, 按场景和预设分组,并绘制 
Pareto 散点图 (默认:Loss 对 Gaussians,可选 Loss 对 
Wallclock 或 PSNR 对 Iterations)。

简单地说

作为图表打开以往训练运行的 概
览。您立刻看到哪次运行在质量和

大小之间提供了最佳平衡。 当您要
相互比较不同预设时很实用。默认

情况下,图表显示 Loss 对 Gaussian 
数 —— 您也可以切换到 Wallclock 
时间或 PSNR。数据来自 JSONL 训
练日志 (M37);您拥有的运行越多, 
分析越有说服力。
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M41 Help > Holdout Analysis…

位置

菜单栏 → Help → Holdout Analysis… (⇧⌘H)。

技术细节

打开 Holdout 分析窗口 (参见第 4 章,IDs W23–W29)。
加载一个 transforms.json , 将相机绘制为 3D 球面,
并允许 Train/Test Fold 切分 (角度或线性,2–8 折)。输
出是 fold-assignment.json, 训练可在相应训练配置中
将其作为测试集使用。

简单地说

帮助您将相机拍摄分为训练和 测
试集 —— 以便您能客观衡量场景
质量 (在训练未见过的图像上)。 更
多是研究和基准测试工具。相机以 
3D 球面呈现;您可以选择 2 到 8 折,
均匀按角度或按顺序线性。结果是

一个小的 JSON 文件,训练随后将其
作为测试集使用。

M42 Help > BayesOpt Console…

位置

菜单栏 → Help → BayesOpt Console… (⇧⌘B)。

技术细节

打开 BayesOpt 控制台 (参见 第 4 章,IDs W30–W39)。
加载预定义的搜索空间 (例如“MCMC scale-reg + 
opacity-reg + ssim”),异步执行贝叶斯优化试验, 并实时
显示收敛曲线和试验日志。

简单地说

内置的自动调参控制台。 应用可以
代您过夜运行,而不是手动尝试不同
参数,并在最后为 您的场景建议最
佳值。是非常高级的工具 —— 对
多数工作流程, 一个好的预设 (见第 
7 章) 已足够。您选择一个预定义的
搜索 空间 (例如“MCMC scale-reg 
+ opacity-reg + ssim”),并 实时看
到收敛曲线和试验日志。根据设置

规划几小时到几天。

提示:Edit 菜单中的 Cmd-Z

自 2026 年 5 月起,Expert Mode 中的 Project Navigator 支持 通过减号按钮或 Backspace 键
删除导入的图像,以及通过 Cmd-Z  撤销。该 Cmd-Z 操作在 macOS Edit 菜单 (由 SwiftUI 提
供) 中 显示为“Undo Remove Image”,前提是已删除的图像仍可恢复。 它通过标准的系统注册,
而不在 ; 因此没有专门的 M-ID 清单条目。
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键盘快捷键概览

菜单条目 快捷键

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit 菜单 (系统提供,在 Expert Mode 且 Project Navigator 选中时):

操作 快捷键

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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章

第 2 章 — 检查器 (Expert View)

图 7  空的 Expert Mode — 左侧 Project Navigator (Images 0、Cameras、Log)、 中间空视口、
右侧检查器含 Presets/Training Configuration/Enhancements/Training Metrics 各部分

导入前的空检查器: 左侧栏显示 Images 计数 0,并提示 “Drop images here / or tap + to 
import”。右侧检查器完全可用, 但预设仅为信息显示 (无活动训练)。默认预设“Preview” 
(5K iters) 处于选中状态。Camera Alignment 为 Apple Photogrammetry、 Densification 
为 Classic、SSIM Weight 0.20、Render Scale 50 %。 Training Metrics (“Start training to 
see live metrics”) 和 Loss History (“Loss curve will appear during training”) 显示 空状态。
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图 8  加载 60 张花束图像后的检查器 — 图像侧栏显示前几个文件名 frame_0001.jpg 等,标题栏显
示“60 images ready”

导入后的检查器: 标题状态为“60 images ready”。 图像侧栏列出全部 60 个导入的帧 
( frame_0001.jpg  至 frame_0945.jpg ,作为 960 张花束数据集每第 16 帧的子集, 用于快速
迭代)。自动渲染比例逻辑检查图像分辨率 (1536×2048 = 3.1 MP) 并相应调整 Render 
Scale。左下角的 绿色 Play 按钮现已激活,可用活动预设启动训练。

图 9  训练中的检查器 — 实时视口显示花束重建,底部指标栏 (Loss / LR / Gaussian-Count / 
Iterations),如参数被修改, Preset 卡片“Preview”会带“Modified”徽章

训练过程中的检查器: 标题栏显示全局进度 “RadianceKit — Training NN %”。视口实时渲
染进行中的 Gaussian 重建 (每 50 次迭代更新一次 —— Live Preview 间隔 可在 Settings → 
General → Training → Live Preview 中设置)。 视口下方的指标栏:当前 Loss、Learning 
Rate、Gaussian Count 和 Iterations 计数 (例如 Preview 预设的 1,600/5,000)。一旦 任何
参数偏离内置默认值,检查器中的预设卡片“Preview”会 带上“Modified”徽章。侧栏“Log”收集 
SfM 和训练阶段事件。
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图 10  训练完成后的检查器 — 视口显示已完成的花束重建 (5K 迭代后 2,991 Gaussians,用时 
13s),标题栏“Training Complete — 2,991 Gaussians”

训练后的检查器: 标题栏显示最终 Gaussian 数 (此处 2 991 —— 非常紧凑,因为这个浅色背景
上的合成 Blender 花束 场景几何简单)。视口显示完成的点云 —— 轨道拖动导航激活 (围绕场
景中心旋转)。Training Metrics 部分现已填充最终值, Loss History 图表显示整个 5 000 次迭
代的走势。底部的导出 部分现已激活 (所有格式按钮启用)。

检查器是 Expert Mode (⌘2) 中的右侧栏。它将所有训练相关的 参数集中在七个可折
叠部分。首次启动时从上到下的默认顺序为: Look、Presets、训练配置、Metrics、损
失图、Enhancements 和 Export。“Look”部分 (训练后的图像调整) 是早先“Finishing” 部
分真正的 UI 重命名 —— 出于持久化原因,其内部 enum 的 rawValue  仍为“Finishing”,
而显示的标题写作“Look”。每个 部分可通过单击标题折叠,顺序可通过拖放重

新排列 (InspectorView.swift:81-97)。首次启动时所有七个 部分都处于折叠状态 
(inspectorCollapsedSections 默认为 Set(InspectorSection.allCases));应用状态随后在
重启间 记住折叠和排序偏好。

检查器中的一系列控件以几乎相同的形式出现在设置中 (第 3 章) —— 通常是 SfM 后端、Sky 
Masking 和类似默认值。这种分离是 有意的:设置提供新建项目的应用全局模板,检查器为当前
打开 的项目覆盖这些值。一旦您熟悉了一侧的操作逻辑,就可以盲操 另一侧。

Expert Mode 中的左栏 —— Project Navigator —— 不属于检查器, 但是它的直接邻居。在那
里可以通过单击选择导入的图像、用空格 键以 Quick Look 查看,并通过减号按钮或删除键删除 
(用 Cmd-Z 撤销)。检查器跟随当前侧栏的选择,显示与之相关的详细信息, 但七个主要部分始
终可用。

Look 部分 (L1–L5)

Look 部分 (内部 rawValue  仍为“Finishing”) 是检查器最上方 的部分,将 训练后 的图像调整

集中在一处。所有滑块都 非破坏性 工作:每个滑块都将 FinishingPass  重新应用 到一个未改

动的 Pristine 快照 (原始 DC 颜色、Opacity、缩放) 上 —— 因此调整是 幂等的,而非累加。结

果 实时 显示在视口中 (WYSIWYG,与之后的导出完全一致),并会 烘焙进每一次导出。该部分仅
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在 一次训练运行 完成后 才可用 (在此之前显示“Available after a training run completes.”);

其值在 每次新训练时被重置。只要导出 正在进行,所有滑块都被 锁定 —— 会出现锁定提示 
“Locked while exporting — the file uses the current settings.”, 且 GroupBox 被禁用。

L1 Saturation 滑块

位置

检查器 → Look 部分 → GroupBox → Saturation。

技术细节

滑块 0.5–1.2,显示两位小数 (例如“1.00”)。按 亮度值缩
放每个 Splat 的 SH-DC 色度:1.0 = 不变,< 1.0 = 去饱和 
(颜色拉向灰阶),> 1.0 = 更鲜艳。在数学上,DC 颜色从 
Pristine 快照回算 ( desaturateDC ),因此反复拖动不会
累加。已在 DJI 无人机素材 (Pensford 高架桥) 上验证,
这类素材往往过饱和 —— 无人机默认值为 0.82。仅作
用于颜色基底 (SH 阶 0),更高的 SH 系数保持不变。

简单地说

完成的 Splat 颜色有多鲜艳。1.00 
让一切保持 训练时的样子,低于此
值会把颜色拉向灰色 —— 适合常
常过饱和 的无人机或视频素材。高
于 1.0 会更鲜艳。您可以随意来回
拖动, 不会有任何“累积失真”,因为
应用始终从未改动的原始状态重新 
计算。实时显示在视口中,导出时也
完全一致。

L2 Splat length 滑块

位置

检查器 → Look 部分 → GroupBox → Splat length。

技术细节

滑块 0.3–1.0,显示两位小数。在对数空间中将每个 
Gaussian 的三条缩放轴拉向其均值 ( shortenScale ,系
数 alpha ): 1.0 = 不变,较小值让细长的“针状”Splat 更
圆,0 则为纯球体。 针对针状、过度拉伸的 Splat,而不改
变整体尺寸,由此减少典型的 “彩屑”伪影。从 Pristine 快
照 (原始对数缩放) 应用,因此幂等。 与 Splat size (L3) 
可交换,因为两者都在对数空间中工作。

简单地说

让过长、碎裂的 Splat 更圆。1.00 
让形状保持 训练时的样子,较低值
把拉长的“针”压成更圆润的团块 
—— 这能 平息那些被彩屑伪影困
扰的颗粒状重建。整体尺寸保持不

变,只是 关乎长条程度。可以放心
与 Splat size (L3) 组合使用。
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L3 Splat size 滑块

位置

检查器 → Look 部分 → GroupBox → Splat size。

技术细节

滑块 0.5–2.0,显示两位小数。在 所有 三条 轴上均
匀缩放每个 Gaussian ( sizeScale ):1.0 = 不变,< 1.0 = 
更小/更密/更锐,> 1.0 = 更大/更“蓬松” (填补 Splat 之间
的 空隙)。由于缩放位于对数空间,乘法被实现为加性
的 log(factor)  偏移 —— 这与 Splat length (L2) 可
交换,因为一个恒定偏移不会 改动到“对均值的偏离”。从 
Pristine 快照应用,因此幂等。本版本 新增。

简单地说

将所有 Splat 均匀地放大或缩小。
1.00 是训练时的 状态,低于此值让
点云更紧、更锐,高于此值会盖住 
Splat 之间的 空隙 (显得更柔/更“蓬
松”)。实用之处在于把有洞的重建
在视觉上 补严,或反过来释放更多
细节。与 Splat length (L2) 完全相
容 —— 两个滑块互不影响。

L4 Fade far region (带子滑块)

位置

检查器 → Look 部分 → GroupBox → 开关“Fade 
far region” 加上子滑块“Fade start ×radius”和“Fade 
floor”。

技术细节

一个开关,激活随距相机质心距离的径向 Opacity 衰减 

—— 把背景中被弱观测的“Far 彩屑”淡出。仅用于轨道

拍摄: 当 finishingContext.fadeEligible 为 false (线
性飞行、相机过少 或退化) 时该开关被禁用;此时不
显示子滑块,而显示提示“Far-fade applies only to orbit 
captures (not this scene).”。适用性由相机 位置的方
位角覆盖确定 (一次轨道环绕质心并填满许多罗盘扇
区, 一次线性飞行仅 ~2 个)。两个子滑块控制几何:Fade 
start ×radius (1.0–3.0) 将内半径设为轨道半径的倍数,
在此范围内为 完整 Opacity;Fade floor (0.0–1.0) 是

远超 Fade 半径处 的 Opacity 系数。重要:Fade 跳

过 Sky-Dome 区域 (索引 [0, frozenCount) 的 frozen 
Gaussians),以免有意为之的 背景穹顶被一同变暗。

简单地说

把场景外缘那些软塌塌的残余淡

出 —— 正是那些在 环绕拍摄中远
远漂浮的“Far 彩屑”团块。仅在真
正的轨道/环绕拍摄 中起作用;在笔
直的无人机飞行或相机过少时,该开
关灰显,并有 提示解释原因。一旦
它处于激活状态,会增加两个微调:
“Fade start ×radius”决定从多远的
距离 (作为环绕半径的倍数) 开始淡
出, “Fade floor”决定远处的 Splat 
最终还保留多少可见度 (0 = 完全 
消失,1 = 不变)。有意重建的 Sky-
Dome (I44) 始终不会被触碰 —— 
天空保持原样。
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L5 Reset finishing 按钮

位置

检查器 → Look 部分 → GroupBox → “Reset finishing” 
(底部, 小按钮)。

技术细节

将所有 Look 设置重置为默认值 
(FinishingPass.Settings() = Saturation 1.0、Fade 
关、Splat length 1.0、Splat size 1.0),并立即触发一
次重新 Finishing,使视口回到 未改动的训练状态。
controlSize(.small)。由于整个 Look 栈从 Pristine 
快照幂等地计算,“回到默认”恰好是最初的训练输出 —— 
不会因反复来回而损失质量。和该部分的所有滑块一样,
在导出 进行期间被锁定。

简单地说

一键将所有 Look 滑块恢复为标准
值 (Saturation 1.00、Fade 关、两个 
Splat 滑块都为 1.00) —— 之后视
口再次精确 显示刚训练出的结果。
当您玩过头、想干净地从头开始时

很实用。 因为应用始终从原始状态
计算,这样做不会有质量损失。导出
进行 期间,该按钮 (和滑块一样) 被
锁定。

Presets 部分 (I1–I11)

Presets 部分是应用已测试配置的最快方式。内置预设 (Capture Class、 Classic、MCMC、
Hybrid) 提供来自 560+ 已记录实验的可复现起点; 自定义预设可保存、导出、导入和共享。列
表按类别 (Capture Class、 Classic、MCMC、Hybrid、Custom) 分组,可同时展开多个类别。
通过 右键菜单 (在某行上点击鼠标右键) 可以访问导出、复制以及 —— 对自定义预设 —— 
删除。

I1 Save…-按钮

位置

检查器 → Presets 部分 → Save…-按钮 (底部操作栏)。

技术细节

打开一个带文本框和 Save/Cancel 按钮的弹出层。当前
的 TrainingConfig 状态以新自定义预设的形式 持久化 
(JSON 编码,跨应用保存)。Save 操作复制所有 81 个训
练 参数加当前的 Densification 策略。无论从哪个内置
预设派生, 该预设都自动进入 Custom 类别。空名称和
纯空白输入会被丢弃。 已存在的名称不会被拒绝 —— 每
个预设拥有独立的内部 ID,重复 名称在技术上允许,但实
际上令人混淆。

简单地说

将当前配置保存为可复用的预设。 
按下按钮,在弹出层中输入名称并
单击 Save —— 所有 81 个参数 (包
括 Densification 策略) 都以您选择
的名称保存到 Custom 类别。当您
花了功夫调整,不想下次项目再从头
折腾时使用它。 对“Drone 4K”或
“Indoor 快速”这类重复设置特别实
用。重复 名称技术允许,但实际混
淆 —— 最好取个有意义的。
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I2 Preset Name 文本框

位置

Save 弹出层 → 文本框“Preset Name”。

技术细节

带圆角边框的简单宽文本框。 在单击 Save 按钮时,该值
用作 Preset 名称。UI 中无长度限制, 但保存的名称必须
可 JSON 编码且能在 UI 列表中显示 —— Emoji 和变音
字符可工作。打开弹出层时,内容自动重置为空字符串。 
在 Trim 后字段为空时,Save 按钮保持禁用。无自动建
议,也不 预填当前活动预设的名称。

简单地说

在此输入预设的名称。选择有意

义 的名称,如“Drone 4K 30fps”或
“Indoor 快速” —— 这样以后在 
Custom 类别中重新找时会更容易。
允许 Emoji 和变音字符, 没有硬性
长度限制。字段为空或仅由空格组

成时,Save 按钮 灰显。再次打开弹
出层时字段再次为空 —— 不会预
填活动预设 名称。

I3 Cancel 按钮 (Save 对话框)

位置

Save 弹出层 → Cancel 按钮 (左侧)。

技术细节

关闭弹出层而不保存。丢弃文本框 内容 —— 下次打开时
通过 Save… 按钮逻辑 (I1) 再次重置为空。 标准按钮样
式,无确认对话框,无热键。当前 TrainingConfig 保持不
变,因为根本没有执行 Save 路径。

简单地说

关闭 Save 弹出层而不保存任何 内
容。如果您改变主意、输入有误

或不小心打开了对话框 —— 只需
单击 Cancel。当前训练配置保持不
变,因为根本没有写入 任何东西。
下次打开弹出层时,名称字段重新为
空。无安全询问、 无热键 —— 直
接单击关闭。

I4 Save 按钮 (Save 对话框)

位置

Save 弹出层 → Save 按钮 (右侧,突出样式)。

技术细节

触发实际的持久化。再次验证 非空名称 (防御性检查),然
后将当前 TrainingConfig 作为 JSON 写入应用存储。随
后关闭弹出层。蓝色突出显示,字段为空时 灰显。如果保
存失败 (例如应用存储已满 —— 非常不可能), 当前没
有可见的错误对话框;那个预设在下次应用启动时只是 不
出现。

简单地说

单击 Save 即接受名称并将当前 设
置写为新预设。弹出层关闭,预设立
即出现在 Preset 列表 的 Custom 
类别中,从此可单击激活。按钮蓝色
突出 ( borderedProminent ),名
称字段为空时灰显。如果保存失败 
(例如 UserDefaults 已满),没有可
见的错误对话框 —— 那个 预设会
在下次应用启动时缺失。
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I5 Export…-按钮

位置

检查器 → Presets 部分 → 操作栏 → Export…-按钮。

技术细节

将当前选中的预设导出为 .radiancepreset  文件 (内
部 JSON)。无选中预设时禁用。 单击时,应用打开一个
带默认文件名 (预设名 + .radiancepreset  扩展名) 的
保存对话框。保存的格式包含 完整的 TrainingConfig 
加元数据 (名称、类别、ID、Built-in 标志)。在 Finder 

中双击会打开应用 —— 但 不会 自动导入;用户必须使用 
Import 按钮 (I6)。

简单地说

在列表中选择一个预设并单击 
Export —— 然后您可以将它保
存为 .radiancepreset  文件, 
例如发送给同事或转移到第二

台 Mac。接收方在另一台上使用 
Import… 按钮 (I6) 重新加载它。对
内置和自定义预设同样 有效。列表
中没有点选时按钮灰显。提示:通过
右键菜单 (I8) 更快 —— 不需要先
选中预设。

I6 Import…-按钮

位置

检查器 → Presets 部分 → 操作栏 → Import…-按钮。

技术细节

打开一个仅允许 .radiancepreset  文件的文件对话
框 (多选禁用)。选择后加载 JSON 文件、验证 并插
入 Custom 类别 —— 使用新的内部 ID 以避免与内置冲
突。 导入自动将类别设置为 Custom,即使导出的预设最
初是内置。 损坏或与较旧 schema 版本不兼容的文件被
静默拒绝,无错误 对话框 (但控制台日志提供说明)。

简单地说

从磁盘读取 .radiancepreset  
文件。在有人发给您经过验证的设

置或您希望在多台 Mac 之间 同步
喜爱的预设时很有用。导入的预设

始终进入 Custom 类别 —— 即使
原本是内置导出。损坏或过时的文

件被静默忽略; 控制台日志中说明
原因。对话框中的多选禁用,因此每
次单击 仅一个文件。

I7 Preset 行 (单击激活)

位置

检查器 → Presets 部分 → 各类别中的每个预设行。

技术细节

单击预设行会用预设中的值替换 TrainingConfig 的所有
字段,记住活动预设的 ID,并重置 Modified 状态。行
前的活动对勾仅在预设被选中且未修改时 出现。一
旦 TrainingConfig 中的值被更改 (其他检查器部分 中
的滑块、Stepper、开关),名称后会出现一个橙色的 
“Modified”徽章。内置预设无法被覆盖 —— 修改时必须
通过 Save 按钮 (I1) 创建自己的副本。

简单地说

单击行激活预设并将所有存储 的值
采纳到当前训练设置中。名称前的

对勾显示哪个预设当前 活动。一
旦您之后调整其他部分中的任何滑

块、Stepper 或 开关,名称后出现一
个橙色“Modified”徽章 —— 因为
您的 设置现在与预设不同。内置预
设无法被覆盖;如果您要保留 更改,
通过 Save… 按钮 (I1) 创建自己的副
本或复制预设 (I9)。
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I8 上下文菜单“Export…”

位置

右键单击任意预设行 → 第一项 “Export…”。

技术细节

与 I5 (Export… 按钮) 完全相同 的功能,但更便捷地可达 
—— 无需先选中预设。直接导出在 行上点击的预设。对
所有预设类别一致 (内置或 Custom), 无限制。导出包含 
Built-in 标志和原始类别,但 Re-Import 时,如 I6 所述,类
别被映射到 Custom。

简单地说

快速导出方式 —— 在所需预设上 
右键单击并选择“Export…”。省去
先点击再按 Export… 按钮 的麻烦。
对所有类别一致,包括内置。生成
的 .radiancepreset  文件与 
I5 相同;之后 Re-Import 时自动进
入 Custom 类别。

I9 上下文菜单“Duplicate”

位置

右键单击任意预设行 → 第二项 “Duplicate”。

技术细节

将预设克隆到 Custom 类别。 生成一个新的内部 ID,
在名称后追加“Copy”,并保存副本。 对内置预设也有效 
—— 副本可编辑。原始预设保持不变。 TrainingConfig 
逐值复制 (JSON Roundtrip),因此原始和副本 之间没有
引用绑定。

简单地说

在 Custom 类别中生成预设的 可
编辑副本。当您例如希望以内置

“Quality”预设为起点, 然后仅微调 
SSIM 滑块时很实用。工作流:复制,
重命名 (上下文菜单或新的 Save… 
运行),调整,完成。原始保持 不变 
—— 您随时可以回到它。对内置也
有效,这是接受其值 作为基础并使
之可编辑的唯一方式。

I10 上下文菜单“Delete”

位置

右键单击自定义预设行 → 最后一项 “Delete” (红色,破坏
性)。

技术细节

仅对自定义预设可见。内置无法 删除。该条目标记为破
坏性,在上下文菜单中显示为红色, 位于分隔符之后,以防

误点。没有 确认对话框 —— 单击立即删除预设。已删除
的预设无法恢复 (Cmd-Z 在 此处不工作 —— 当前版本
仅对图像列表支持 Undo,不对预设 操作支持)。如果删
除的预设当前是活动的,TrainingConfig 保持不变,仅活
动预设选择被清空。

简单地说

删除自定义预设。对内置 
(Quick、 Preview、Balanced、Quality、
Ultra Detail、Drone / Aerial、360° 
Walkaround、Photo / Object 等) 甚
至看不到“Delete” —— 您不会意
外杀掉它们。注意:没有 安全询问,
没有 Undo,单击预设即没了。如果
您不确定, 之前通过 Export… (I5/
I8) 在磁盘上拉一份安全副本 —— 
您 随时可以重新导入。如果预设
当前是活动的,您的 TrainingConfig 
保持不变,只是对勾消失。
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I11 类别标题 (展开/折叠)

位置

检查器 → Presets 部分 → 每个类别 标题 (Capture 
Class、Classic、MCMC、Hybrid、Custom)。

技术细节

每个类别的折叠状态默认不同: 精选的 Capture Class 

组初始 展开,Classic、MCMC、Hybrid 和 Custom 初始 

折叠。状态不持久化 —— 应用重启时所有类别 都回到默
认状态。Chevron 箭头带动画旋转。标题右侧的数字 显
示该类别中的预设数量。单击命中区域涵盖整个标题

区域。

简单地说

展开和折叠类别以保持预设 列表
整洁。应用启动时 Capture Class 
组打开,Classic、MCMC、Hybrid 和 
Custom 关闭。单击标题 (整个区域
可点击),列表带短促 Chevron 动画
展开或合起。右侧的小数字显示类

别中的预设 数量。应用重启后再次
回到默认状态 —— 应用有意不保
存 此折叠设置。

训练配置部分 (I12–I22)

图 11  仅训练配置部分的截图 — Camera Alignment (Apple Photogrammetry 活动,Native 
(Beta) 不活动)、Densification (Classic 活动)、Max Iterations 5,000 / Densify Until 3,500 带 

Link 图标、SSIM Weight 滑块 0.20、Render Scale 滑块 100 % (1,536×2,048 = 3.1 MP)

这里集中了核心调节项:哪个 SfM 后端应该计算、Densification 如何工作、多少次迭代、
SSIM 权重多大。在 MCMC 策略下会 出现两个额外的开关 (“MCMC Quality”和“Auto-scale 
by scene”), 在 Classic 模式中被隐藏。在 Native SfM 后端下会出现 FOV 覆盖字段,仅在没有 
EXIF 焦距的视频帧中使用。
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I12 Camera Alignment 选择器

位置

检查器 → 训练配置 → Camera Alignment (上方的分段
选择器)。

技术细节

带两个选项的分段选择器: Apple Photogrammetry 和 
Native (Beta)。选择决定下次相机 重建使用的 SfM 后
端。同时影响其他检查器元素的可见性: Native 额外显
示 FOV 覆盖 (I13),仅在没有 EXIF 的视频帧 中使用。提
示:对于非常大型户外拍摄,您可以通过 Workspace 导入
加载外部工具 (Metashape 或 COLMAP) 的结果 —— 见
第 1 章 (M5) 和第 9 章 (Q3、Q6)。

简单地说

在此选择如何重建相机位置 —— 
对最终质量最重要的开关。Apple 
Photogrammetry 是快速标准, 完
全适合多数物体扫描。Native 
(Beta) 是符合 App Store 要求 的自
有开发,对轨道和转台场景良好,且
对没有 EXIF 的视频帧 需要 FOV 覆
盖 (I13)。对非常大型户外集,您也
可以在 Metashape 或 COLMAP 中
计算相机,并通过 Workspace 导入
加载结果。 按场景类型的详细信息
和建议见第 9 章。

I13 FOV Override 字段 (Native SfM)

位置

检查器 → 训练配置 → FOV Override (仅在 Camera 
Alignment = Native 时可见)。

技术细节

数值文本框 (范围 0-170°),默认 0 = 从 EXIF 或启发式自
动确定。手动输入在输入图像从视频中 提取而无焦距元
数据时必要。典型值:iPhone Wide ≈ 73°、 DJI Mavic 
Wide-Crop ≈ 70°、全画幅传感器无人机 ≈ 84°。 值被
截断到 [0, 170] —— 范围外的值直接被推回。仅影响 原
生 SfM 流水线 (Q4/Q5);Apple Photogrammetry 完全
忽略 该值。

简单地说

如果您的图像没有 EXIF (从视频 
提取的帧典型),在这里输入相机水
平视场角的度数。经验值: iPhone 
Wide ≈ 73°、DJI Mavic Wide-Crop ≈ 
70°、全画幅传感器 无人机 ≈ 84°。0 
让应用自己猜测 —— 通常工作良
好,但在 稀有镜头下可能出错。超
过 170° 的值会自动被推回。该
字段 仅在 Camera Alignment (I12) 
选择 Native 时可见且有效 —— 
Apple Photogrammetry 完全忽略
它。
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I15 Densification 选择器

位置

检查器 → 训练配置 → Densification (分段选择器,始终
可见)。

技术细节

在两种 Densification 策略 之间切换:Classic (原
始 3DGS 方法,含 Clone/Split/Prune 和梯度阈值) 
和 MCMC (随机梯度朗之万动力学加 Relocation, 
NeurIPS 2024)。从 Classic 切换到 MCMC 时,应用
自动将 MCMC 特有字段设为已验证的默认值 (Reg-
Weights = 0、 MCMC-Cap-Multiplier 3.0、Sample-/
Noise-Schedule)。没有 此自动初始化,使用旧预设
的会话会遭遇 1.4.4-MCMC-Collapse bug (460K→5 
Gaussians,Watchdog 杀死)。选择器还决定哪些 检查
器元素可见 —— 在 MCMC 下出现 I16/I17。详细字段作
用 见第 6 章,T11–T16 (Classic) 和 T61–T73 (MCMC)。

简单地说

Gaussian 数量增长的核心策略 选
择。Classic 经过 459 个实验良好
调优,生成快速且高质量 的结果,
无需了解 MCMC 字段。MCMC 是
较新的方法 (NeurIPS 2024),更可
复现,无需手动阈值调整 —— 但在
可比质量下 计算时间约长 6×。切
换到 MCMC 时,应用自动设置安全
默认值, 以使训练不会进入 1.4.4-
Collapse。关于策略字段的细节见 
第 6 章 (T11–T16 Classic、T61–T73 
MCMC)。

I16 MCMC Quality 开关

位置

检查器 → 训练配置 → MCMC Quality (仅在 
Densification = MCMC 时)。

技术细节

将 Gradient-Accumulation 切换 为 2 步 (活动) 或 1 步 
(不活动)。在执行 Optimizer 步骤前, 累积来自两个连续
相机视角的梯度。经验上 (Session 33、 V544a),将最
终 L1 误差降低约 6 % (Quality 时 0.0246, 不启用时 
0.0261,基于 Horse-Full-MCMC 上 3 次试验平均)。 代
价:训练时间翻倍。对非常长的训练 (200K 迭代),增
加 10+ 分钟等待 —— 因此只在最后几个百分点的质量真
正必要时 才值得。仅影响训练,不影响导出格式或视口显
示。

简单地说

带跨两个视角 Gradient 
Accumulation 的 MCMC Quality 
模式。经验上让最终结果好 约 6 
% (Horse 测试中 L1 0.0246 替代 
0.0261),但耗时 翻倍。如果您已经
在跑 200K MCMC 训练 (通常 2 小
时), 再加近一小时。值得用于最终
展示渲染或 Quality Sweep 会话的
结尾,日常工作流中不太需要。仅在 
Densification 为 MCMC (I15) 时可
见。
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I17 Auto-scale by scene 开关

位置

检查器 → 训练配置 → Auto-scale by scene (仅在 
MCMC 下)。

技术细节

活动时,有效的 Max-Gaussians 上限按 SfM 初始点数 × 
MCMC-Cap-Multiplier (默认 3.0) 缩放。示例:SfM 提
供 250K 初始点,基础 Cap = 150K, Multiplier 3.0 → 有
效上限 = max(150K, 750K) = 750K。 未激活时仅严格
使用基础。在 v1.4.5 中引入,因为带超过 1000 帧的大型
户外拍摄,以及相应高的 SfM 点密度,在 150K Cap 默认
下 Densification 被饿死 —— 多余的点保留,新点 不能产
生。在 Custom 预设中默认关闭,在 MCMC 内置中默认 
开启。仅在训练时生效,不影响导出。

简单地说

让 Gaussians 的最大数量随 场景
大小 (确切地说:随 SfM 初始点数) 
增长。在小型场景中 您几乎察觉不
到差异,在大型户外场景中往往对质
量起决定 作用 —— 否则训练会“窒
息”,因为默认 150K 上限对场景 太
低。专门为 v1.4.5 引入,因为非常
大型户外集 (超过 1000 帧) 明显卡
在 Cap 上。在 MCMC 内置预设中
预先开启;在 自定义预设中默认关
闭。

I18 Max Iterations Stepper

位置

检查器 → 训练配置 → GroupBox → Max Iterations。

技术细节

范围 1 000–100 000 的 Stepper, 步进 1 000。
决定 Optimizer 迭代的总数。与训练时间线性 
相关 (减半 = 约 50 % 时间)。经验上的甜
点:20K (Classic Balanced,L1≈0.028)、40K (Classic 
Quality,L1≈0.023)、 200K (MCMC Full,L1≈0.0246)。
在 Classic 中,40K 以上 平均带来的改进很小 —— 收
益递减。修改时,如果 Link 函数 (I19) 处于活动,Densify 
Until 按比例随动 (默认比例 0.5, 即 Densify-Until = 
Max/2)。

简单地说

执行多少个训练步 —— 更多 更好,
但也线性消耗更多时间。经验法则:
良好质量 20 000, Classic 策略的
最佳点 40 000 (再多平均几乎没有
提升)。 MCMC 需要明显更多,200 
000 是这里的标准。迭代翻倍大约 
让训练时间翻倍。Link 按钮 (I19) 
活动时,Densify Until 按比例随动 
—— 几乎总是您想要的。
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I19 Link/Unlink 按钮 (Densify ↔ Iterations)

位置

检查器 → 训练配置 → GroupBox → Max Iterations 与 
Densify Until 之间的小 Link 按钮。

技术细节

切换按钮,固定 Densify Until 与 Max Iterations 的比
例。活动时 (Link 图标突出),每次 更改 Max Iterations 
时,Densify Until 按比例随动。Unlink 时 (Link-Plus 图
标),两值保持独立。默认 linked,因为这 反映了典型
相关性 —— 您把训练拉到双倍迭代时,通常也希望 
Densification 按比例延长。比例在设置 Link 按钮时从
当前值 计算;典型比例为 0.5 (Densify-Until = 迭代数的
一半)。

简单地说

Max Iterations 与 Densify Until 之
间的小夹子按钮。活动时 (Link 
图标突出),两个值 共同移动 —— 
您把 Iterations 翻倍,Densify Until 
也按 相同比例翻倍。未激活时 
( link.badge.plus  图标),您可
以 独立设置。默认链接,因为这反
映了典型相关性 —— 较长训练 通
常希望较长的 Densification 阶段。
99% 的情况让它扣着。

I20 Densify Until Stepper

位置

检查器 → 训练配置 → GroupBox → Densify Until。

技术细节

范围 500–50 000 的 Stepper, 步进 500。决定从
哪个迭代索引起,不再通过 Clone/Split (Classic) 或 
Relocation (MCMC) 添加新 Gaussians。达到后, 仅细
化位置和颜色。更高值 = 更多 Gaussians = 更大文
件, 更长的每次迭代时间 (+30-60% GPU 时间/步)。
典型值:15K (对 30K Max-Iter)、20K (对 40K)、100K 
(对 200K MCMC)。 Link (I19) 活动时自动缩放。在 
Classic 与 MCMC 中作用 不同:Classic 完全停止增
长,MCMC 停止 Relocation 逻辑, 但 Sample-/Noise-
Adaption 继续。

简单地说

允许添加新 Gaussians 直到 哪
次迭代 —— Classic 通过 Clone/
Split,MCMC 通过 Relocation。 之
后仅细化已有点的颜色和形状。

更高 = 更多细节,但也 更大文件
和每步 +30-60% GPU 时间。典
型值:15K (对 30K Max-Iter)、20K 
(对 40K)、100K (对 200K MCMC)。
通常通过 Link (I19) 挂在 Max 
Iterations 上 —— 手动解耦很少有
意义。
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I21 SSIM Weight 滑块

位置

检查器 → 训练配置 → GroupBox → SSIM Weight。

技术细节

范围 0.0–1.0 步进 0.05 的滑块, 显示为“0.20”。混合 
L1-Loss (0.0) 与 SSIM-Loss (1.0)。 L1 收紧每像素亮
度,SSIM 收紧结构相似性 (边缘、局部统计)。 默认 0.2 
来自原始 3DGS 论文 (Kerbl 2023),在大量会话中 反向
工程出作为稳健折中。更高值 (0.5+) 偏向细节保留, 
但可能忽略局部亮度错误。更低值 (< 0.1) 在锐边处导致 
细节丢失。SSIM 在着色器中使用 11×11 高斯窗口计算。 
性能:在 0.0 (仅 L1) 下训练快约 8-12 %,因为着色器中 
跳过 SSIM 计算。

简单地说

结构图像相似性 (边缘、局部 图
案) 相对于纯亮度比较的权重。0.2 
是原始 3DGS 论文的 标准值,对几
乎所有场景足够。对头发、毛发

或植被等精细 结构使用更高 (0.5+) 
—— 那里更多结构权重有帮助。更
低 (0.0) 让训练快约 8-12 %,因为着
色器中跳过 SSIM 计算, 但在锐边处
损失细节。没有充分理由更改时保

持 0.2。

I22 Render Scale 滑块

位置

检查器 → 训练配置 → GroupBox → Render Scale。

技术细节

范围 0.25–1.0 步进 0.25 的滑块, 显示为“100%”。相对
于源图像大小缩放训练渲染分辨率。 对性能影响最
大:50% 减少 GPU 时间约 75% (因为像素少 4 倍), 
25% 约 94%。梯度阈值自动随之缩放。滑块下方出
现实时 分辨率显示,单位 MP (例如“2304×1296 (3.0 
MP)”)。如果 当前值偏离建议值,以橙色字体显示“— 
recommended: 50%”。 建议针对约 3 MP 的有效分辨
率 —— Apple Silicon GPU 最 高效处理的区间。例如 
4K 源图像自动建议 25%,FullHD 图像 100%。更改还会
触发缓冲区重新分配。

简单地说

训练以哪种分辨率渲染 —— 最大
的性能调节项之一。完整 (100%) 
提供最佳质量,但在 大图像上消耗
大量 GPU 时间。一半 (50%) 节省
约 75% GPU 时间,因为像素少 4 倍 
—— 对 4K 源完美。滑块下方您看
到 以兆像素为单位的有效分辨率;
应用瞄准约 3 MP,因为这在 Apple 
Silicon 上最高效。如果您的值偏
离,应用显示橙色 “recommended”
提示 —— 通常值得遵循。
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Enhancements 部分 (I26–I29, I42–I44)

图 12  仅 Enhancements 部分的截图 — 三行:Post-Training Compactification (开关开)、
Viewport Scaling (分段选择器 Off/MetalFX/Lanczos)、Perceptual Loss (滑块在“Off”)。 每行带

副标题说明功能

Enhancements 部分将三个能在不更改核心训练循环的情况下 改善图像质量的特性分组。前

两个 (I26-I27) 是 训练 后 或 视口 阶段:Compactification 在训练结束后 清理,Viewport 
Scaling 是纯视口渲染器,不影响正在进行的 训练。Perceptual Loss (I29) 尽管位于本部
分,却是训练组件 —— 它在训练期间作为额外 Loss 项激活,因此通过分隔符与 视口开关
分开。自 v1.6 起,本部分还有一个 Outdoor 组 (I42–I44:Sky Masking、Mid-Training Floater 
Cleanup、 Reconstruct Sky Dome) —— 针对天空漂浮物的训练选项,以前 位于设置窗口中,
现在按项目置于此处。
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I26 Post-Training Compactification 开关

位置

检查器 → Enhancements → Post-Training 
Compactification。

技术细节

激活 V443 后处理:训练迭代 结束后,删除 Opacity 低
于 0.01 (1% 可见性) 的 Gaussians。 经验上这将文
件大小减少约 55-58%,无可见质量损失 —— 因为这些 
Gaussians 在视觉上反正不贡献。Compactification 作
为 GPU Compact Pass 运行,根据 Gaussian 计数耗时
几分之 一秒到几秒。不影响训练性能。如果此开关关闭,
不可见 Gaussians 也被导出 —— 仅在您想将该格式用
于另一个训练 阶段 (Continue Training) 时相关,否则浪
费存储。

简单地说

训练后清理您反正看不到的 
Gaussians (Opacity 低于 1%)。让
导出文件大小减半左右 ( 55-58% 
缩减) 而无可见质量损失。作为最
后一次迭代后的 短 GPU Pass 运
行,只耗时几分之一秒到几秒。几
乎总是该开启 —— 关闭它的唯
一原因是您之后通过 Continue 
Training 继续 训练,需要保留不可
见 Gaussians。对正常导出工作流
就开着。

I27 Viewport Scaling 选择器

位置

检查器 → Enhancements → Viewport Scaling (带三个
选项的 分段选择器:Off、MetalFX、Lanczos)。

技术细节

一个单独的分段选择器,用于选择视口放大器 —— 这

三个选项 互斥。如果训练分辨率 (通过 I22 Render 
Scale) 低于视口大小,所选模式会将渲染帧放大到显示大
小。 Off = 简单的双线性拉伸。MetalFX = Apple 基于 
ML 的 Spatial Upscaler,最锐利的选项 (ML 模型针对锐
边 优化),在 M3 GPU 上开销约 1-2ms 每帧。Lanczos 
= Apple Metal Performance Shaders 加 8-Tap Sinc 
重采样,经典 而无 ML,开销最小 (< 0.5ms),质量低
于 MetalFX,但没有 ML 典型的对精细线条结构的“抹
平”。切换时渲染器流水线实时 重新配置 —— 立即可见,

无需重启。背景: 早先这是 两个独立的开关 (MetalFX 
+ Lanczos),可以同时开启 —— 一个 矛盾状态,其中 
MetalFX 会悄悄盖过 Lanczos。该选择器移除了 这一状
态;若从旧会话继承了“两个都开”的状态,会在下次 切换

时自动自愈为 MetalFX。仅 影响实时视口,不影响 渲染
的导出 (Orbit Video、截图) —— 那些以完整源分辨率
渲染。

简单地说

在视口中将实时图像锐化 —— 当
您使用降低的训练 分辨率 (Render 
Scale 50%,见 I22) 工作时尤其有
用。三个档位, 始终只有一个处
于活动状态:“Off”只是简单拉伸像
素,“MetalFX” 使用 Apple 的机器学
习获得最锐利的边缘 (几乎总是最
佳选择), “Lanczos”是无 ML 的经典
滤波器 —— 当 MetalFX 在某场景
中给您 平滑线条或显示伪影时,把
它作为回退。实时生效,无需重启。 
仅在实时视口中起作用,不影响导出
的 Orbit 视频或截图 —— 那些以完
整源分辨率渲染。与早先不同,您不
能再不小心同时 选择两个模式。
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I29 Perceptual Loss 滑块

位置

检查器 → Enhancements → Perceptual Loss。

技术细节

范围 0.0–0.2 步进 0.01 的滑块, 0.0 显示为“Off”,否则为
“0.05”等。激活一个额外的 Loss 项,比较渲染的多尺
度高斯模糊与 Ground-Truth 图像 (3 个 模糊尺度)。捕
获 L1+SSIM 单独无法识别的结构差异。V460 实现。经
验上 0.05-0.1 的值让会话 L1 提升几个百分点, 但花
费  5% 训练时间 (通过模糊核的额外前向传递)。超
过 0.15 时训练变得不稳定,L1 再次恶化 (Loss 项主导

优化)。 作用 期间 训练,不在后处理 —— 尽管位于 
“Enhancements”部分,因此并非纯粹的事后增强。

简单地说

额外的 Loss 部分,通过三个 不同
的模糊级别检查图像结构相似性。

对具有头发、织物或 植被等精细
结构的场景特别有用,因为它捕获 
L1+SSIM 单独 看不到的图案。较小
值更安全 —— 0.05 到 0.1 是甜点,
超过 0.15 训练变得不稳定,Loss 再
次恶化。在 0 (Off) 时功能 完全关
闭,无开销;活动时通过模糊核的额
外前向传递吞噬 约 5% 训练时间。
尽管位于“Enhancements”部分,在
训练 期间直接生效,而非仅在后处
理中。

I42 Sky Masking

位置

检查器 → Enhancements (Outdoor 
组) → 开关“Sky Masking”。 绑
定:AppState.trainingConfig.skyMaskingEnabled (按
项目, @DefaultFalse )。默认: false 。

技术细节

启用训练前基于 Apple Vision 的天空像素 分割。
在训练开始前,对每个输入相机通过 Apple Vision 
Foreground Mask 提取天空区域 (Sky = Background),
并作为各相机的逐像素掩码 关联。训练过程中,每个
像素的 Loss 贡献乘以天空掩码的补集 —— 天空像素
对梯度贡献为 0,因此投影到天空中的 Gaussians 不会收
到 任何优化信号,也就不会变“更密”或“更亮”。能在户
外/无人机场景 中显著减少漂浮物 (天空中的暗团)。在经
典 40K 训练中代价是约 3% 的 L1 回归 (见 memory/​dev_​
outdoor-floater-reduction.md)。 仅在可清晰识别天
空的户外场景中有用;在室内场景或白色背景中, 天空分
割会识别错误区域,屏蔽有效的 Loss 信号。该值现在按
项目 存储 (不再是应用全局),并跟随预设/场景文件。

简单地说

带天空的户外拍摄常常在天空中

出现黑色或 彩色团块 —— 即所
谓的“漂浮物”。此选项自动识别
天空位置,并告诉 训练:“别动天
空”。在无人机飞行和风景场景中
效果非常好。在室内 或深色背景
下可能会让图像变差 —— 因此只
有在能看到真正天空时 才启用。
详情:memory/​dev_​outdoor-
floater-reduction.md。
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I43 Mid-Training Floater Cleanup

位置

检查器 → Enhancements (Outdoor 组) → 开关“Mid-
Training Floater Cleanup”。绑定:AppState.trainingConfig.floaterCleanupEnabled 
(按项目, @DefaultFalse )。默认: false 。

技术细节

在 Classic 40K 训练 (预设“P4 Quality”) 中 启用两
个额外的密度控制 Pass:在第 20,000 和第 30,000 次
迭代时。 两次 Pass 都按三个条件搜索所有 Gaussians:
(a) 极低的 Opacity (标准 0.005),(b) 微小的屏幕空间尺
寸,(c) 过去 1000 次迭代中 没有 Loss 贡献。满足所
有三个条件的 Gaussians 会被清除。效果: 训练结束
时 Gaussians 减少 ~5–15%,在无人机/户外场景中明
显 减少天空中的暗团。在近景室内场景中代价约 1–
3% L1 回归,因此 不作为默认启用。该值在重启后保
留 (与 S7 相反)。两次清理迭代 (20K、30K) 被硬编
码,目前无法通过 UI 更改;在较短的训练中 (例如 P2 
Preview 5K),该开关无效,因为永远到不了这些迭代标

记。 新增: 该开关仅在活动预设使用 Classic 密集化
器 (densificationStrategy == .classic) 时才可操

作。对于 MCMC 或 Hybrid,它被 禁用 并出现一条内联
提示,因为这些策略自己 处理死掉的 Gaussians (MCMC 
通过 Relocation,Hybrid 通过组合的 Reloc/Noise 逻辑) 
—— 手动清理 Pass 在那里会无效甚至适得其反。 代
码引用:RadianceKitApp.swift,General 标签页。详情: 
memory/​dev_​outdoor-floater-reduction.md。

简单地说

训练过程中有时会产生“死掉”的 
Gaussian 点,它们已不再对图像质
量做贡献,但占用内存。此选项在
长时间训练 中两次清理 (在 20K 和 
30K 次迭代时) 并移除这些尸体。
对带天空 的户外场景特别有用,因
为那里集聚了最多漂浮物。对小型

训练或 家具的近景拍摄通常不必
要。只有当您的预设使用 Classic 
密集化器 时,这个开关才能打开 
—— 对于 MCMC 或 Hybrid 预设,
它会灰显 (并附一段简短说明),因为
它们自己会清理死掉的点。
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I44 Reconstruct Sky Dome

位置

检查器 → Enhancements (Outdoor 组) 
→ 开关“Reconstruct Sky Dome”。绑
定:AppState.trainingConfig.skyDomeEnabled (按项
目, @DefaultFalse )。默认: false 。

技术细节

启用训练前的 Sky-Dome 投影 (V549e MVP)。 在 SfM 
之后、训练开始之前,对每个输入相机从图像中提取与 
S7 共享的 Apple Vision 天空掩码;天空像素用相机内参
反投影到一个 虚拟球面 (标准半径为 8× 场景半径)。在
该球面上初始化 ~5000 个 新 Gaussians,其颜色均值来
自投影的天空像素,具有非常大的缩放 (在场景单位中
为 1.0) 和初始 Opacity 0.95。这 5000 个 Gaussians 
并不是经典意义上的 Sky-Mask —— 它们与所有其
他 Gaussians 一样 被训练,但通过高初始 Opacity 保留
在一个薄壳上。结果:在户外/ 无人机场景的 360° 新视
角中,出现的是真实的天空颜色和云结构, 而不是黑色的
彩屑团块。该值在重启后保留。仅在至少 360° 相机 覆
盖的户外场景中有用;在没有天空视野的纯物体扫描中无
效。 状态:实验性,在更多户外集上的更广泛 A/B 验证仍
待进行。

简单地说

与其让训练试图从几个可见像

素中“猜”天空 (这会导致漂浮
物),RadianceKit 在训练开始前将
天空像素直接投影 到围绕场景的
虚拟球体上。当您随后将完成的场

景在 360° 中旋转时, 看到的就是真
实天空,而不是黑色团块。只在画面
中确实有天空的 户外拍摄中起作
用。对客厅扫描或工作室拍摄没有

帮助。
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Metrics 部分 (I30–I38)

图 13  仅花束完成训练 (5K 迭代,最终 2 991 Gaussians) 后 Training Metrics 部分的截图 — 训
练指标表格 (Iteration、Loss、SSIM Loss、 Combined Loss、Gaussian Count、Learning Rate、

Elapsed、ETA)

训练运行时,Metrics 部分显示来自训练循环的九个实时值。 训练启动前该部分为空 (“Start 
training to see live metrics”)。 所有值每 ~30 次迭代更新一次 ( 流的更新频率)。该部分
是只读的 —— 没有任何元素可单击或 更改。如需深入分析,请参考 ~/​Documents/​RadianceKit/​
Logs/​ 下的 JSONL 训练日志 (脚本 python3 scripts/​analyze_​logs.py best 5)。

I30 Iteration

位置

检查器 → Metrics → Iteration。只读。

技术细节

格式“4523 / 40000”显示 —— 当前迭代/总计划迭代。
与训练循环同步,后者每 ~30 次 迭代推送值。第二个
数字对应启动时的 Max-Iterations 值; 即使用户之后调
整 Stepper 也不再变化 —— 当前运行使用自己 的快照
副本。如果应用通过 Training 菜单追加迭代 (Continue 
Training +5K/+10K/+20K),分母增加。

简单地说

训练当前所处位置。“4523 / 
40000”意味着:40 000 步中已完成 
4523 步,约 11%。左数 按秒钟向上
计数;如果它停滞数分钟,训练卡住 
—— 通常表明 GPU 节流或竞争性
应用。右数对应训练启动时的 Max 
Iterations (I18),即使您之后调整 
Stepper 也不再变化。在 Continue 
Training (+5K/+10K/+20K) 时它随
附加步增长。
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I31 Loss

位置

检查器 → Metrics → Loss。只读。

技术细节

六位小数浮点值 (例如 “0.024385”)。衡量组合的 
L1+SSIM-Loss (混合由 I21 SSIM Weight 控制) 加可选 
Perceptual Loss (I29) 和其他正则化项。 尺度不是绝对
的,而是场景相关 —— 多数比较需要相同数据集。 良好
配置的典型最终值:- Classic Quality 40K iters: 0.022–
0.025 (Horse、Truck、Garden) - MCMC Full 200K 
iters: 0.024–0.028 - 户外无人机 30K:0.030–0.060 
(几何原因更差)
• 室内公寓:0.018–0.025

5K 迭代后超过 0.10 的值表明 SfM 问题 (相机位姿不佳) 
—— 中止并重新计算 SfM。

简单地说

渲染图像与原始的偏离程度 —— 
由 L1、SSIM 以及可选 Perceptual 
Loss 组合。越小越好。 0.03 以下
通常很好,0.05 以下还行,户外场景
由于几何原因 更多在 0.03-0.06。
几千次迭代后超过 0.10 是警告信号 
—— 通常归因于相机重建 (SfM 没
干净地工作)。尺度不是绝对的, 而
是场景相关;仅在相同数据集内比
较。如果数字突然向上 跳,通常发
生了梯度爆炸事件。

I32 Learning Rate

位置

检查器 → Metrics → Learning Rate。只读。

技术细节

科学记数法显示 (例如 “1.60e-04”)。位置参数的当前学
习率 (3DGS 有六个独立 LR: 位置、SH-DC、SH-Rest、
Opacity、Scale、Rotation —— 这里 显示位置 LR 作为
代表)。默认初始 1.6e-4,通过指数衰减 降至训练末的 
~1.6e-6。衰减可通过训练配置中的 LR-Schedule 字段
调整 (第 6 章中的 T 字段)。如果 LR 异常保持高 (例如 
10K 迭代后仍为 1e-3 或更高),可能表明配置加载错误。

简单地说

优化步长当前大小 —— 具体 
是 Gaussian 位置的学习率。从 
1.60e-04 开始,指数下降到 训练
结束时约 1.60e-06 (“1.60e-06” = 
0.0000016)。曲线 自动运行,您无
需调整。如果 10 000+ 迭代后值
仍大于 1e-3, 可能加载了错误配
置 —— 中止训练并重新选择预
设。3DGS 内部 有六个独立学习率 
(位置、SH-DC、SH-Rest、Opacity、
Scale、 Rotation);您仅看到位置 LR 
作为代表。
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I33 SH Degree

位置

检查器 → Metrics → SH Degree。只读。

技术细节

整数 0-3。颜色表示的球谐 阶数。从 0 (仅 DC 分
量,即每个 Gaussian 方向无关的颜色, 也就是仅 RGB 
常量) 开始,在训练过程中逐步升至 3。标准 计划在
迭代 1000/2000/3000 时各提升 1。SH-3 对应每个 
Gaussian 48 个颜色系数 (3 RGB 通道 × 16 SH 基函
数)。 更高 SH 阶 = 更多方向相关反射 (光滑表面在不同
视角下正确 不同),但也更多内存和较慢训练。

简单地说

每个 Gaussian 当前的 颜色表示有
多复杂。从 0 开始 (每点仅一个方
向无关的颜色), 逐级提升至 3 —— 
通常在迭代 1000、2000 和 3000。
第 3 级 意味着每个 Gaussian 48 
个颜色系数,并允许方向相关反射, 
即光滑表面在不同视角下正确不

同。无需主动触碰,计划自动 运行。
更高阶花费更多内存并略微减慢训

练 —— 但这是真实 反射的代价。

I34 Gaussians

位置

检查器 → Metrics → Gaussians。只读。

技术细节

模型中 Gaussians 的当前 数量,以语言环境分隔符格式
化 (例如“524.318”)。增长:
• Classic:从 SfM 初始点 (典型 50K-300K) 开始,通过

Clone/Split 增长直到 Densify Until 之前不久,然后静态
直到 训练结束 (减去 Pruning)
• MCMC:Sample 点添加到 MCMC Cap,然后仅 

Relocation

健康的最终值:- Classic Quality:400K-700K (Horse 
524K、 Garden 800K) - MCMC Full:精确在 Cap 上 
(默认 150K, Auto-Scale Multiplier × SfM-Count 视场
景 500K-1.5M)

在 MCMC 中,数字落到 < 60% Cap 是异常 (Collapse 
指示器, 表明正则化过于激进)。

简单地说

3D 模型当前有多少 Gaussian 点。
在训练期间增长,直到达到 Densify 
Until (I20);之后 数字几乎保持恒
定。更多点 = 更多细节,但也更大文
件和较慢 的视口渲染。500.000 
Gaussians 是中等场景 Classic-
Quality 的典型中值;MCMC Full 视 
Auto-Scale (I17) 而定,在 500K 到 
1.5M 之间。如果 MCMC 中数字
突然落到 Cap 的 60% 以下, 是 
Collapse 指示器 —— 通常正则化
过激进。
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I35 GPU Memory

位置

检查器 → Metrics → GPU Memory。只读。

技术细节

将 Gaussian 缓冲区内存 消耗估算为 Gaussian-Count 
× 616 字节 (以内存样式格式化)。 616 字节是充分装备
的 Gaussian (位置、缩放、旋转、Opacity、 SH 系

数 Grad 3、梯度累加器) 的经验大小。该显示 不 包
含渲染器开销 (Tile 缓冲、Sort 缓冲、Backward 缓
冲) —— 实际 GPU 内存需求通常是该值的 2-3×。500K 
Gaussians 时: 显示约 290 MB,实际约 700 MB。1.5M 
Gaussians 时:显示 约 880 MB,实际约 2.5 GB。在 64+ 
GB Unified Memory 的 M3 Max 上不关键,在 18 GB 的 
M3 Pro 上已是极限。

简单地说

Gaussians 自身占用多少 GPU 内存
的估计 —— 每点约 616 字节。实
际 GPU 消耗是显示 的 2-3 倍,
因为渲染器还增加自己的 Tile、
Sort 和 Backward 缓冲。在 16-18 
GB Unified Memory 的 MacBook 
上,您应保持 500K Gaussians 以
下;M3 Max 或 Studio (64+ GB) 可
以 轻松跑 1.5M 及以上。如果训
练突然崩溃或系统交换,通常 这里
达到极限 —— 降低 Render Scale 
(I22) 或减少 Densify Until (I20)。

I36 Speed

位置

检查器 → Metrics → Speed。只读。

技术细节

每秒迭代数,带一位小数 (“24.3 it/s”)。由训练器作为最
近 ~100 次迭代的滑动平均 计算。典型值:- Quick 预设 
(1K iters):80-120 it/s (短,无 steady-state) - Classic 
20K @ 1.0 Render Scale (Truck 场景,M3 Max):25-35 
it/s - Classic 20K @ 0.5 Render Scale:80-120 it/s 
- MCMC 200K @ 0.5 Render Scale: 25-50 it/s (因 
Relocation 较慢) - 1M+ Gaussians 完整 分辨率下:< 10 
it/s

训练过程中速度下降是正常的 —— 更多 Gaussians = 每
次 迭代更多计算。突然下降 (例如从 30 → 5 it/s) 表明 
GPU 热节流或竞争性应用。

简单地说

训练运行速度,每秒迭代数。 通常
处于 20-50 it/s,在降低的 Render 
Scale (50%) 和小型 场景中可达 
80-120 it/s。在训练过程中自然下
降,因为更多 Gaussians = 每次迭代
更多工作。突然下降 (例如 30 → 
5 it/s) 表明 GPU 热节流或竞争性
应用 —— 播放视频的浏览器标签
页、 Time Machine 备份、Photos 
索引。让应用在前台并关闭后台 程
序通常有帮助。在 1M+ Gaussians 
和完整分辨率下,低于 10 it/s 正常。
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I37 Elapsed

位置

检查器 → Metrics → Elapsed。只读。

技术细节

已经过的时间,作为“4:23” (m:ss) 或“1:23:45” 
(h:mm:ss)。1 小时起切换格式。仅测量 纯训练时间,不
包括前置阶段 (SfM 计算、图像导入)。 Pause/Resume 
时时钟继续走 —— 因此是 wall-clock, 不是 CPU 时间。

简单地说

训练已运行多久,作为纯 秒表 
(Wall-Clock 时间)。格式 1 小时以
内“m:ss”,之后 “h:mm:ss”。不是
“CPU 时间”,而是“我们已经等了多
久” —— 因此 Pause 时间也计入。
仅测量纯训练阶段,不包括 前置 
SfM 计算或图像导入。与 ETA (I38) 
比较时有用 —— 如果 Elapsed 明
显超过原 ETA,训练某处变得比计划
慢。

I38 ETA

位置

检查器 → Metrics → ETA。只读。

技术细节

预计剩余时间,作为“17:42” 或“1:12:35”。计算:(Max 
Iterations − 当前迭代) / 每秒 迭代。当 Speed 当前

为零时显示“–” (开始或暂停时)。 估计 不 适配训练末典
型的减速 —— 特别是 MCMC 和 Classic 在大 Densify-
Until 值时,训练倾向于变慢, 因为越来越多的 Gaussians 
进入图像。实际上通常保持比 起始 ETA 高 10-20%。

简单地说

预计还需等多久 —— 由 剩余迭代
和当前速度 (I36) 计算。粗略估计:
如果 Mac 突然 变慢 (从 Densify 阶
段起更多 Gaussians、热节流、其他 
应用),可能比显示的更长。应用未
计入训练末典型减速, 因此实际结
束通常比起始 ETA 多 10-20%。加 
15% 通常就对。 Speed 当前为 0 
(训练开始或暂停) 时显示“–”。
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损失图部分 (I39–I41)

图 14  训练完成后仅 Loss History 部分的截图 — Current 0.0064、 Min 0.0035 (绿色)、蓝
色走势从 0.027 (迭代 1) 到 0.0035 (迭代 5K), 在迭代约 200 处有特征拐点,下方是橙色 Gaussian 

Count 图

损失图部分可视化训练随时间的过程。它由两个图表组成: Loss Curve 图 (大,上,蓝色) 和 
Gaussian Count 图 (较小, 下,橙色)。两者在训练期间实时构建,持续到下一次训练启动。 首次
训练前该区域为空 (“Loss curve will appear during training”)。图表是纯 SwiftUI Path 绘制 
(不使用 Swift Charts 框架),以便在 100K+ 点时仍流畅渲染。

I39 Current Loss (显示)

位置

检查器 → 损失图 → 左标签区 “Current: 0.0287”。只
读。

技术细节

上次 Loss 采样点的浮点 值,格式化为四位小数。与 I31 
(Metrics 部分中的 Loss) 相同,只是这里更紧凑格式化。
来源是 Loss History —— 每 ~30 次迭代获得一个条目
的列表。仅有限值被纳入列表 —— NaN/Infinity (非常罕
见,梯度爆炸 bug 情况) 被过滤。

简单地说

比 Metrics 部分中更短 写法的当前 
Loss 值 (四位小数)。内容上与 I31 
相同,但 这里的显示直接位于 Loss 
图旁,在观察曲线时给您精确数值。 
和所有实时指标一样每 ~30 次迭代
更新一次。应用自动过滤 NaN 或 
Infinity 值 (在梯度爆炸 bug 时极罕
见)。在看图时 不必跳到另一部分
时很有用。
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I40 Min Loss (显示)

位置

检查器 → 损失图 → 右标签区 “Min: 0.0245” (绿色)。
只读。

技术细节

当前训练运行中曾见的所有 Loss 值的最小值。从 Loss 
History 实时重计算 —— 无单独 持久化。以绿色字体显
示,因为“Min”=“迄今最佳”。图表 下边缘的绿色虚线在视
觉上标记此 Y 位置。在 Continue Training 会话中,最小
值跟踪重新开始 —— UI 中旧 History 被新 History 替换 
(不附加)。如果当前训练比前次差,Min 显示可能大于前
次最终结果。

简单地说

此训练迄今见过的最低 Loss 值 
—— 显示为绿色,因为“迄今最佳”。
图表下边缘的 绿色虚线也视觉地标
记此位置。如果当前曲线明显在其

上, 运气好还有提升;但通常 Min 是
您稍后关心的最终结果指示。 在 
Continue Training 会话中,Min 跟
踪重新开始,因为 UI 中旧 History 
被新 History 替换 —— Min 值因此
可能比前次 最终结果显得更差。

I41 Gaussian Count 图

位置

检查器 → 损失图 → 下方的 第二个图 (橙色)。只读。

技术细节

Gaussian 数量随训练迭代 的折线图。来源:Gaussian-
Count History ((Iter, Count) 对的列表,由训练器每 ~30 
次迭代填充)。Y 轴在 History 的最小值和最大值之
间动态。Classic 策略中曲线通常这样: 持续上升直到 
Densify Until,然后平稳 (带小 Pruning 波动)。MCMC:
陡升至 Cap,然后水平线 (Relocation 保持 数字恒定)。

如果在活动训练下曲线 下降, Densification 过度激
进 Pruning —— 错误默认值或已知的 MCMC Collapse 
bug (v1.4.4 热修主题) 的迹象。

简单地说

Gaussians 数量随训练 时间如何
演变 —— Loss 曲线下方较小的
橙色图。Classic 策略下,线持续上
升直到达到 Densify Until (I20),然
后 保持平稳带小 Pruning 波动。
MCMC 下,它陡升至 Cap 并 保持
水平,因为 Relocation 保持数字恒
定。如果尽管训练 活动曲线突
然向下弯曲,Densification 过度激
进 Pruning —— v1.4.4 中 MCMC 
Collapse bug 的经典迹象。然后帮
助 应用升级或切换回 Classic。

如何读取 Loss 曲线?

Loss 图表是检查器中最重要的诊断工具 —— 没有其他指标 能如此直接显示训练是否有用进展
或卡住。典型健康形状是 前 1000-3000 次迭代中的快速下降 (从 ~0.15 到 ~0.05), 然后到训
练结束的缓慢均匀下降 (到 0.020-0.030)。曲线 对数化呈现为光滑对角线。

Loss 平台意味着什么? 如果曲线在数千次迭代中 保持平稳,有两种可能解读:(a) 训练“收
敛” —— Loss 无法 再显著下降,因为模型已经在给定数据和设置下能达到的水平。 这是期
望的;这是“完成”。(b) 训练“卡住” —— Loss 实际 仍可下降,但优化停滞 (局部最小值、学习率
太小、 Densification 关闭)。区分:如果 Loss 值在典型良好范围 (室内/物体 0.020-0.030,户
外 0.040-0.060) 且曲线自 5K 迭代起平稳,则已收敛。如果值明显高于类似场景 (例如 0.08),
则卡住了。
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注意 Gaussian 平台 ≠ Loss 平台。 Gaussian 数量 的平台 不 意味着“训练完成”。它仅意味
着 Densification 已停止添加新点 —— 要么因为达到了 (Classic), 要么因为 MCMC Cap 已满。
训练之后继续运行,仅细化现有点。 真正的“完成”信号您从 Loss 曲线和 Iteration 显示 (I30) 
读取,而不是这里。

中止的经验法则: 如果 Loss 曲线在 5000+ 迭代后 仍在 0.08 以上且几乎不再下降,SfM 重建
很可能出错。 中止训练,在第 9 章查看所选 SfM 后端是否适合场景, 必要时切换到 COLMAP/
Native,然后重新启动。宁可花 10 分钟 做更好的 SfM,也不要用差的相机对齐进行 2 小时训练。

何时使用检查器?

快速参考:哪个部分 + 哪个控件用于什么典型用例?
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常见任务 部分 控件 ID

给完成的 Splat 颜色去饱和 Look L1 (Saturation)

把针状/彩屑 Splat 变圆 Look L2 (Splat length)

填补有洞的点云 / 放大 Splat Look L3 (Splat size)

淡出轨道拍摄中远处的“Far 彩屑” Look L4 (Fade far region)

丢弃 Look 调整 Look L5 (Reset finishing)

加载预设 Presets I7 (单击行)

保存自己的设置 Presets I1 → I2 → I4

与同事共享设置 Presets I5 (导出) 或 I6 (导入)

切换 SfM 后端 (例如因 Apple-
PG 不 稳定)

训练配置 I12 (见第 9 章)

处理无 EXIF 焦距的视频 帧 训练配置 I13 (FOV Override)

COLMAP 性能:GLOMAP 而非 经
典

训练配置 I14

从 Classic 切换到 MCMC 训练配置 I15

让训练运行更长 训练配置 I18 (Max Iter) + I20 (Densify 
Until) — 通过 I19 耦合

GPU 时间减半 训练配置 I22 (Render Scale 设为 50%)

训练质量 +6% (MCMC) 训练配置 I16 (MCMC Quality)

带许多 SfM 点的户外 场景 训练配置 I17 (Auto-scale by scene)

设置 / 切换 COLMAP 路径 训练配置 I23 / I24 / I25

让导出文件更小 Enhancements I26 (始终 保持开)

视口锐化无需额外训练时间 Enhancements I27 (Viewport Scaling → 
MetalFX)

MetalFX 过度平滑 → 替代方案 Enhancements I27 (Viewport Scaling → 
Lanczos)

精细结构的最后一点细节 Enhancements I29 (Perceptual Loss 0.05-0.1)

监控训练 Metrics I30 (进度)、I36 (速度)、 I38 (剩
余时间)

早期评估质量 Metrics I31 (5K 后 Loss < 0.05 = 好)

疑似 SfM 问题 Metrics + Loss 图 I31 + I39 (5K 后 Loss > 0.08 → 
重做 SfM)

区分收敛与卡住 损失图 I39 + I40 (读取 Loss 平台)

识别 Densification 问题 损失图 I41 (Gaussian 曲线下降 → bug)
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章

第 3 章 — 设置

设置窗口可通过 RadianceKit → Einstellungen… 或标准快捷键 ⌘,  打开。它包含两个标签

页:General 和 AI Helpers。 与第 2 章中的检查器值不同,此窗口中的设置作用于 整个

应用 (跨所有项目) —— 它们会被持久化并在应用重启后保留。General 标签页将三个内
容板块分组:Interface、Viewport、Training。 (以前位于此处的三个户外漂浮物开关 —— Sky 
Masking、Mid-Training Floater Cleanup、Reconstruct Sky Dome —— 自 v1.6 起已移至专
家 检查器的 Enhancements 部分,现在按项目存储;见第 2 章 I42–I44。) AI-Helpers 标签页开
启用于 SfM 和训练预处理的设备端机器学习辅助 (Vision、CoreML)。

早期版本中用于集中启用或禁用所有 AI Helpers 的控件在当前版本 中已不再存在 —— 相应地
这里也不再记录。早期的“Coming Soon” 区域 (针对尚未交付的辅助功能) 也已移除,不在此引
用。
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General 标签页

图 15  设置 → General 标签页,包含界面、视口、训练和实验性板块
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S1 Default Mode

位置

设置 → General → Interface → Default Mode 选择器。 
绑定:。默认: .simple 。

技术细节

控制应用下次启动时以两种 UI 模式中的 哪一种打
开。“Simple Mode”是分四步的引导式向导流程 (导
入 → 处理 → 预览 → 导出,记录于第 10 章 Z1–Z4), 
“Expert Mode”则是第 2 章描述的带导航器、3D 视口
和专家检查器 的经典三面板布局。该值在重启后保留。
与菜单 Mode → Simple Mode (⌘1) / Mode → Expert 
Mode (⌘2) 作用相同,只不过菜单切换的是 当前会话,而
此选择器为未来会话设置默认值。两种模式访问相同

的 项目状态 —— 切换模式时项目、相机和训练配置保持
不变。模式特定 的工具栏按钮会立即重新渲染。

简单地说

在这里您选择 RadianceKit 下次启
动时 以哪种界面运行。“Simple 
Mode”是新手模式:四个清晰步
骤, 预设选项,几乎没有可调项。
“Expert Mode”是带所有第 2 章中 
看到的旋钮的完整工具箱布局。您

可以随时通过“Mode”菜单来回 切
换,而不会丢失图像或训练进度。

S2 Language

位置

设置 → General → Interface → Language 选择器。绑
定:。默认: .system  (跟随 macOS 语言)。

技术细节

选择整个应用 UI 的显示语言, 独立于 macOS 系统语言。
RadianceKit 本地化为 17 种语言 ( de 、 en 、 pl 、

en-AU 、 ar-SA  以及 12 种其他)。 选择“System”时
应用跟随 macOS 语言。明确选择时该语言设置 在重启
后保留;完整效果通常需要重启应用,因为本地化 bundle 
仅在启动时加载。项目中 298 个已记录的本地化键全部
纳入,包含 所有子视图和帮助提示中的文本。

简单地说

如果您的 Mac 以英文运行,但您更
愿意使用 德文的 RadianceKit 界面 
(或相反),请在这里设置。多数文本
会 立即切换。某些对话框在重启应
用后才会显示新语言。
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S3 Viewport Background

位置

设置 → General → Viewport → Background 选择器。
绑定:。默认: .darkGray  (RGB 0.1, 0.1, 0.1)。

技术细节

设置 3D 视口的默认背景颜色。三种选项: “Dark 
Gray” (RGB 0.1, 0.1, 0.1 —— 默认)、“Black” (0, 0, 0) 
和 “White” (1, 1, 1)。该设置在重启后保留新项目和新会
话的默认值, 同时立即更新正在运行的 Metal 渲染器。
与菜单 Viewport → Background (M21、M22、M23) 
中相同的选项,但设置选择器设定默认值,而菜单 切换当
前显示。对截图和演示视频很重要:白色背景会更突出绿
色/蓝色 漂浮物,深色背景更适合干净的渲染效果。

简单地说

预览窗口中 3D 模型背后的颜色。
深灰是标准, 适合多数场景。白色
适合截图,黑色在渲染效果上更显高
级。您可以 随时通过“Viewport → 
Background”菜单为当前场景切换
颜色 —— 此设置仅决定下次打开
时再次使用哪种颜色。

S4 Auto-Rotate After Training

位置

设置 → General → Viewport → 开关“Auto-Rotate 
After Training”。绑定:。默认: false 。

技术细节

训练结束后立即开始视口相机围绕场景重心的 连续转台
旋转 (标准旋转速率 ~0.3 rad/s)。在演示会话、A/B 对
比 中,以及直接从 360° 视角判断场景边缘是否出现“漂
浮物”时很实用。 视觉效果与菜单 Viewport → Toggle 
Auto-Rotation (M16、⌘⌥T) 相同,只不过这个开关让
此行为在训练结束后自动触发而非手动触发。 之后随时
可通过菜单或点击视口 (会暂停旋转) 中断。对训练性能 
没有影响 —— 旋转只在训练完成后才运行。

简单地说

启用时,训练一完成,3D 场景就会自
动旋转 —— 像旋转木马一样。当
您让训练通宵跑,早上看到结果已经
在动而无需 自己点击时,会感觉很
棒。在长时间监控训练的会话中,最
好保持关闭。
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S5 Live Preview Interval

位置

设置 → General → Training → 
Live Preview 选择器。 绑
定:AppState.trainingConfig.livePreviewInterval。
默认: 0  (Off)。

技术细节

决定运行中的训练快照以多少迭代间隔渲染 到 3D 视
口中。四个离散值:0 (“Off”)、50、250、1000 次迭
代。 启用 Live Preview 时,训练器将 Gaussian 缓冲区
从 GPU 复制到一个 单独的渲染缓冲区,并触发视口重
绘。“Off”时视口仅在训练完成后才 更新。性能开销:
每 50 次迭代在 M3 Ultra 上慢约 5–10%,每 250 次迭代
慢 ~1–2%,每 1000 次迭代不可测量。Snapshot 缓冲区
的内存 开销恒定 ~2 GB,与间隔无关。该值用作新训练
的默认值;训练开始 后,训练检查器显示该训练的实时值。
间隔 50 时的视觉印象是点云 流畅“生长”,间隔 1000 时
显得卡顿。

简单地说

训练进行时,您可以选择 3D 视
图的更新 频率。“Off”表示训练
期间不更新 (最快)。“Every 50 
Iterations” 近乎实时地显示您的场
景如何形成 (稍慢)。对于小型训练
的悠闲观察, “Every 250”是一个不
错的折中。

S6 Throttle Delay

位置

设置 → General → Training → Throttle 选择器。绑
定: AppState.trainingConfig.throttleDelayMs。默
认: 0  (Off)。

技术细节

在训练迭代之间人为插入毫秒级的延迟。 四个离散值:0 
(“Off”)、2 (“Light”)、5 (“Moderate”)、10 (“Eco”)。 
意义:在较长的训练中 (数小时),GPU 否则会被 100% 占
用,导致 系统 UI 明显变慢 (鼠标卡顿,其他应用变
慢)。Throttle 延迟给 GPU 让出空隙,让其他任务可以执
行。性能开销很大:在 5 ms 节流下, 典型的 40K 训练比
无节流时长 50–80%。在性能模式“Eco” (10 ms) 下,每
次迭代的延迟比迭代本身还长 —— 慢 2–3 倍。启用节
流时, 选择器下方出现提示:“Throttle is on. Training will 
be slower than usual.”。应用本身不会有明显改善 —— 
受益的只有其他应用。

简单地说

如果您的 Mac 在长时间训练中变得
太热, 或其他程序变得迟钝,可以在
这里启用一个刹车。“Off”让 GPU 
全速 运行 (最快)。“Light”在每个
步骤之间做一个小停顿 (稍慢,但系
统 更顺滑)。“Eco”是最强的刹车 
—— 适合 MacBook 上不希望过热
的 夜间训练。
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AI-Helpers 标签页

图 16  设置 → AI Helpers 标签页,带主开关和子开关
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S11 AI Helpers enabled (Master)

位置

设置 → AI Helpers → 第一节 → 开关“AI Helpers 
enabled”。绑定:。默认: true 。

技术细节

流水线中所有 AI Helpers 功能的主开关。 关闭时,导入
和 SfM 流水线完全跳过所有基于 ML 的预处理阶段 —— 
没有 Apple Vision 调用,没有 CoreML 模型加载,不会唤
醒 NPU。 启用时,会咨询各个子开关 (S12–S13)。该值
在重启后保留。 影响以下阶段:(a) SfM 之前的帧质量预
检 (S12),(b) 回环检测 (S13)。重要:关闭时,两个子开关
被禁用并在视觉上灰显。底部提示强调,所有 AI Helpers 
严格在设备端运行 —— 不上传图像,不进行云处理。 隐
私保证来自于仅使用 Apple Vision Framework (本地运
行在 Neural Engine 上) 和直接位于应用 bundle 中的 
CoreML 模型。

简单地说

所有内部使用 KI/机器学习的功能
的总开关。 默认是“开”,因为这些
辅助功能能节省大量时间,而您的图
像不会 离开 Mac。如果您想完全关
闭它们 (例如为了节电或因为您的 
Mac 没有 NPU),请在此关闭 —— 然
后下面的两个子选项会自动灰显, 
不再起作用。

S12 Frame quality check

位置

设置 → AI Helpers → Available 部分 → 开关“Frame 
quality check”。绑定:。默认: true 。

技术细节

启用帧质量筛选器 (阶段 3.11), 在 SfM 调用前分析每个
导入的帧。每帧的流水线步骤: (a) Apple Vision 的拉普
拉斯方差滤波器 (模糊检测 —— 阈值 ~150), (b) 基于直
方图的过曝/欠曝检查 (阈值:>5% 像素为 0 或 255), (c) 
空白帧检测 (所有像素的标准差 < 5)。通过所有三项检
查的帧 直接通过。未通过至少一项检查的帧会触发一个
模态确认对话框, 对话框列出每个有问题的帧及其缩略图
和原因,并询问是否移除。 重要:不会自动删除 —— 始
终需要对话框,最终决定权在用户。 性能:在 M3 Ultra 上
每帧 ~50 ms,并行运行。关闭时所有帧 未经检查传递给 
SfM。主开关 (S11) 关闭时该开关在视觉上灰显 且无效。
根据 Memory,已交付状态:SHIPPED 2026-05-23。

简单地说

实际训练之前,应用会查看每张照
片: 是否抖糊?完全暗或完全白?空
白?如果是,会询问您是否要剔除该 
图像 —— 永远不会自动删除任何
东西。这能在以后节省许多小时, 
因为一张完全抖糊的图像有时能毁

掉整个训练。默认是“开”,因为 开
销几乎为零,而收益很大。
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S13 Loop closure detection

位置

设置 → AI Helpers → Available 部分 → 开关“Loop 
closure detection”。绑定:。默认: true 。

技术细节

启用基于 Apple Vision Feature Print 的 回环检测。对
每个导入的帧计算一个 ~768 维的特征向量,代表图像 内
容的神经嵌入。然后通过余弦相似度对所有 Feature 
Print 进行 两两比较。相似度 > 0.85 且帧索引距
离 > 50 (即非相邻帧) 的 对被识别为“回环候选”,并写
入项目文件夹中的一个 Sidecar JSONL 文件。仅信息性 
—— 不修改导入的图像序列。意义:向 SfM 求解器 (尤其
是 COLMAP) 提示这些帧在 3D 空间中应该聚类在一起。
对于 原生 SfM,Sidecar 信息目前仅作为文档;COLMAP 
通过自定义 matches 文件在内部使用这些提示 (可手动
集成,未自动关联)。性能:在 M3 Ultra 上每帧 ~200 ms,
并行运行。关闭时不生成 Feature Print。 主开关 (S11) 
关闭时视觉上灰显。

简单地说

如果您围绕物体拍摄并最终回到起

点, 让计算机知道这一点会大有帮
助。此选项自动识别哪些照片是

从 “几乎相同位置”拍摄的,并将该
信息写入一个小辅助文件。 SfM 工
具 (尤其是 COLMAP) 可以利用此信
息生成更干净的 3D 重建。 默认是
“开”,因为它在后台运行,且不修改
您的图像。

检查器镜像设置

来自清单表中其余的设置条目 (S17–S33) 是来自专家检查器的镜像, 记录在第 2 章 (检查器控
件 I12–I29) 中。它们不会物理地出现在 设置窗口中,而仅在清单中被列出,因为它们通过持久化
的 TrainingConfig  属性运行,因此在形式上具有设置性质。具体内容 说明见对应章节。
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何时使用什么?

设置 作用范围 持久性

S1 Default Mode 应用全局 应用重启

S2 Language 应用全局 应用重启

S3 Viewport 
Background

应用全局 (默认) + 运行时 应用重启

S4 Auto-Rotate 
After Training

应用全局 应用重启

S5 Live Preview 
Interval

新训练的默认值 应用重启

S6 Throttle Delay 新训练的默认值 应用重启

S11 AI Helpers 
Master

应用全局 应用重启

S12 Frame quality 
check

应用全局 应用重启

S13 Loop closure 
detection

应用全局 应用重启

应用全局 = 对所有项目生效。新训练的默认值 = 仅影响下一个创建 的训练,正在进行的会话保
持不变。当前训练 = 立即作用于运行中的 训练配置,但若不显式重新导入则不会持久化。
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章

第 4 章 — 辅助窗口

除主窗口 (3D 视口加检查器) 外,RadianceKit 还管理七个其他窗口, 全部通过 Help 菜单打开。
从上到下:User Guide (⌘?)、Keyboard Shortcuts (⌘/)、Open Training Logs… (不打开应用
窗口,而是 Finder; 因此此处不再赘述)、Manage Storage…、Pareto Dashboard… (⇧⌘D)、 
Holdout Analysis… (⇧⌘H)、BayesOpt Console… (⇧⌘B)。其中三个 —— Dashboard、
Holdout、BayesOpt —— 是独立的分析工具。它们各有 自己的 View Model 栈,在磁盘上
读写 JSON 文件,并且每个都有一个 CLI 参数,可在应用启动时让该窗口立即指向特定文件 
( --dashboard-dir 、 --holdout-file 、 --bayesopt-autorun )。

四个简单窗口 (User Guide、Keyboard Shortcuts、Manage Storage, 以及子菜单项 Open 
Training Logs / Open Exports Folder) 每个控件 得到一个简短条目。三个分析窗口记录得更
详细 —— 每个都有一个 引言,解释您在窗口中看到什么、何时应打开它,以及如何解读所示 
图像。

本章末尾有一个指向主窗口检查器的交叉引用部分:训练运行时您 能从实时 Loss 图和 
Gaussian Count 显示中合理读到什么。

User Guide (W1–W4)

图 17  User Guide 窗口,左侧侧栏,右侧渲染的 Markdown 内容
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这是什么: 一个内置帮助窗口,渲染应用附带的 guide_<语言>.md 。语言从设置 (General → 
Language) 派生, 或当选择“System”时从 macOS 语言偏好派生。布局经典:左侧 含所有标题
的侧栏,右侧正文。

何时打开  当您需要对某一点的快速提醒时 —— 即作为 关键词替代。详细参考是本手册;内置帮
助窗口更像是命令行上的 --help 。每个应用版本随之更新,但内容上保持较表层。

W1 NavigationSplitView (侧栏 + 详情)

位置

Help → User Guide (⌘?)。

技术细节

两列布局,带窄侧栏 (至少 180 pt 宽) 用于内容树,以及带
可滚动详情区的实际 Markdown 内容区。窗口最小尺寸 
700 × 500 pt。首次打开时,窗口从应用 bundle 加载相
应的 guide_<lang>.md  (回退 guide_en.md ), 将其解
析为 Block 记录 (标题 H1–H4、段落、列表、表格、分
隔线), 并单独提取标题结构用于侧栏。内联格式 (粗体、
斜体、Code Span) 通过内置 Markdown 引擎渲染。语
言从应用设置读取,中文 ( zh-Hans ) 和巴西葡萄牙语 
( pt-BR ) 作为特殊情况以完整 locale 标签保留, 因为这
些变体与 zh 或 pt 不同。

简单地说

内置帮助文本,左侧主题列表, 右侧
内容。语言自动根据您的系统设置

调整。离线工作,但故意 只是简短
版本 —— 完整参考是本手册。

W2 List (标题侧栏)

位置

User Guide 窗口的左栏。

技术细节

当前 Markdown 文档中所有 H2 和 H3 标题的列表。
H2 条目无缩进,中等字重显示;H3 条目 带 16 pt 左缩进
和减弱前景样式。H4 及更深的级别被忽略, 否则深度
会让侧栏失去概览。锚 ID 从标题文本通过 slug 化生
成 (小写 + 空格转破折号 + 过滤为字母/数字/破折号 —— 
与 GitHub 用于 Markdown 锚的算法相同,因此外部文档 
URL 可能落在相同 的锚上)。列表使用原生 macOS 样
式。

简单地说

左侧的导航栏。点击条目跳到 章
节。
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W3 Button (标题 → 锚跳转)

位置

每个侧栏行一个按钮。

技术细节

每个侧栏条目是一个按钮, 设置当前锚,但外观上像列
表条目。一个观察者变量随后触发到 相应锚的滚动跳转,
带 0.3 秒的柔和动画。跳转后锚值被重置, 以便下次单击
相同锚时再次触发 (否则观察者不会重新触发, 因为值未
改变)。

简单地说

单击带您到右侧文本的相应位置。

W4 ScrollView (详情内容)

位置

右栏。

技术细节

可滚动、垂直堆叠的内容 区域,带 Lazy Rendering,因为
较长的 Guide 容易超过 200 个 Markdown Block —— 
非 lazy 变体会同时实例化所有。每个 block 获得自己的 
ID,要么是标题锚 (对可跳转的 H1–H3),要么是 索引占位
符。最大宽度 720 pt,Padding 32 水平 / 24 垂直, 使长
行保持良好可读布局。表格按单元格用水平堆栈和分隔

线渲染; 内联代码通过内置 Markdown 引擎。真正的代
码块当前作为段落 处理 —— 帮助窗口的已知限制。

简单地说

实际的帮助文本。可滚动, 良好可
读宽度,清晰排版。
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Keyboard Shortcuts (W5–W6)

图 18  Keyboard Shortcuts 窗口 — 五组 Navigation/Views/Capture/Editor/Training,左侧热键
列,右侧描述

图中所示  五个部分的静态参考列表。 Navigation: Mouse Drag (Orbit/Fly)、Shift+Drag/
Right-Drag (Pan)、Scroll (Zoom)、WASD (Fly-Through 移动)、Q/E (Up/Down)、 F 
(Toggle Orbit/Fly)、双击 (Re-center)、Cmd+Scroll (FoV 调整)。 Views: R (重置相机)、T 
(自动旋转)、P (相机回放)、B (背景循环)、0–9 (跳到训练相机 1=10%/5=50%/0=最后)、左/
右 箭头 (上一个/下一个相机)。Capture: S (截图到桌面)、 V (Turntable 视频)、C (复制相机
信息)。Editor: Tab (编辑模式)、Click/Drag (Paint-Select)、Option+Click (取消选择)、 X / 
Delete (删除选择)、Cmd-Z (撤销上次删除)、[ / ] (画笔 更小/更大)、Esc (取消选择)。
Training: Start、 Pause/Resume、Cancel、Continue +5K/+10K/+20K 通过 M9–M14 的菜
单快捷键。

这是什么: 一个所有快捷键的简单静态概览 —— Navigation、Views、Capture、Editor、
Training。内容硬编码, 无 Markdown 加载。
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何时打开  当您寻找在视口中做某事的最快方式时。 WASD Fly-Through、R 重置相机、B 循环
背景 —— 全都在这里。

W5 ScrollView (内容区)

位置

Help → Keyboard Shortcuts (⌘/)。

技术细节

一个内有垂直列表的简单 滚动区。Padding 20 周
围,无侧栏导航树 (列表足够短)。内容 分为五个部
分 (Navigation、Views、Capture、Editor、Training)。 
每组按键一行,两列均为可翻译文本。左列 (按键代码) 固
定为 180 pt 宽度,使右侧描述保持垂直对齐。除滚动外
无交互 —— 单击行不触发任何操作,快捷键是菜单和视口
上的真正键盘修饰。

简单地说

所有快捷键的表格。静态 速查表,
便于快速查阅。

W6 VStack (快捷键部分)

位置

ScrollView 内部。

技术细节

左对齐堆叠的部分, 16 pt 间距。五个部分内分别为标题 
+ 行序列。标题使用次要 Subheadline 样式 —— 故意不
用 Title 格式,因为部分不必可导航。 内容故意扁平 (无 
Disclosure、无搜索、无过滤),使组件在每个 macOS 版
本上一致工作,并保持文件可读。

简单地说

按功能 (Navigation、Views、 Editor 
等) 对按键的分组。
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Manage Storage (W7–W12)

图 19  Manage Storage 窗口 — 标题显示 693 items · 16.74 GB total,按日期排序的 PLY 导出文
件表格,每行 Format-Pill + 文件名 + 大小 + 日期

图中所示  RadianceKit 管理的 所有文件的表格视图。标题统计 693 个项目,16.74 GB 总
大小。 顶部工具栏:“Show in Finder” + “Refresh”。每行:PLY 图标、 文件名 (例如 training_​
20260527T211321Z.ply)、导出日期、 大小 (从 7 KB 到 218 MB 不等)、放大镜图标 (Reveal) 
和回收站 图标 (Move to Trash)。文件按日期排序,最新在上。在此演示 截图中,PLY 导出占主
导,因为大量使用了 --benchmark 。

这是什么: 对 RadianceKit 在 ~/​Documents/​RadianceKit/​ 下存储的一切的磁盘使用概览 —— 
Logs、Exports、Scenes、Capture Bundles (来自 iOS 伴侣)、Imports (输入图像的暂存副
本)。每个 条目一个字节大小和两个按钮:“在 Finder 中显示”和“移到 回收站”。不是自动清理 
—— 应用本身什么都不删;您按条目 决定。

何时打开  磁盘满时。尤其是 Logs 会积累 (每次训练尝试 一个 JSONL,加上 _​
qualityMetrics.json);Exports 自然也是 (PLY 100% 原始数据,每次导出一个)。崩溃后也有
用,如果 Imports 暂存目录中还有输入图像的旧副本 (参见 dev_​v549f-needle-reduction.md 
中的“Disk-pressure incident”)。
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W7 按钮“Show in Finder”

位置

Storage 浏览器窗口右上角的标题。

技术细节

在 Finder 中打开整个 RadianceKit 目录 (~/​Documents/​
RadianceKit/​),使您能直接 看到文件夹结构,并可用 
Finder 本身操作。该操作打开一个新 Finder 窗口,不切
换到应用沙盒容器 —— ~/​Documents/​RadianceKit/​ 是
应用正常可访问的 Documents 域,不是沙盒容器路径。

简单地说

在 Finder 中打开目录, 以便您自己
操作文件。

W8 按钮“Refresh”

位置

标题,Finder 按钮旁。

技术细节

触发一个在用户启动的 异步任务上运行的后台扫描,
以使大型目录树扫描不阻塞 UI。 实际遍历访问每个
已知子文件夹 (Logs、Exports、Scenes、 Captures、
Imports),并为每个直接子项生成一个 Storage 条目。 
每个条目确定递归大小 —— 优选实际磁盘使用 (包括 
APFS 硬链接共享),回退到逻辑文件大小。

简单地说

重新读取列表,以防您 期间在 
Finder 中删除或添加了东西。

W9 List (Storage 条目)

位置

标题下方的主内容。

技术细节

每行此布局的列表: 类别特定的 SF Symbol 图标 (Logs 
文档、Exports 上传箭头、 Scenes 立方体、Imports 
托盘)、名称 + 副标题 (Kind 标签 + 格式化修改日
期)、右侧字节计数器 (右对齐,monospaced)、 Reveal 
按钮 (放大镜符号)、Trash 按钮 (回收站)。排序:首要 按 
Kind (Scenes 首先,然后 Exports、Logs、Captures、
Imports、 Other),次要按修改日期降序 (最新在上)。如
果扫描仍在运行, 位置改为显示“Scanning…”进度。如果
未找到内容,显示带 托盘图标的空状态显示。

简单地说

按类型和时效性排序的 所有 
RadianceKit 数据列表。每个条目
您看到大小并可直接删除。
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W10 行按钮“Reveal in Finder”

位置

每行,右侧放大镜符号。

技术细节

打开 Finder 并选中特定 项 (文件或文件夹)。与 W7 不
同:W7 打开根目录;W10 精确标记 这一个条目。实际工
作流:识别一个大条目,单击放大镜,然后 例如将其复制到
外部卷。

简单地说

在 Finder 中直接跳到 此条目,以便
您快速找到它。

W11 行按钮“Move to Trash”

位置

每行,放大镜旁的回收站符号。

技术细节

触发确认对话框 (W12)。 仅在确认后,标准 macOS 操
作“移到回收站”运行 (即可逆, 非直接删除)。Trash 成功
后,条目从列表中移除,总字节计数 更新。出错时显示模
态错误对话框。

简单地说

将条目移到回收站。 对话框事先询
问。

W12 ConfirmationDialog (删除确认)

位置

由 W11 触发,呈现为 macOS 表单。

技术细节

标准确认对话框,带动态 标题“Delete <name>?”和一行
消息,明确指出条目落入回收站 并可从那里恢复 (直到回
收站被清空)。两个按钮:“Move to Trash”作为破坏性操
作 (红色显示),以及自动 Esc 绑定的 “Cancel”。该对话
框在某种意义上是非模态的,仅阻塞此窗口, 不阻塞整个
应用 —— 这是 macOS 对可逆删除的标准。

简单地说

删除前的安全询问。 “Move to 
Trash”是可逆的 —— 只要回收站
未清空。
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Pareto Dashboard (W13–W22)

图 20  Pareto Dashboard — 报告导入前的空状态

空状态 (首次打开后) —— 带“Open Reports Folder…”行动召唤 的空状态。一旦加载了训练报
告,数据点出现,见下张截图。

图 21  Pareto Dashboard 加载 129 个基准报告 — Gaussians 对 PSNR 带 Pareto Front、
Scene/Strategy/Mip 过滤器

图中所示  标题工具栏显示“129 reports of 129” (选定文件夹中所有报告成功解析 —— 21 个额
外文件因较旧 格式无法解析,见右侧提示列表)。坐标轴:X 轴选择器为 Gaussians ,Y 轴选择器
为 PSNR (dB) 。散点图:绿色点 = Classic 策略,蓝色点 = MCMC。虚线 Pareto Front 沿最佳
达到 的 PSNR 值延伸,从约 500K Gaussians 起在 PSNR≈30 dB 形成 平台。右侧过滤芯片:7 
个场景 (bicycle、bonsai、family、 flowers、kitchen、stump、truck),2 种策略 (classic、
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mcmc), 3 个 Mip Splatting 选项 (All、On、Off)。当前所有过滤器 都打开,因此点的密集
集群。

这是什么: 一个多运行比较工具。您过去训练了多个 场景或同一场景使用不同预设 —— 每次训
练运行 (如果您带了 --benchmark  或通过 Benchmark 功能调用) 都产生一个 JSON 报告文
件,其中包含最终 PSNR、SSIM、LPIPS、Gaussian Count 和挂钟时间等。该 Dashboard 一
次读取这样一个整个文件夹, 并将它们作为 2D 散点图绘制,坐标轴可选。此外,Pareto Front 
(非支配点的集合) 以虚线绘制。

何时打开  在您创建了至少三或四个训练报告之后。 点更少时,前沿线无意义。典型用例:您
试图重建一个户外场景, 依次跑了 P3 Balanced (Classic)、P4 Quality (Classic)、P7 MCMC 
Quality 和 P9 Outdoor (tuned) —— 现在您要知道哪种配置在 每秒训练时间内提供最佳 
PSNR,或哪个需要最少 Gaussians 达到 给定 PSNR。

如何解读  两个轴都可自由选择 (X 轴:、、 psnr 、 ssim 、 lpips  等;Y 轴同样)。
ParetoFront2D.indices 中的 Pareto Front 逻辑知道每个指标是“越小越好” (例如 LPIPS、 
Loss、Time) 还是“越大越好” (PSNR、SSIM) —— 因此线视轴 选择从左下到右上或从左上到

右下,始终沿最佳达到的组合。 一个点是 Pareto 最优的,当且仅当 没有 其他点在 两个维度都至
少同样好 (即没有其他支配它)。Pareto 最优点 位于线上,其他点在右/上 (视轴方向)。线上的点
是“最佳预设” 的真正候选;远离线的点是浪费的训练时间。

过滤芯片  您可以将选择限制到特定场景 (例如当您 只想比较户外运行时)、特定策略 (Classic 
或 MCMC),或 Mip-Splatting 开/关 (在 Q1.5 阶段后相关,其中 Mip 保留为 opt-in 高级标志)。

示例工作流  您有“truck”场景的三个报告在 ~/​Documents/​RadianceKit/​Reports/​:Run A (P4 
Quality、40K iter、524K Gs、105 s、PSNR 23.4)、Run B (P7 MCMC、200K iter、 150K 
Gs、693 s、PSNR 24.6)、Run C (P9 Outdoor、100K iter、 1.25M Gs、312 s、PSNR 
25.8)。设 X 轴为 trainingTime,Y 轴 为 PSNR。Run B 在右上,Run C 在更右上,Run A 在左
下。 Pareto Front 连接 A 和 C —— 都非支配。Run B “丢失” (C 在 Time 和 PSNR 上都更
好)。洞察:对“truck”,MCMC 默认不 值得;要么快+还行 (A) 要么长+非常好 (C)。将 C 的配置存
为 自己的预设 (检查器 → I1 Save Preset)。

下一步行动: 将最佳配置保存为预设。具体:查看 Pareto 点 (Hover 显示 PSNR/SSIM/LPIPS/
Gs/Time 工具提示), 决定哪个在 Time vs Quality 折衷上最适合您,打开相应的 报告 (文件名含
运行时间戳),将其训练配置在新运行中复制, 或在下次训练会话后通过检查器保存为预设。
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W13 按钮“Open Reports Folder…”

位置

左上角工具栏。

技术细节

打开一个文件夹选择 对话框,提示“Select a folder 
containing benchmark .json reports”。确认后,后台任
务顺序解析文件夹中所有 .json  文件。错误报告 (损坏
的 JSON、错误的 schema) 被收集并在 侧栏底部显示
为“N file failed to parse” —— 不崩溃。如果在 第一次
加载仍在运行时进行第二次单击,前一个任务被取消, 以
使不会有两个结果同时写入状态。

也通过 CLI:--dashboard-dir /​路径/​到/​reports 在应
用启动 时立即加载文件夹。

简单地说

选择您的基准报告所在 文件
夹。默认路径为 ~/​Documents/​
RadianceKit/​Reports/​。 然后
一次加载所有 JSON。

W14 选择器“X-Axis”

位置

图表上方,左侧。

技术细节

带 Dashboard 模块所有 可用指标轴 (PSNR、SSIM、
LPIPS、Gaussian Count、训练时间 等) 的菜单选择器。
默认是 Gaussian Count。切换时已悬停的 点被重置,因
为旧轴坐标系中之前突出显示的位置在轴切换后 无意
义。选择器限于内容宽度,以使其不横跨整个宽度。

简单地说

水平轴上应显示哪个 指标。通常是
“训练时间”或“Gaussian 数”,因为
这是您要 比较的“成本”。

W15 选择器“Y-Axis”

位置

图表上方,X-Axis 旁。

技术细节

与 W14 相同,只是默认 是 PSNR。轴选择独立保存,因此
用户也可选择无意义组合 (X=PSNR、Y=PSNR —— 会
将所有点投到对角线上)。但此类组合 不被捕获;有意决
策,因为“SSIM vs PSNR”比较确实有趣, 用于看指标行为
有多一致。

简单地说

垂直轴上是什么。 通常是作为质量
度量的“PSNR”或“SSIM”。
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W16 开关“Show Pareto Front”

位置

轴选择器旁右侧。

技术细节

标准 macOS 开关。 活动时,Pareto 图表中除点云外还
绘制一条带计算出的 2D Pareto Front 的线。样式:虚线 
(4-4 模式)、灰色半透明、 线宽 1.5 pt。Pareto 计算在
主线程上运行 —— 对典型的报告 数量 (≤ ~50) 无问题
快速。开关关闭时,线被省略,只剩 纯点。

简单地说

显示穿过“迄今最佳” 点的线。如果
线挡道 (例如因为您只想比较单个 
Trade), 关掉它。

W17 Chips “Scene” 过滤器

位置

Dashboard 窗口右侧栏。

技术细节

加载报告中出现的每个 场景的过滤芯片。自有 Flow 布
局,一旦宽度耗尽自动将芯片 打包到多行。活动芯片获得 
Accent 背景,不活动的获得中性 标准 Material 背景。可
多选 (Set 语义);如果没有芯片选中, 所有场景都视为“通
过” —— 即 Set 逻辑是“空选 = 一切”, 不是“空选 = 无”。

简单地说

单击场景名称将点过滤为 仅此场
景。可多选。空 = 所有场景。

W18 Chips “Strategy” 过滤器

位置

侧栏中 Scene Filter 下方。

技术细节

与 W17 一样,但用于 训练策略 —— 通常是两个值
“classic”和“mcmc”,从基准报告 JSON 的 Strategy 字
段派生。当您混合了两种策略的报告并只想 看一种
时有帮助 (例如“只显示 MCMC 运行,因为我已经排除 
Classic”)。

简单地说

按 Classic 或 MCMC 过滤。 默认两
者都活动。
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W19 Chips “Mip-Splatting” 过滤器

位置

侧栏中 Strategy Filter 下方。

技术细节

三值过滤器 (而非 W17/W18 那样的 Set):“All” / “On” / 
“Off”。背景:Mip-Splatting 在阶段 Q1.5 中被评估为实
验性多尺度改进,最终裁定是“全程 无明显胜利;保留
为 opt-in 标志”。当您做 Mip 开/关比较时, 通常想能非
常清晰地分离。因此专用的三元过滤器,带状态 “全部通
过”、“仅 Mip 开”、“仅 Mip 关”。侧栏部分仅在 数据集
中至少有一个 Mip 报告 和 一个非 Mip 报告时显示 (否
则过滤无意义)。

简单地说

当您要比较 Mip-Splatting 开/关时,
这里是三段过滤器。否则忽略。

W20 ChipButton (Filter Toggle,all/on/off)

位置

辅助组件,用于 W17/W18/W19。

技术细节

极简的按钮包装。内容: 带 Caption 字号和 Padding 10 
水平 / 5 垂直的标签文本。 背景条件化:活动时 → 应用 
Accent 颜色带白色文本;否则 中性标准 Material 背景带
黑色文本。形状是 Capsule (药丸状)。 Plain Button 样
式,使 Capsule Material 不被系统边框覆盖。

简单地说

那些圆形过滤按钮本身。 视觉上像 
iOS 标签。

W21 Chart (Pareto Scatter)

位置

Dashboard 中央区域。

技术细节

带两层的 Swift Charts 图表:1. 每个报告一个点 —— 位
置来自选定的 X 和 Y 指标, 颜色按 Strategy,符号按 Mip 
状态。Symbol 大小常规 80, 突出 200 (如果 ID 对应当
前悬停的报告)。2. 仅当开关打开时 绘制 Pareto Front 
线。

Chart Overlay:一个透明矩形注册鼠标移动;每帧确定 
Plot Frame 中欧几里得最近的点位置,如果距离低于 24 
px 则更新 悬停的报告 (否则重置)。这样您无需单击就
获得工具提示 —— 悬停就够。

简单地说

实际的散点图。每个点 是一次训练
运行。Hover 显示详情工具提示。
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W22 Tooltip (Hover 详情)

位置

图表下方,Hover 时显示。

技术细节

水平栈:场景名 (Headline)、 Strategy 标签 (Caption)、
分隔线、然后 PSNR/SSIM/LPIPS/Gs/Time 指标各为一
个小垂直组 (标签 + monospaced 值)。如果 Mip 激活, 
另外一个 Accent 颜色“Mip”Capsule 标签。背景半透明 
Blur, 8 pt 半径圆角矩形。仅在鼠标确实在点上时显示。
离开时自动 消失。

简单地说

当您将鼠标移到点上时 下方的详情
卡片。一次显示所有质量指标和运

行配置。

Holdout Analysis (W23–W29)

图 22  Holdout Analysis — 加载 transforms.json 前的空状态

带空状态和行动召唤“Open transforms.json…”的空状态。接受 NeRF Studio 和 Instant NGP 
格式。

空状态 (首次打开后) —— 一旦加载 transforms.json , 相机标记出现,见下张截图。
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图 23  Holdout Globe 含 100 个 NeRF-Blender-Mic 相机,5 折每折 20 相机,Angular 策略活动

图中所示  标题显示加载的文件 (transforms_​train.json) 和相机数 (“100 cameras”)。左侧 
栏:策略选择器,两个选项 —— Angular (longitudinal) 活动 (按球面上的经度/纬度扇区对折,
使每个测试折几何上密集) 与 Linear (round-robin) (基于顺序,每第 k 帧作为测试集)。 k-
Folds 滑块在 5,Test-Fold 选择器在 Fold 1。Export 按钮 生成用于 Nerfstudio/Instant-NGP 
的 fold-assignment.json。 中间面板:所有 100 个相机的 3D 球面投影 —— 绿色点 = Train, 
红色点 = 当前 Test Fold (Fold 1 含 20 相机)。右侧栏 (Angular Correlation):每折 20 个相机 
+ 平均最近角 (Fold 1: 7.9°、Fold 2:7.8°、Fold 3:7.7°、Fold 4:7.0°、Fold 5: 6.3°) —— 值越
小意味着此折内的相机紧密相邻,即 Holdout 分割空间连贯。

这是什么: 您相机布置的 3D 可视化器,带交叉验证 逻辑。您加载一个 transforms.json  
(Nerfstudio / Instant-NGP 对相机位姿的标准格式),应用读取所有相机,将它们的视线 方向
投影到单位球面上,并在虚拟球体上显示为小球面标记。 然后将相机分成 k  折 (按所选策
略:angular 或 linear), 标记绿色为训练部分,红色为测试部分 (Holdout),并为每折 计算一个 
Angular Correlation 分数,告诉您测试折在视角空间 中距训练折多远。

何时打开  当您要做 Holdout 评估时 —— 即:您的 模型对未见视角的泛化有多好?训练中的标准
是“每第 8 个视图 作为 Holdout” (Mip-NeRF360 约定),但这是非常线性的拆分。 如果您的图
像例如按时间聚类 (先物体一侧,然后另一侧), 则“每第 8”不具代表性 —— 随机序列位置落入测
试集,但其 所有邻居在训练集,这太容易。使用“angular”则在视角空间 上分层:每折包含轨道所
有区域的相机,使测试真正测试泛化 空隙。

如何解读  Angular vs Linear:- Angular (标准): 按经度角 (绕 Y 轴的 φ 坐标) 将相机分成 k  
个相等扇区。 Fold 0 是 φ ∈ [0°, 360/k°) 的相机,Fold 1 是接下来, 依此类推。优点:每折覆
盖轨道的部分扇区;测试折空间紧凑 但在世界数据集上广泛分布。适合经典轨道拍摄。- Linear 
(Round-Robin):Fold-Index = (image_index modulo k)。这 是简单的“每第 k 个”拆分。在图
像顺序没有空间偏差时 (例如随机排序的无人机拍摄) 工作。在图像按时间聚类时 工作不佳。

在 3D 球面中您立即看到:绿色点 (训练) 和红色点 (测试)。 如果红色点都聚集在一角,Holdout 
不好 (不是好的泛化测试)。 如果它们均匀分布在绿色之间,则好。每折的 Angular Correlation 
分数 (右侧栏,以度) 另外告诉:更小值 = 测试 靠近训练 (每个测试相机有一个近邻训练相机,容易
测试); 更大值 = 测试远离训练 (更难泛化)。
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示例工作流  您用 251 张图像拍摄了 Truck 场景, 通过菜单项 M33 (Export SfM 
transforms.json) 导出一个 nerfstudio 文件。打开 Holdout 窗口 (⇧⌘H),通过“Open 
transforms.json…”加载 JSON,查看球面。k=5 (默认) 给您 5 折。单击“Fold 3” —— 看红色标
记是否相对均匀。如果是: “Export fold-assignment.json”,将导出的文件放在 Reports 文件夹
中,下次带 --benchmark  的训练运行 (或相应的检查器 设置) 将使用这个折划分作为 Test-
Holdout —— 替代默认 的“每第 8”。

W23 按钮“Open transforms.json…”

位置

左上角工具栏。

技术细节

打开一个限于 JSON 文件的文件选择对话框。确认
后,Holdout 模块加载文件。 加载器解析 nerfstudio 格
式 (相机内参加上带图像路径和 Transform 矩阵的
帧列表) 和 instant-ngp 格式 (相同结构)。 每帧从 
Transform 矩阵提取视线方向 (相机本地基的 z 轴) 并保
存。如果解析失败,在状态区显示错误消息。

也通过 CLI:--holdout-file /​路径/​到/​
transforms.json 直接启动窗口并加载文件。

简单地说

加载您的相机位姿 JSON。 标
准是 Nerfstudio 和 Instant-NGP 
导出。RadianceKit 本身 可通
过菜单 → Export → SfM 导出 
transforms.json。

W24 选择器“Strategy” (angular/linear)

位置

左侧栏,上方。

技术细节

带两个选项的 Radio 选择器:Angular 和 Linear。策略切
换自动触发折的重新计算。 视线方向是球面上 3D 单
位向量的列表;Angular 策略投影到 经度角 φ 并排
序,Linear 策略简单按帧索引做模运算划分。

简单地说

均匀轨道拍摄用 Angular (标准,安
全),仅在您的图像不空间聚类时用 
Linear。
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W25 滑块“k Folds”

位置

左侧栏,中部。

技术细节

从 3 到 10 的滑块, 步进 1。更改时折计算自动重新触发,
使折列表、训练/测试 索引和每折分数立即重新计算。所
选值显示为标签右侧的 monospaced 数字文本。

经验法则:k=5 是标准 (给您每折 20% 测试,这是交叉验
证 的常用值)。k=10 当您有非常多数据且需要更多折以
获得 统计意义时。k=3 当您数据少时。

简单地说

划分多少折。5 是 标准,几乎总是合
适。

W26 选择器“Test Fold”

位置

左侧栏,k 滑块下方。

技术细节

菜单选择器。选项动态 为 0..<k,标签“Fold 1”到“Fold 
N” (即 UI 中 1 索引, 内部 0 索引)。如果之前所选索引 ≥ 
k (例如因为您将 k 从 10 减到 5),它自动重置为 0。所选 
Test Fold 在球面中显示 为红色,所有其他显示为绿色。

简单地说

哪一折当前是 Test Fold。您可点选
并看到每一折在球面上的样子。

W27 按钮“Export fold-assignment.json”

位置

左侧栏,下方。

技术细节

打开默认文件名为 fold-assignment.json 的保存对话
框。确认后,Holdout 模块 将当前划分编码为 JSON 
schema (按帧的折分配加 Strategy 元块)。该文件随
后可在下次带 --benchmark  的训练中带上, 使相同的 
Holdout 用于最终指标评估。写错误显示为错误文本; 成
功显示为绿色文本“Saved to (filename)”。

简单地说

将当前 Train/Test 划分保存为 
JSON。该文件您可在训练时直接
带上,使相同 测试集再次使用。
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W28 SCNView (3D 相机球面)

位置

Holdout 窗口中央面板。

技术细节

SceneKit 球面视图。 场景包括:线框球 (半径 1.0、36 
段、深灰色)、三个彩色 轴端柱 (红/绿/蓝代表 X/Y/Z,长 
1.2)、每个相机一个小标记 球 (半径 0.03) 位于单位球
面上相应视线方向位置 (略在外面, 以使其不消失在线框

球内)。标记在每次折更改时 不 重新构建 —— 仅在帧列
表更改时 (即加载了新 JSON) 需要重建。 相反,每次更
新运行就地更新材质颜色:Test 索引红色, Training 绿色,
既不也不浅灰色。这样即使在 N > 1000 相机时滑块刻
度也保持高性能。

相机控制激活 —— 您可用鼠标旋转、缩放、平移球面。
光照 确保标记不显平。背景深灰。

简单地说

带相机位置的 3D 球面。绿色 = 
Training,红色 = Test,浅灰 = 未分配 
(不出现, 所有相机都属于某处)。用
鼠标可旋转和缩放球面。

W29 FoldCard (单击选择折)

位置

右侧栏,“Angular Correlation”部分。

技术细节

每折一个卡片视图 —— 6 pt 半径圆角矩形,Padding 10,
垂直布局两行 (上“Fold N”
1. 相机数,下“Mean nearest angle:” + 度数值)。背景颜
色

条件化:活动折 = Accent 颜色半透明,不活动 = 中性标准 
Material。点击选择折,球面实时重新着色。

“Mean nearest angle”分数是每个 Test 相机到最近 
Training 相机的平均最小角 (内部以弧度计算,UI 中以度
显示)。

简单地说

每折一个小卡片在 右侧,显示相机
数和到最近 Training 相机的平均距
离。点击它 选择此折作为 Test。
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BayesOpt Console (W30–W39)

图 24  BayesOpt 控制台 — Trial 启动前的空状态

带 Search Space 选择器 (RadianceKit defaults (6-dim))、 Trial Budget 滑块 (默认 40)、
Random Seed (42) 和 Convergence 图、Trial Log 与 Search Space 参数列表三个空面板的
空状态。

空状态 (首次打开后) —— 一旦启动运行,Convergence 图和 Trial 表填满,见下张截图。

图 25  BayesOpt 控制台经过 40 次试验 — Convergence 图陡升到 Trial 15,Best Value 
0.9943,Trial Log 含 init/bo/restart 标签

图中所示  右上方状态“Finished — best 0.9943 after 40 trials”。左侧栏:Search Space 
选择器为 RadianceKit defaults (6-dim)、Trial Budget 40、Random Seed 42。
Parameter 列表显示要调优的六个超参数及其值范围: mipSmoothing3DScale [0.05, 
0.5]、mipFilter2DVariance [0.1, 0.6]、 densifyGradThreshold [5e-07, 5e-06]、
ssimWeight [0.05, 0.5]、 mcmcNoiseScale [1e-05, 0.0001]、mcmcRelocationInterval 

[50, 200]。 中间:Convergence 图 (X = Trial Index 1–40,Y = Objective Value 0–1) —— 
灰色点 = 初始样本 (LHS),蓝色点 = BayesOpt Acquisition,橙色点 = Restart Trials (#22 和 
#31)。 Best-Value 线陡升到 Trial ~7,然后到 Trial 15 仅边际改进, 从此处起在 0.99+ 平台。
右侧栏:Trial Log #1–#34 含 Score + 标签 (init/bo/restart)。右上方的 Save Best Config 按
钮写入 bayesopt-best.json 。
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这是什么: 一个用于超参数搜索的贝叶斯优化控制台。 贝叶斯优化是一种自
动方法,尝试用尽可能少的实验找到一个 未知函数的最优点 —— 通常是:“哪个 
mcmcMaxGaussians、 capMultiplier、ssimWeight 和 gradThreshold 组合为我的场景 类提
供最佳 PSNR?”BayesOpt 不是 6^4 = 1296 次试验的网格, 而是尝试约 40–100 次信息化试
验,从而接近最优。

重要: 应用当前交付的版本不针对真实训练运行执行 优化 (那会耗费数天),而是针对一个合成的
演示目标 —— 带 Hill-Climbing 特性的多模态地形加轻微噪声。这是有意的: 该窗口应向您
展示优化器的行为 (收敛走势、采样点、 Best-So-Far),并让您理解 Search Space 定义。对于
真实 的训练驱动 BayesOpt 运行 (如阶段 Q7 中为 Scene-Class 预设进行的),使用独立的离线 
CLI 工作流;该窗口是实时 UI 变体。

何时打开  三种用例:1. 您要理解 BayesOpt 如何 工作 —— 启动演示运行并观察 Convergence 
图。2. 您计划 新的场景类 (例如“水族馆”或“古董家具”),内置的 10 个 预设不完美匹配。
在心中定义搜索空间,在此处用“Bowl demo” 或“Densify”预设检查,然后将 Best Config 导
出为 JSON 并用作真实训练运行的起点。3. 您要检查 RKBayesOpt 包中 定义的默认 Search 
Space (Mip Subset、RadianceKit Defaults) —— 它们在左侧栏的 Parameter 面板中列出。

如何解读  - Convergence 图 (中间列): Y = 迄今最佳达到的目标函数值。X = Trial Index。开
始陡升 (BayesOpt 随机尝试初始样本,其中一些幸运),然后越来越 平,因为近最优区域已用
尽。如果线持续 20+ 次试验平稳, 您可停止运行 —— 进一步试验不再带来收益。图中的单个点 
是单独的 Trial 值 (不是“迄今最佳”),按阶段着色:灰色
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章

初始样本,蓝色 = bayesopt acquisition,橙

色 = restart。

• Trial 表 (右栏):#1、#2、#3 等,每个带值

和阶段标签。迄今最佳 Trial 标记为黄色星星。从表中您可 识别 Best Trial 并在导

出时查看其参数值。- Search Space 检查器 (左侧栏):对所选预设显示所有参数名
及其 搜索范围 [lo, hi] 。当您在预设“RadianceKit defaults (6-dim)”上时,您看到例
如“densifyGradThreshold [5e-7, 5e-6]” —— 即在这两个值之间 log-uniform。

示例工作流  选择预设“RadianceKit defaults (6-dim)”、 Trial Budget 40、Seed 42。单
击“Start”。观察:前 8 次 试验为灰色 (初始样本、LHS 拉丁超立方),后续为蓝色 (BayesOpt 获
取)。Convergence 图陡升到 Trial ~15,然后 平缓。在 Trial ~30–40 时最佳值稳定。单
击“Save Best Config” —— 一个 bayesopt-best.json  保存,含预设名、 Trial Index、值和
解码的参数值。然后您可将该 JSON 手动 采纳到您的预设定义中。

W30 按钮“Start”

位置

左工具栏,在 Idle/Finished 状态。

技术细节

重置 Trial 列表, 切换到 Running 状态,生成新的 Run 
ID (用于多次 Start 单击的 Stale 检测) 并创建一个新的 
Pause Gate。然后启动 一个后台任务,作为异步流执行
优化器。初始样本大小由 min(8, budget /​ 4 + 1) 得
出 —— 即在 Budget ≥ 28 时 典型为 8 个拉丁超立方样
本,在小预算下更少。Trial 更新 增量接收并附加到列表。
Stale Run 保护:如果期间第二次 Start 单击重设 Run ID,
旧 Run 的更新被丢弃。

Primary Action 样式用于突出的按钮外观。

简单地说

用当前搜索空间、预算 和种子启动
新优化运行。
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W31 按钮“Pause”

位置

左工具栏,在 Running 状态。

技术细节

激活 Pause Gate 并 切换到 Paused 状态。实际效
果:Runner 在 50 ms 轮询循环 中等待,然后才评估下一
个 Objective 函数。这意味着正在 运行的 Trial 完成 (它
是合成的且仅耗时微秒),但不会启动 下一个 Trial。一旦 
Resume 运行,它从中断处继续。

简单地说

暂停运行。当前计算 完成,然后暂
停。

W32 按钮“Stop”

位置

左工具栏,在 Running 和 Paused 状态。

技术细节

取消 Runner 任务, 清空引用,解除 Pause Gate (如果
仍 paused),并切换到 Finished 状态 (如果存在 Trial) 或 
Idle 状态 (如果没有)。 已计算的 Trial 在列表中保留可
见 —— Stop 不删除它们。 破坏性按钮角色让按钮显示
为红色,因为它中断运行。

简单地说

永久中断运行。 Trial 保留可见,您
仍可导出 Best Config。

W33 按钮“Resume”

位置

左工具栏,在 Paused 状态。

技术细节

解除 Pause Gate 并 切换回 Running 状态。Runner 任
务已经在运行 (它在轮询 循环中等待);一旦循环注意到 
Pause 被解除,它继续并 启动下一个 Trial。

简单地说

继续暂停的运行。
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W34 按钮“Save Best Config”

位置

右工具栏,始终可见 (但无 bestTrial 时禁用)。

技术细节

打开默认文件名为 bayesopt-best.json  的保存对话
框,限于 JSON。确认后 构建 Payload 字典:预设名、
Trial Index、值 (Objective Score)、Parameters (解码
的参数名 → 值的字典)。解码将 归一化的搜索空间
坐标 [0,1]^d 投影回原始值范围 (按 log-uniform/linear/
integer 比例)。JSON 输出 pretty-printed 且键排序。
写错误 (在当前演示版本中) 静默忽略 —— 无 错误 UI,因
为这是演示路径。

按钮在没有 Trial 运行过时保持灰显。

简单地说

将迄今最佳 Trial 的参数值保存为 
JSON。您可将这些值手动采纳到
您的预设 配置中。

W35 选择器“Search Space”预设

位置

左侧栏,上方。

技术细节

带四个预设选项的菜单 选择器:- “RadianceKit 
defaults (6-dim)” —— 含所有 Q7 超参数的完
整标准搜索空间。- “Mip subset (2-dim)” —— 
仅 mipSmoothing3DScale [0.05, 0.5] log-uniform 和 
mipFilter2DVariance [0.1, 0.6] linear。当您要为场景
类 调优 Mip-Splatting 时有用。- “densify-until + 
ssim-weight
1. grad-thresh“ —— 三个 Densify 相关参数 

(densifyGradThreshold

log-uniform、 ssimWeight  linear、
densifyUntilIter  integer)。

• “Bowl demo (1-dim)” —— “BayesOpt 这样工作”演
示的教学

性单参数搜索空间。

运行活动时不能切换搜索空间 (会混乱优化器)。

简单地说

BayesOpt 搜索哪个 超参数空间。
标准是“RadianceKit defaults”。
针对 Mip 调优 尝试用“Mip 
subset”。要理解 BayesOpt 如何
工作用“Bowl demo”。
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W36 滑块“Trial Budget”

位置

左侧栏,Search Space 选择器下方。

技术细节

从 10 到 200 的滑块, 步进 5。默认 40。意味
着:BayesOpt 最多可做 N 次试验。 其中前若干次是初
始样本 (拉丁超立方),其余是真正的 BayesOpt 试验。实
用经验法则:具有 d 维度的搜索空间需要 约 10d 到 20d 
次试验以获得好的最优。在 6 维默认 中即 60–120,在 2 
维 Mip 子集中 20–40,在 1 维 Bowl 演示中 10–20。

运行期间滑块禁用。

简单地说

最多多少次优化尝试。 尝试越多 = 
解决方案越好,但耗时更长。40 是
演示 Objective 的良好默认。

W37 滑块“Random Seed”

位置

左侧栏,Budget 滑块下方。

技术细节

从 1 到 100 的滑块, 步进 1。默认 42。种子被传递给初
始拉丁超立方样本以及 演示 Objective 的噪声组件。可
重复性:相同种子 + 相同 搜索空间 + 相同预算产生完全
相同的试验序列。对“如果 同事们重建演示,他们能否获
得相同运行?”有用。运行期间 禁用。

简单地说

控制随机生成器。 相同种子 = 相同
运行 —— 用于重现。

W38 Chart (Convergence)

位置

窗口中间列。

技术细节

带两层的 Swift Charts 图表:1. 每次试验“迄今最佳值”
的线 —— Accent 颜色的 单调递增或保持线。2. 每次试
验一个点,带单独 Objective 值,按阶段着色。Symbol 大
小 40。三个阶段标签:“init” (灰色)、“bo” (蓝色)、
“restart” (橙色)。

一个小图例在左上方显示阶段颜色。如果 Trial 列表
为空 (首次启动前),改为显示带 Chart 图标和提示“Press 
Start to begin a BayesOpt run.” 的空状态显示。

简单地说

走势图表。实线 是“迄今找到的
最佳解”;点是单独的尝试。如果线
长期保持 平稳,BayesOpt 已找到最
优。
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W39 Table (Trial Log)

位置

窗口右列。

技术细节

含 lazy 堆叠 Trial 行的滚动区。每行一个水平栈:Trial 编
号 (3 位 monospaced, 左)、值 (monospaced、右对
齐、70 pt 宽)、阶段标签 (Capsule, 25% Opacity 阶段
颜色填充),可选黄色星星 (如果该试验 为当前最佳)。自
动滚动机制在新 Trial 到达时自动跳到末尾 —— 使您能
在屏幕底部跟读实时走势,而无需自己滚动。

简单地说

所有试验的表。值、 阶段、最佳的
星星。自动滚动,新 Trial 出现在下
面。

主窗口:Loss 走势和 Gaussian Count (I39–I41,交叉引用)

主窗口检查器中的三个显示值得单独解释,因为它们在训练运行 时持续可见,并且关于走势何时
看起来健康有重要经验法则。 显示在检查器中的“Loss Chart”部分 (见第 2 章 —— 检查器), 并
补充上面辅助窗口中的 Holdout 分析。

何时 Loss 曲线健康? 健康的 Loss 曲线显示三个阶段: (1) Warmup —— 前 200–500 次迭代 
Loss 从高 (L1+SSIM 组合视场景典型 0.15–0.25) 陡降到约一半。如果 该阶段中 Loss 不下降,
通常输入错误 (图像损坏、SfM 位姿 差、初始 Gaussian 数太少)。(2) Densification —— 在 
~500 与 densifyUntilIteration (Classic 15K,MCMC 到 20K 或 25K) 之间,Loss 继续下降,当 
Densify 操作插入新 Gaussians 且 Optimizer 利用它们时常带小跳跃。Gaussian Count 在该
阶段增长。(3) Refinement —— 之后 Loss 进入 逐渐平缓的尾。典型最终值:Tanks-&-
Temples Truck 用 P4 Quality 落在 L1 ≈ 0.023,Horse 用 Full Classic V546 在 L1 ≈ 0.0230,
户外 Mip-NeRF360 场景往往更差 (0.04–0.07)。

平台意味着什么? 平台 (Loss 曲线在数千次迭代中 水平延伸) 有两种解读:(a) 模型已收敛,继续
训练不带来 什么 —— 这是好情况。(b) 模型卡住 (局部最小、糟糕的梯度 信息、缓冲区限制的 
Cap) —— 坏情况。两者在图中看起来相同。 区分:查看 Gaussian Count。如果它也平稳 并且 
接近 MCMC Cap (例如 .fullMCMC  上 150K 中 150K),您已达到极限 —— 要么提高 Cap,要么
接受平台。如果 Gaussian Count 仍 增长但 Loss 不下降,则卡住了。

何时中止 vs 继续训练? 经验法则:10K 迭代无 Min-Loss 改进 → 中止,进一步迭代浪费。在此
之前:您可通过 Cmd+T (Training 菜单 → Continue Training → +5K iterations) 再附加一个延
长,如果您看到边际改进。注意:在 MCMC 中 平台往往是真的 —— Cap 是自然边界。

Gaussian Count 平台 不 是“完成”信号。 它 仅意味着 MCMC 达到了 Cap 或 Classic 
Densification 已用尽。 真正的“完成”问题仅由 Holdout 分析回答 —— 在独立测试集 上的 
PSNR/SSIM/LPIPS,通过 Holdout 窗口 (W23–W29) 或 --benchmark  标志评估。

PSNR/Holdout 是真理,Loss 仅代理。 Loss 是相对 指标:它在您的模型适应训练视图时下降。
但低 Loss 并不 自动表示好模型 —— 如果模型记住了训练图像 (过拟合), Loss 会小,但在未见
视图 (Holdout) 上的 PSNR 会差。因此: 对最终质量评估始终看 Holdout 指标,而不是仅看最终 
Loss。

87 / 167



R A D I A N C E K I T 初始样本,蓝色 = bayesopt acquisition,橙色 = restart。

经验法则盒

• User Guide 和 Keyboard Shortcuts 是静态帮助 —— 对关键词 问题快速,深入则使用此
手册。

• 当磁盘剩余空间低于 10% 时打开 Manage Storage。Logs 和 Imports 暂存通常是罪魁。
• Pareto Dashboard 在至少三或四个训练报告之后才有意义。 X 轴 = 成本 (Time / Gs),Y 轴 

= 质量 (PSNR / SSIM)。 Pareto Front 显示高效组合。
• 在向其他人发布 PSNR 基准之前使用 Holdout Analysis —— 确保您的测试集真正具有代
表性。

• BayesOpt 控制台主要是搜索空间定义的学习和检查工具。 对真实训练驱动的超参数调优使
用离线 CLI 工作流。

• Loss 平台和 Gaussian Count 平台需分别解读。Cap 限制 不是“完成”信号。真正质量仅由 
Holdout PSNR 测量。

• 10K 迭代无 Min-Loss 改进 → 停止训练。
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章

第 6 章 — 训练配置

图 26  导出为 JSON 并在 TextEdit 中显示的 Preview 预设 — 字
段 id/name/category/version/createdAt/description, trainingConfig 含所有相关参数 

(maxIterations 5000、densifyUntilIteration 3500、 ssimWeight 0.20、renderScale 0.50、
strategy classic、cameraAlignment applePhotogrammetry、densifyGradThreshold 2.0e-06、

opacityResetInterval 3000、 minOpacity 0.005,六个 Bool 开关)

图中所示  一个典型的预设 JSON 导出。顶层字段: id  (UUID)、 name 、(classic | mcmc 
| sceneClass | custom)、(schema 版本)、(时间戳)、 (自由文本)。嵌套对象包含对可复现性
关键的参数 —— 导入时整个 块被反序列化为 TrainingConfig  结构,应用版本中的默认值 填
充 JSON 中缺失的字段 (例如应用更新后)。要将预设传递给 另一台 Mac 的人,简单地发送此 
JSON 文件即可。

TrainingConfig  结构是 RadianceKit 中每次训练运行的核心。 它收集影响训练的每个参数 
—— 从最大迭代数到八个学习率, 直到 MCMC、Mip-Splatting、Curriculum 和场景感知 Cap 
逻辑的 专门字段。您在侧栏的训练配置部分 (Expert View) 中编辑它, 将其保存为预设,或作为 
JSON 导出传递给另一台 Mac。训练时, 正是这个对象被冻结并交给 GPU 后端。
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本章是面向高级用户和脚本作者的参考资料。它列出所有 81 个 公共字段、9 个静态预设
和一个公开方法。源文件是 TrainingConfig.swift —— 有疑问时,其中的 doc-comment 和 
Initializer 默认值作为真理来源。

提示  ·  U I  V S  预设 /C L I

81 个字段中仅 12 个在检查器中有直接滑块、开关或选择器 (沙盒 App Store 构建):T1、

T2、T17、T20、T22、T38、 T56–T58、T60、T61、T73。其余 69 个字段通过所

选 预设 (第 7 章) 设置,只能通过 CLI 标志 (见第 5 章) 直接 覆盖。这种分离是有意:默认
值保持稳定且经过生产验证,高级 用户仍有逃逸通道。如果某个字段让您特别感兴趣:先查
第 2 章 (检查器) 和第 5 章 (CLI),看是否能不调 JSON 就达到。

目录:

1. 迭代 (T1–T2)
2. 学习率 (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH 度数推进 (T21)
6. 性能 (T22–T25)
7. 诊断和点云准备 (T26–T30)
8. 正则化 (T31–T37)
9. Refinement (T38–T44)

10. Sky-Dome (T45–T48)
11. Adam + LR 时间表 (T49–T55)
12. 后处理 + Apple AI (T56–T60)
13. MCMC Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. 自适应 Densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. 静态预设 (TP1–TP9)
18. 方法:
19. 哪个字段做什么? (速查表)
20. 危险字段
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迭代 (T1–T2)

T1 maxIterations

详细信息

默认: 30 000 (Initializer)、35 000 ( .full )、200 

000 ( .fullMCMC ) 范围: 1 000 – 500 000 (UI 滑块),

逻辑中无硬 上限 定义于:

技术细节

后端执行的训练迭代总数。一次迭代 指对单个训练相机
的前向渲染、对所有 Loss 组件 (L1 + SSIM + 可选正则
化 + Sky Mask) 的反向传递,以及一次 Adam Optimizer 
步骤。该数字直接影响其他计划:位置学习率遵循从 0 
到 T1  本身或 T49 positionLRScheduleEndIteration 
的 Cosine Annealing 曲线;Densification 在 T2 
densifyUntilIteration 停止;MCMC Noise Decay 在 
T69 mcmcNoiseDecayEnd 结束; SH 度数升级发生在 
T21  中定义的三个标记。在经典 Densification 下,
经验上的甜点在 20 000–35 000 次迭代 (Sessions 1–
32、V546 测试),在 MCMC 下为 60 000–200 000 
(V534)。超过预设值的大幅增加很少带来额外质量 —— 
Adam 动量饱和,且无 LR Decay 结束时 Loss 停滞。反
过来,低于 ~5 000 导致未充分收敛的几何 (Density 
Control 没足够时间 进行 Clone/Split)。

简单地说

应用计算多久。更多迭代 = 更好结
果, 但某时之后不再感知更好,反而
花更长。预设的选择使您无需 思考
即获得好值:Quick 1 000、Preview 5 
000、Balanced 20 000、 Quality 35 
000、MCMC Quality 200 000。如
果自己调整:MCMC 可大胆 (100 
000–200 000),Classic 不超 40 
000 —— 之后无效。
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T2 densifyUntilIteration

详细信息

默认: 15 000 (Initializer)、5 000 ( .full )、160 000 

( .fullMCMC ) 范围: 0 – 定义于:

技术细节

Densification 停止的迭代。在此之前, Gaussians 按 
T11–T16  (Classic) 或 T67–T70  (MCMC) 参数化 的
规则被克隆、分裂和裁剪;之后 Gaussian 数保持恒
定,仅优化 位置、旋转、缩放、Opacity 和 SH 系数 
(Refinement 阶段)。 在 3DGS 原始论文中该值是 T1  
的 50%,在 RadianceKit 的 .full  预设中只有 ~14% 
(35 000 中 5 000) —— V310/V338 实验的结果,显示 5 
000 次迭代后进一步 Densification 反而 恶化结果 (更
多 Floater、更多内存需求,无质量增益)。MCMC 则将 
Relocation 运行到 T1  的 80% (V504b),因为 MCMC 
不 产生有害 Floater。 T2  过小 (< 1 000) 时产生太少 
Gaussians; Classic 过大 (> T1  的 50%) 导致过度增
长和 RGB 饱和 离群点 (见户外过训练发现)。

简单地说

应用何时停止生成新 Gaussians。 
之后只细化已有的。35 000 迭代
经典训练中 5 000 是正确值 —— 
更多让场景更糊。MCMC 中是总
迭代的 80% (200 000 运行 即 160 
000)。改 Quality 预设时,最好别动
此字段。

学习率 (T3–T10)

T3 positionLearningRate

详细信息

默认: 0.00016 范围: 1e-7 – 1e-3 (推荐) 定义于:

技术细节

训练开始时 (迭代 0) 每个 Gaussian XYZ 位置的 Adam 
学习率。遵循 Cosine Annealing 曲线,在训练 过程中降
至 T4 positionLearningRateFinal。默认 0.00016 来
自 3DGS 原始论文 (Kerbl et al. 2023),在 RadianceKit 
中即使 提高图像分辨率也不需缩放 —— 位置在世界坐标
系中移动,而 非像素空间。大幅增加 (> 0.0005) 会让 
Gaussians 不稳定。

简单地说

Gaussian 位置变化速度的学习率。 
保持默认。原始论文值,经过验证。
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T4 positionLearningRateFinal

详细信息

默认: 1.6e-6 (Initializer)、1.6e-5 ( .full 、

.fullMCMC ) 范围: 1e-8 – 1e-3 定义于:

技术细节

位置学习率衰减的终止值。 Cosine Annealing 从 T3  
衰减到此值。 .full  中 10× 高于 Initializer 默认 
(V45),使较长训练保持有用学习。

简单地说

训练结束时位置学习率有多低。 经
过实验调优,保持默认。

T5 shDCLearningRate

详细信息

默认: 0.0025 范围: 1e-5 – 1e-2 定义于:

技术细节

SH DC 系数 (每 Gaussian 的基础 RGB 颜色) 的 Adam 
学习率。比位置学习率高 ~15×,因为颜色 变化对 Loss 
影响更直接。 .full  中 2× (V188)。

简单地说

基础颜色的学习速度。无需触碰。

T6 shRestLearningRate

详细信息

默认: 0.000125 范围: 1e-6 – 1e-3 定义于:

技术细节

SH 高阶系数 (1–3 度,方向相关 反射) 的学习率。比 DC 
低 20× —— 高阶 SH 是细微细节,需要 更稳定的优化。
.full  中 2× (V188)。

简单地说

反射和闪烁颜色的学习率。 保持默
认。

T7 opacityLearningRate

详细信息

默认: 0.05 范围: 0.001 – 0.5 定义于:

技术细节

每 Gaussian 透明度 (sigmoid 前的 原始 Logit) 的 
Adam 学习率。高 (0.05),因为透明度是 1D 且 快速调节
关键 (失效的 Gaussians 应快速变为 0)。 .full  中 2× 
(V188)。

简单地说

Gaussians 透明度的变化速度。 默
认快。无需触碰。
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T8 opacityLearningRateFinal

详细信息

默认: 0.05 范围: 0.001 – 0.5 定义于:

技术细节

Opacity 学习率的衰减目标 (实际 为常量,因 default 等
于 T7 )。默认情况下无 Opacity Annealing。

简单地说

Opacity 衰减目标。默认 = 起始 值,
即无衰减。

T9 scaleLearningRate

详细信息

默认: 0.005 范围: 1e-4 – 0.05 定义于:

技术细节

每 Gaussian 缩放 (对数空间中的三个 轴) 的 Adam 学
习率。 .full  中 2× (V188)。

简单地说

Gaussians 大小调整速度。保持默
认。

T10 rotationLearningRate

详细信息

默认: 0.001 范围: 1e-5 – 0.01 定义于:

技术细节

每 Gaussian 旋转 (wxyz 四元数) 的 Adam 学习率。
.full  中 2× (V188)。

简单地说

Gaussians 旋转速度。保持默认。

Densification — Classic (T11–T16)

T11 densifyGradThreshold

详细信息

默认: 2e-6 (Initializer)、1.1e-6 ( .full ) 范围: 1e-7 – 

1e-4 定义于:

技术细节

Classic Densification 中触发 Clone 或 Split 的位置梯
度阈值。高 → 更少 Gaussians,低 → 更多。 必须与 
T22 trainingRenderScale 匹配 (1.0× → 1e-6,0.5× → 
2e-6,0.25× → 4e-6)。减半可产生 2–4× Gaussians,可
能耗尽 GPU 内存。

简单地说

何时分裂 Gaussians 的阈值。 危
险字段 —— 必须与 Render Scale 
匹配。
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T12 densifyFromIteration

详细信息

默认: 500 范围: 0 – 5 000 定义于:

技术细节

Densification 启动的迭代。 首次 500 迭代是 Warmup,
场景大致定位,无 Densify。

简单地说

何时开始增长 Gaussians。 保持默
认。

T13 densifyInterval

详细信息

默认: 100 (Initializer)、200 ( .full ) 范围: 50 – 500 

定义于:

技术细节

Densification Pass 之间的迭代 间隔。 .full  中 V112 
调到 200,以减少 Floater。

简单地说

多久检查一次新 Gaussians。

T14 pruneOpacityThreshold

详细信息

默认: 0.005 (Initializer)、0.001 ( .full ) 范围: 

0.0001 – 0.05 定义于:

技术细节

Prune 时间步移除 Gaussians 的 最小 Opacity。
.full  0.001 (V393) 移除较少 (更保留), 保持更多细
节。

简单地说

何时丢弃近不可见的 Gaussians。

T15 opacityResetInterval

详细信息

默认: 3 000 (Initializer)、100 000 ( .full 、

.preview ) 范围: 100 – 1 000 000 定义于:

技术细节

Opacity 全局重置的间隔 (Inverse-Sigmoid 0.01)。默
认 3 000 来自 3DGS 论文,但破坏 RadianceKit 的短训
练 —— V194 在 .full  中禁用 (100 000 = 有效关闭)。
危险字段:在 < 10K 训练中 < 100K 值破坏收敛。

简单地说

危险字段。短训练保持高 (100 
000+)。
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T16 maxScreenSize

详细信息

默认: 20 范围: 5 – 100 定义于:

技术细节

Gaussian 最大屏幕大小 (像素), 超过则强制 Split。

简单地说

Gaussian 在屏幕上能多大。 保持
默认。

Loss (T17–T20)

T17 ssimWeight

详细信息

默认: 0.2 (Initializer)、0.05 ( .fullMCMC ) 范围: 0.0 – 

1.0 定义于:

技术细节

SSIM 损失 vs L1 损失的权重。 0.2 来自原始论文。
MCMC 用更低 (0.05) 以让 L1 主导 (V521b/V534)。

简单地说

图像结构相似性的权重。详见 I21。

T18 ssimWeightRefinement

详细信息

默认: 0.2 范围: 0.0 – 1.0 定义于:

技术细节

Refinement 阶段 (Densify Until 后) 的 SSIM 权重。可
不同于 Densification 阶段。

简单地说

Refinement 阶段的 SSIM 权重。

T19 edgeLossWeight

详细信息

默认: 0.0 范围: 0.0 – 1.0 定义于:

技术细节

Sobel 边缘 Loss 的额外权重。 保持 0,因为带来 
Floater。

简单地说

边缘锐化的额外权重。默认关闭。
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T20 skyMaskingEnabled

详细信息

默认: false 定义于:

技术细节

启用基于 Apple Vision 的天空掩码。 详见第 3 章 S7。

简单地说

户外/无人机场景中减少天空 
Floater。

SH 度数推进 (T21)

T21 shDegreeUpgradeIterations

详细信息

默认: [1000, 2000, 3000]  (Initializer)、

[2000, 5000, 8000]  ( .full 、 .fullMCMC ) 定义

于:

技术细节

SH 度数从 0 升到 1、1 到 2、2 到 3 的迭代时间表。早
期升级在低分辨率下不太有效。V228 推迟到 2K/5K/8K 
改进结果。

简单地说

何时加更多颜色细节。保持预设

值。

性能 (T22–T25)

T22 trainingRenderScale

详细信息

默认: 1.0 (Initializer)、0.5 ( .preview )、0.25 

( .quickTest ) 范围: 0.25 – 1.0 定义于:

技术细节

训练渲染分辨率缩放。详见 I22。

简单地说

训练以何分辨率渲染。最大性能杠

杆。
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T23 resolutionWarmupScale

详细信息

默认: 0.5 范围: 0.25 – 1.0 定义于:

技术细节

Warmup 阶段的初始 Render Scale。 之后逐步升到 
T22 。

简单地说

训练开始时的分辨率。

T24 tileSize

详细信息

默认: 16 范围: 8 – 32 定义于:

技术细节

GPU Tile 渲染的 Tile 大小。 16×16 经过 Apple Silicon 
优化。

简单地说

GPU 渲染分块大小。保持默认。

T25 throttleDelayMs

详细信息

默认: 0 范围: 0 – 100 定义于:

技术细节

迭代之间的人为毫秒延迟。 详见 S6。

简单地说

让训练变慢以让其他应用响应。

诊断和点云准备 (T26–T30)

T26 depthDistortionWeight

详细信息

默认: 0.0 范围: 0.0 – 1.0 定义于:

技术细节

深度扭曲正则化权重。在 Q1.5 中评估,无明显胜利,保
持 0。

简单地说

深度正则化。默认关闭。
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T27 singleViewOverfit

详细信息

默认: false 定义于:

技术细节

仅对单个视图训练以诊断。 Debug 工具,不用于生产。

简单地说

仅对单帧训练 (诊断模式)。

T28 maxCameras

详细信息

默认: 0 (无限制) 范围: 0 – 10 000 定义于:

技术细节

训练相机数的硬上限。0 = 无限制。 用于子集采样。

简单地说

仅使用 N 个相机进行训练。

T29 maxInitialPoints

详细信息

默认: 0 (无限制) 范围: 0 – 1 000 000 定义于:

技术细节

SfM 初始点云的硬上限。 0 = 全部。在大点云上有用。

简单地说

初始 SfM 点数。0 = 全部。

T30 cameraClusterOutlierMultiplier

详细信息

默认: 5.0 范围: 1.0 – 20.0 定义于:

技术细节

相机离群点检测中的距离 乘数 (比 cluster 中位数远多
少倍视为离群点)。

简单地说

自动剔除偏离离群相机。
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正则化 (T31–T37)

T31 coarseToFineBlurRadius

详细信息

默认: 0 范围: 0 – 10 定义于:

技术细节

训练目标的模糊半径 (Coarse-to-Fine)。

简单地说

训练初期模糊目标图像。

T32 scaleRegWeight

详细信息

默认: 0.0 范围: 0.0 – 0.1 定义于:

技术细节

Gaussian 尺度的正则化权重。 V549f 测试灾难性,保持 
0。

简单地说

尺度正则化。保持关闭。

T33 anisotropyRegWeight

详细信息

默认: 0.0 (Initializer)、0.1 ( .full ) 范围: 0.0 – 1.0 定

义于:

技术细节

各向异性正则化权重 (S9 通过 UI 启用)。 .full  V438 
启用。

简单地说

减少针状 Gaussians。详见 S9。

T34 scaleRatioPruneThreshold

详细信息

默认: 10.0 范围: 2.0 – 50.0 定义于:

技术细节

Scale 比例阈值,超过则 Prune 针状 Gaussians。

简单地说

Gaussian 多长就被剔除。
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T35 opacityRegWeight

详细信息

默认: 0.0 范围: 0.0 – 0.1 定义于:

技术细节

Opacity 稀疏性正则化权重 (强制接近 0)。

简单地说

强制 Opacity 走向 0 或 1。

T36 opacityDecayFactor

详细信息

默认: 0.0 (Initializer)、0.9995 ( .full 、

.fullMCMC ) 范围: 0.0 – 1.0 定义于:

技术细节

每次 Densify 循环后 Opacity 衰减 因子 
(HTGS,Eurographics 2025)。 .full  14% L1 改进 
(V546)。

简单地说

缓慢减少 Opacity。V546 的杀手
特性。

T37 opacityDecayInterval

详细信息

默认: 50 范围: 10 – 500 定义于:

技术细节

Opacity Decay 的间隔。 V546 中 50 最优。

简单地说

何时应用 Opacity Decay。

Refinement (T38–T44)

T38 gradientAccumulationSteps

详细信息

默认: 1 (Initializer)、2 ( .fullMCMC ) 范围: 1 – 4 定义

于:

技术细节

梯度累积的视图数。 2 = MCMC Quality (V544a,6% 
改进)。

简单地说

详见 I16 MCMC Quality。
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T39 testViewIndices

详细信息

默认: []  定义于:

技术细节

Holdout 评估的测试视图索引。 危险字段:手动设置可使
基准测试无用 (所有索引 > N)。 让 --benchmark  标志
设置。

简单地说

危险字段。让 –benchmark 设置。

T40 refinementPruneInterval

详细信息

默认: 0 (Initializer)、1000 ( .full ) 范围: 0 – 5000 

定义于:

技术细节

Refinement 阶段中的 Prune 间隔。 .full  1000 = 
V438 引入。

简单地说

Refinement 中何时清理。

T41 refinementPruneOpacityThreshold

详细信息

默认: 0.005 范围: 0.0001 – 0.05 定义于:

技术细节

Refinement Prune 的 Opacity 阈值。

简单地说

Refinement 阶段中 Prune 强度。

T42 midTrainingCompactificationIterations

详细信息

默认: []  (Initializer)、 [20000, 30000]  (与 S8 一

起) 定义于:

技术细节

中期训练 Compactification 的迭代列表。详见 S8。

简单地说

详见 S8 Mid-Training Floater 
Cleanup。
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T43 frustumCullEnabled

详细信息

默认: false 定义于:

技术细节

训练相机视锥外的 Gaussians 被 Cull。仅 CLI。

简单地说

移除帧外的 Gaussians。

T44 frustumCullExpansion

详细信息

默认: 1.2 范围: 1.0 – 3.0 定义于:

技术细节

Frustum 扩展因子,以保留 临界外区域的 Gaussians。

简单地说

Cull 时 Frustum 多大。

Sky-Dome (T45–T48)

T45 skyDomeEnabled

详细信息

默认: false 定义于:

技术细节

启用 V549e Sky-Dome 投影。 详见 S10。

简单地说

详见 S10 Reconstruct Sky Dome。

T46 skyDomeSampleCount

详细信息

默认: 5000 范围: 1000 – 20000 定义于:

技术细节

Sky-Dome 上要初始化的 Gaussians 数。

简单地说

天空中放多少 Gaussians。
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T47 skyDomeRadiusMultiplier

详细信息

默认: 8.0 (Initializer)、59.0 (P9 Outdoor) 范围: 1.0 – 

100.0 定义于:

技术细节

Sky-Dome 半径,作为场景半径 的倍数。

简单地说

天空多远。Outdoor 预设中较大。

T48 frozenGaussianCount

详细信息

默认: 0 范围: 0 – 1 000 000 定义于:

技术细节

前 N 个 Gaussians 不被优化 (冻结)。用于 Sky-Dome 
MVP 中的天空 Gaussians。当前未连接 到 Optimizer。

简单地说

冻结前 N 个 Gaussians。未启用。

Adam + LR 时间表 (T49–T55)

T49 adamResetIteration

详细信息

默认: 0 (无) 范围: 0 – 100 000 定义于:

技术细节

重置 Adam 矩的迭代。 0 = 永不重置。

简单地说

Adam Optimizer 重启。

T50 positionLRScheduleEndIteration

详细信息

默认: 0 (= T1)、20 000 ( .full )、160 000 

( .fullMCMC ) 定义于:

技术细节

位置 LR Cosine Annealing 的 结束迭代。0 = 与 T1 相
同。 .full  V431 调到 20K。

简单地说

何时位置学习率达到 Final。
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T51 extendedPhaseLRDecay

详细信息

默认: false 定义于:

技术细节

Refinement 阶段中的额外 LR 衰减。

简单地说

训练末尾的额外学习率衰减。

T52 adaptiveDensifyThreshold

详细信息

默认: 0.0 范围: 0.0 – 1.0 定义于:

技术细节

自适应 Densify 阈值, 用 Q5 自适应 Densification 启
用。

简单地说

Q5 阈值参数。

T53 mergeAfterDensification

详细信息

默认: false 定义于:

技术细节

Densification 后合并步骤。 不推荐。

简单地说

Densify 后合并附近 Gaussians。

T54 densifyPhase2FromIteration

详细信息

默认: 0 范围: 0 – 50 000 定义于:

技术细节

两阶段 Densification 的 第二阶段开始。危险字段:测试
中级联到 0 Gaussians。

简单地说

危险字段。保持 0。

T55 densifyPhase2UntilIteration

详细信息

默认: 0 范围: 0 – 50 000 定义于:

技术细节

两阶段 Densification 的 第二阶段结束。危险字段。

简单地说

危险字段。保持 0。
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后处理 + Apple AI (T56–T60)

T56 postTrainingCompactification

详细信息

默认: true ( .full , .fullMCMC )、false (其他) 定义

于:

技术细节

启用 V443 后训练 Compactification。 详见 I26。

简单地说

详见 I26。几乎总是开。

T57 metalFXUpscaling

详细信息

默认: true 定义于:

技术细节

视口 MetalFX 放大。详见 I27。

简单地说

详见 I27。

T58 mpsLanczosScaling

详细信息

默认: false 定义于:

技术细节

视口 MPS Lanczos 放大。详见 I28。

简单地说

详见 I28。

T59 livePreviewInterval

详细信息

默认: 0 (Off) 范围: 0 – 10 000 定义于:

技术细节

Live Preview 更新间隔。详见 S5。

简单地说

详见 S5。

T60 perceptualLossWeight

详细信息

默认: 0.0 范围: 0.0 – 0.2 定义于:

技术细节

Perceptual Loss 权重。详见 I29。

简单地说

详见 I29。
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MCMC Densification (T61–T73)

T61 densificationStrategy

详细信息

默认: .classic  选项: .classic , .mcmc  定义于:

技术细节

Densification 策略选择。 详见 I15。MCMC = NeurIPS 
2024。

简单地说

Classic 或 MCMC。详见 I15。

T62 mcmcMaxGaussians

详细信息

默认: 150 000 ( .fullMCMC )、1 189 511 (P8)、1 250 

744 (P9) 范围: 0 – 5 000 000 定义于:

技术细节

MCMC 模式中 Gaussian 数硬上限。 0 
= 使用 Mass-Extinction-Floor 150K。Cap 通过 
resolveMcmcMaxGaussians 用 SfM 初始点数和 Buffer 
容量 解析。

简单地说

MCMC 最多多少 Gaussians。

T63 mcmcNoiseScale

详细信息

默认: 5e-5 ( .fullMCMC )、5.61e-05 (P8) 范围: 1e-6 

– 1e-3 定义于:

技术细节

MCMC 随机噪声尺度。 V467/V536 最优。

简单地说

MCMC Relocation 中的噪声强度。

T64 mcmcOpacityRegWeight

详细信息

默认: 0.0 范围: 0.0 – 0.1 定义于:

技术细节

MCMC Opacity 正则化权重。 危险字段:1.4.3 中 0.01 
导致 Mass Extinction (460K → 5)。 1.4.4 起固定为 0。

简单地说

危险字段。保持 0。
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T65 mcmcScaleRegWeight

详细信息

默认: 0.0 范围: 0.0 – 0.1 定义于:

技术细节

MCMC Scale 正则化权重。 危险字段:与 T64 一同导致 
1.4.3 Mass Extinction。固定为 0。

简单地说

危险字段。保持 0。

T66 mcmcRelocationInterval

详细信息

默认: 100 (Initializer)、50 (Q7 sweeps) 范围: 10 – 

500 定义于:

技术细节

MCMC Relocation Pass 之间的 间隔。

简单地说

MCMC 多久重定位。

T67 mcmcWarmupIterations

详细信息

默认: 500 范围: 0 – 5 000 定义于:

技术细节

MCMC Relocation 启动前的 Warmup。

简单地说

MCMC 何时启动。

T68 mcmcDeadOpacityThreshold

详细信息

默认: 0.005 (Initializer)、0.01 ( .fullMCMC ) 范围: 

0.0001 – 0.1 定义于:

技术细节

Gaussian 在 MCMC 中视为 “死”的 Opacity 阈值,因此
可重定位。V535 最优。

简单地说

Gaussians 何时被重定位。
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T69 mcmcNoiseDecayEnd

详细信息

默认: 0 (Initializer)、160 000 ( .fullMCMC ) 范围: 0 – 

1 000 000 定义于:

技术细节

MCMC 噪声衰减结束的迭代。 80% T1 (V497c/V502)。

简单地说

MCMC 噪声何时减少。

T70 mcmcGrowthRate

详细信息

默认: 0.05 范围: 0.01 – 0.5 定义于:

技术细节

每个 Relocation 通过的 MCMC 增长率。

简单地说

MCMC 增长速度。

T71 mcmcSigmoidK

详细信息

默认: 100 范围: 10 – 1000 定义于:

技术细节

MCMC 采样深度选择的 Sigmoid 因子 K。

简单地说

MCMC 采样行为。

T72 mcmcCapMultiplier

详细信息

默认: 3.0 ( .fullMCMC )、2.98 (P8)、5.32 (P9)、1.76 

(P10) 范围: 0.5 – 20.0 定义于:

技术细节

MCMC Cap 与 SfM 初始点数的 乘数 (Auto-Scale 启用
时)。Outdoor 5.32 仅在 Bicycle 156K init 点时工作 → 
830K Cap。危险字段。

简单地说

自动 MCMC Cap 缩放因子。
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T73 mcmcAutoScaleByScene

详细信息

默认: false (Initializer)、true ( .fullMCMC ) 定义于:

技术细节

启用 MCMC 自动按场景缩放。 详见 I17。

简单地说

详见 I17。

Mip-Splatting (Q1.5) (T74–T76)

T74 useMipSplatting

详细信息

默认: false 定义于:

技术细节

启用 Mip-Splatting (Q1.5)。 2026-05-25 closed no-
win。某些户外场景甚至降低 PSNR。

简单地说

Mip-Splatting opt-in 标志。

T75 mipSmoothing3DScale

详细信息

默认: 0.2 范围: 0.05 – 0.5 定义于:

技术细节

Mip 3D 平滑缩放。

简单地说

Mip 3D 平滑参数。

T76 mipFilter2DVariance

详细信息

默认: 0.3 范围: 0.1 – 0.6 定义于:

技术细节

Mip 2D 过滤方差。

简单地说

Mip 2D 滤波参数。
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自适应 Densification (Q5) (T77–T79)

T77 adaptiveDensification

详细信息

默认: false 定义于:

技术细节

启用 Q5 自适应 Densification。 单独 fail,与 Q6 一起 
pass 1/3。

简单地说

Q5 自适应 opt-in 标志。

T78 adaptiveWindow

详细信息

默认: 1000 范围: 100 – 5000 定义于:

技术细节

自适应 Densification 的 滑动窗口。

简单地说

Q5 窗口参数。

T79 adaptiveDensifyMultiplier

详细信息

默认: 2.0 范围: 1.0 – 10.0 定义于:

技术细节

自适应 Densify 乘数。

简单地说

Q5 乘数参数。

Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

详细信息

默认: false 定义于:

技术细节

Q6 课程学习中的分辨率 渐进。Q6 是 Q5+Q6 包的承载
者。

简单地说

Q6 分辨率渐进。
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T81 curriculumSHProgression

详细信息

默认: false 定义于:

技术细节

Q6 课程学习中的 SH 推进。

简单地说

Q6 SH 渐进。

静态预设 (TP1–TP9)

此处仅显示与 Initializer 默认值的结构差异。十一个 UI 预设 P1–P11 的完整营销描述见第 
7 章。

TP1 .preview

详细信息

~10 GB RAM 以上系统的诊断/预览预设。覆盖:30 
000 → 5 000、 15 000 → 3 500 (T1 的 70%)、T4 
1.6e-6 → 1.6e-5 (10× 高,更少 激进衰减)、T5/T6/T7/
T9/T10 各 2× (V176)、T15 3 000 → 100 000 (有效
关闭,V172:Reset 破坏短训练)、T21 [1K, 2K, 3K]  → 
[1K, 2K]  (V182:Degree 3 不在 2K 中收敛)、T22 1.0 

→ 0.5

简单地说

新导入图像序列的任何初始评估 
—— 2–3 分钟 等待,之后结果足以
回答“Quality 运行是否值得?”的二
元问题。

TP2 .full

详细信息

生产质量 Classic。覆盖:30 000 → 35 000 (V550)、
15 000 → 5 000 (V310 甜点)、所有 LR 2× (V188)、
T4 1.6e-6 → 1.6e-5 (V45)、 T11 2e-6 → 1.1e-6 
(V335)、T13 100 → 200 (V112)、T14 0.005 → 0.001 
(V393)、T15 3 000 → 100 000 (V194)、T21 → 
[2K, 5K, 8K]  (V228)、T36 0.0 → 0.9995 (V546 

HTGS,14% 改进)、T33 → true (V438)、T40 0 → 
1000 (V438)、T50 0 → 20 000 (V431)、T56 → true 
(V443)

简单地说

带 < 500 图像的任何标准照片拍
摄 (物体、小房间、 雕塑)。V546 
中宣布的 14% Loss 改进在 Horse 
Full 上 3 次试验平均 确认对比 
V438。
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TP3 .fullClassicPaper

详细信息

Q1.5-A 测试,TP2 的兄弟,论文忠实 Classic。覆盖 TP2: 
T1 35 000 → 30 000、T2 5 000 → 15 000 (论文 
50% T1)、T4 → 1.6e-6 (论文默认)、T5/T7/T9 回到论
文默认 (0.05, 0.005, 0.001)、 T11 1.1e-6 → 2e-7 (校
准到 Bicycle 上 ~1-2M Gs)、T13 200 → 100、T14 
0.001 → 0.005、T15 100 000 → 3 000 (论文 §5.2,有
风险)、 T36 0.9995 → 0.0、T50 20 000 → 30 000 
(Cosine 跑 100% T1)

简单地说

Q1.5 研究实验,需要论文级 
Gaussian 预算 (1–2 M) 用于 Mip-
Splatting 测试。Q1.5 “closed no-
win” 裁定后,预设保留 对高级用户
可访问,但不推荐用于生产。

TP4 .fullMCMC

详细信息

生产质量 MCMC。覆盖 Initializer:T1 30 000 → 
200 000 (V534)、T2 15 000 → 160 000 (V504b 
80%)、T4 → 1.6e-5、LR 时间表如 TP2、T17 0.2 
→ 0.05 (V521b/V534)、T21 → [2K, 5K, 8K] 、 T61 
→ .mcmc 、T62 150 000、T63 5e-5 (V467/V536)、
T68 0.005 → 0.01 (V535)、T69 0 → 160 000、T72 
3.0、T73 true、T15 3 000 → 200 000

简单地说

Web 交付、要求细节的物体扫描、
无人机飞行 (虽然 P9 Outdoor 更
好)。比 Classic 在可比 L1 下少 
71% Gaussians。

TP5 .fullMCMCMip

详细信息

Q1.5-D 测试,TP4 的兄弟,带 Mip-Splatting + 论文级 
MCMC 预算。覆盖 TP4:T62 150 000 → 1 500 000 
(10×)、T74 false → true

简单地说

所有其他字段与 TP4 相同。Q1.5 
D-PASS Bicycle 2026-05-24 (打破 
12 次迭代多尺度 FAIL 序列)。Q1.5 
最终裁定 2026-05-25 仍 closed-
no-win —— Mip-Splatting 胜利不
可在 11 对 场景上复现。预设保留 
opt-in。

TP6 .classicBalanced

详细信息

中等档 Classic。覆盖 TP2:T1 35 000 → 20 000 
(V149)、 T50 20 000 → 0 (Cosine 跑 T1 = 20K,无扩
展阶段)

简单地说

较短等待的标准情况。V149 识别
为甜点。
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TP7 .mcmcPreview

详细信息

MCMC 诊断。覆盖 TP4:T1 200 000 → 60 000 
(V494b)、T2 160 000 → 48 000 (80%)、T62 150 
000 → 100 000 (V473b)、T69 160 000 → 40 000 
(V494b)、T72 3.0 → 2.0

简单地说

快速看 MCMC 结果以判断 TP4 或 
Scene-Class 预设是否值得。

TP8 .mcmcBalanced

详细信息

中等档 MCMC。覆盖 TP4:T1 200 000 → 120 000 
(V518)、 T2 160 000 → 96 000 (80%)、T69 160 
000 → 96 000 (80%)、T72 3.0 → 2.5

简单地说

无完整 200K 运行的 MCMC。
~120K 迭代是质量和等待时间 的良
好折中。

TP9 .quickTest

详细信息

纯功能测试。覆盖 Initializer:T1 30 000 → 1 000、T2 
15 000 → 500、 T11 2e-6 → 4e-6 (校准到 0.25× 分
辨率)、T13 100 → 50、T15 3 000 → 100 000 (关闭,
因为太短)、T22 1.0 → 0.25

简单地说

理智检查“训练是否合理开始?”。
在 M3 Ultra 上 < 30 秒。 保证看起
来糊。

方法: resolveMcmcMaxGaussians

签名: public func resolveMcmcMaxGaussians(initialPointCount: Int, 

bufferCapacity: Int) -> Int 定义于:

技术  “MCMC 最多可让多少 Gaussians 生长?”问题的 唯一真理来源。从三个输入计算:配
置的 T62 mcmcMaxGaussians (Mass-Extinction-Floor 150 000,如果 0)、(SfM 初始点数) 和 
(预分配 Gaussian 缓冲区大小)。逻辑:

1. base = T62 > 0 ? T62: 150_​000 (Mass-Extinction-Floor 防止 Initializer 默认 bug 如 
1.4.3 Mass Extinction 事件)

2. 如果 T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) 否则

3. 如果 bufferCapacity > 0 :return min(scaled, bufferCapacity)
4. 否则 return scaled

示例:Bicycle (Mip-NeRF 360,194 帧照片) → SfM-init ~156K 点, T62 = 150 000 、
T72 = 5.32 、Buffer 容量 8M。Resolved Cap = min(8M, max(150K, ceil(156K × 
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5.32))) = min(8M, 830K) =

830K。这是 MCMC Relocation 逻辑遵守的有效增长 Cap。

简单地说  计算 MCMC 中的实际最大 Splat 数。接受您的设置,查看场景初始有多少点,并按 
Multiplier  缩放 (如果自动适应启用)。这样 Cap 适应场景, 而非对小场景和巨大场景强制相
同值。您无需自己调用方法 —— 训练内部使用它。

哪个字段做什么? (速查表)

目标 要调的字段

远处更多细节 T62 mcmcMaxGaussians 高、 T72 mcmcCapMultiplier 5+

一般更多细节 
(Classic)

T1 maxIterations  高 (≤ 40K)、 T2 densifyUntilIteration ≤ 
T1 的 14%

减少无人机飞行中的 
Floater

T43 frustumCullEnabled 开、 T20 skyMaskingEnabled 开、
T45 skyDomeEnabled  开

户外场景中漂亮的天

空

T45 skyDomeEnabled  开、 T47 skyDomeRadiusMultiplier 30–
60

更小的导出文件 策略 .mcmc  (T61)、 T56 postTrainingCompactification 开、T62 

mcmcMaxGaussians ≤ 200K

更快训练 T22 trainingRenderScale 0.5、 T1 maxIterations  减半 — 但不
要两个都做!

更好的高光 T21 shDegreeUpgradeIterations 带 [2K, 5K, 8K]  (无早期前载)、
MCMC + 200K iter

保持 Mac 响应 T25 throttleDelayMs 5–10 (消耗 ~15% 训练时间)

更频繁的 Live 预览 T59 livePreviewInterval 降到 10–20

阴影中更柔和的过渡 T17 ssimWeight  略高 (0.15–0.25),但不超过 0.3

保持室内紧凑 P10 Indoor 预设 (、 T72 = 1.76 )

危险字段

这些字段在错误配置时可能导致 OOM、应用崩溃、Gaussians Mass Extinction 或无用基准
数据。需谨慎处理:

• T11 densifyGradThreshold — 减半可产生 2–4× Gaussians,迅速耗尽 GPU 内存。还
要注意:必须与 T22 trainingRenderScale 匹配 (1.0× → 1e-6、0.5× → 2e-6、 0.25× → 
4e-6)。

• T72 mcmcCapMultiplier — 大场景 > 200K SfM 初始点和 Multiplier > 5 时产生数百万 
Gaussians 的 Resolved Cap。在 36 GB RAM Mac 上可能 OOM。Outdoor 预设 5.32 仅
因为 Mip-NeRF-360-Bicycle 有 156K init 点 → 830K Cap。
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• T39 testViewIndices — 手动设置可使基准 无用 (所有 indices > N → 无 Holdouts)。让 
--benchmark  标志设置。

• T64 mcmcOpacityRegWeight 和 T65 mcmcScaleRegWeight — 1.4.3-Beta 设为 0.01 导致 
Mass Extinction (一次迭代 中 460K → 5 Gaussians)。自 1.4.4 起固定为 0.0,但手动 增加
可重现该问题。

• T15 opacityResetInterval — 如果不是 100 000+ (有效关闭) 且训练短于 10 000 迭
代,Reset 破坏收敛。 .preview  因此设为 100 000,尽管 maxIterations = 5 000。

• T54/​T55 densifyPhase2* — 两阶段 Densification 在测试中级联到 0 Gaussians。两者保
持 0。

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25,在某些户外场景上甚至降低 
PSNR。默认关闭, 仅研究 opt-in。

如果某字段在此列表上且您要更改,先备份当前预设 (导出为 JSON) 并考虑能否可复现地测量
结果 —— 否则之后您不知道您是带来 改进还是恶化。
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章

第 7 章 — 内置质量预设

图 27  预设区域显示全部四组且全部展开 — CAPTURE CLASS (4 个预设: Drone/Aerial、360° 
Walkaround、360° Walkaround (High Detail)、 Photo/Object)、CLASSIC (5 个预设:Quick/
Preview/Balanced/Quality/Ultra Detail)、MCMC (3 个预设,附有“No threshold tuning”提示)、

HYBRID (1 个预设:Balanced (Hybrid))

图中所示  检查器中的预设区域, 四个组别全部展开。CAPTURE CLASS 包含四个针对真实拍摄
类型 (无人机、 360° 漫游、照片物体) 精心策划的预设 (Drone / Aerial、360° Walkaround、 
360° Walkaround (High Detail)、Photo / Object) —— 这是首要组别, 也是新手模式中唯
一可见的组别。CLASSIC 包含 Quick (1K iters)、Preview (5K iters,当前选中并有蓝色对勾)、
Balanced (20K iters)、Quality (35K iters) 和 Ultra Detail (35K iters)。MCMC 带有 副标
题“No threshold tuning”——MCMC 不需要 Densify-Until 阈值: Preview (60K iters,100K 
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高斯)、Balanced (120K,150K)、Quality (200K,150K)。HYBRID 包含 Balanced (Hybrid) 
(20K iters,150K 高斯)。 底部操作栏:Save…、Export…、Import…

预设是为训练准备好的配置。RadianceKit 在四个组别中提供十三个内置 预设:四个 Capture-
Class 预设 (P9–P12) —— 这是针对真实拍摄 方式 (无人机、360° 漫游、照片物体) 精心策
划、并在真实社区素材上凭 肉眼验证过的配方,也是自 v1.6 起的首要轴线 ——,五个 Classic 预
设 (P1–P5:Quick/Preview/Balanced/Quality/Ultra Detail),三个 MCMC 预设 (P6–P8),以及一
个结合 Classic 与 MCMC 策略的混合预设 (P13)。 早先的“Scene-Class”预设 (Render/3D、
Outdoor、Indoor,在阶段 Q7 中 针对 Mip-NeRF-360 和 NeRF-Blender 场景进行了学术调
优) 在 v1.6 中 作为可见组别被撤回 —— 在真实素材上凭肉眼验证过的 Capture-Class 现在是
首要轴线;经 Q7 调优的配置仅在内部保留。您可在侧栏的 Presets 区域或在新手模式的导入
步骤中选择它们。 +  按钮会打开对话框以新建自己的预设 —— 十三个内置预设无法删除, 但可
以复制。

在专家视图中,预设按拍摄方式和策略分组显示 (Capture Class / Classic / MCMC / Hybrid)。
单击某个条目会将其存储的训练配置写入当前状态。 这不是快照 —— 如果之后您调整滑块,状
态会发生变化,但预设本身 保持不变;一个彩色提示会显示“modified”。

何时使用哪个预设主要取决于场景类型和硬件。本章末尾的三个 表格概览对此进行了总结。

P1 — Quick

位置

检查器 → 预设区域 → 组别“Classic” → 条目 “Quick”。
UUID 后缀 …001 。

技术细节

诊断用预设,1 000 次迭代,经典 (自适应) Densification 
策略,训练分辨率缩放为 0.25× (输入图像在训练前缩小
到 25 %)。不是用于交付场景的预设, 而是快速判断设置 
(相机位姿、点云、图像序列) 在 Loss 值上 是否表现出
有意义的变化。在 M3 Ultra 上,50–200 张图像 通常少
于 30 秒。小尺寸会掩盖真实的图像质量,但能将内存 需
求和渲染开销保持得非常小。当系统 RAM 少于 10 GB 
时, 首次启动也会自动选用此预设。

简单地说

快速功能测试。导入图像,等不到半
分钟, 查看场景的粗略轮廓是否出
现。如果查看器中的图像看起来像 
一团模糊的色块 —— 没错,本应如
此。但如果您看到的只是暗点 或完
全扭曲的形状,则相机位姿很可能有
问题 (参见第 9 章)。 要得到可展示
的结果,之后您至少需要 P2 或 P3。
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P2 — Preview (Classic)

位置

检查器 → 预设区域 → 组别“Classic” → 条目 
“Preview”。UUID 后缀 …002 。

技术细节

5 000 次 Classic-Densification 迭代,0.5× 分辨率缩放,
学习率为标准的两倍。Densification (克隆 + 分裂) 在前 
2 500 次迭代中保持活跃,之后仅做 Pruning。≥ 10 GB 
RAM 系统的默认预设。在 M3 Ultra 上,200 张图像的场
景通常 需要 90 秒到 3 分钟。能让您对几何形状和相机
位姿形成可用 的印象,但纹理明显被柔化 —— 0.5× 渲染
分辨率之后无法通过 直接用 P3 或 P4 重新训练来弥补,
因为学习率是按一半分辨率 校准的。

简单地说

“简单看一下”的标准选择。如果您
刚刚导入 新图像,想查看场景是否
可重建,这是合适的级别。大约等
待 2–3 分钟,之后可以在 3D 查看器
中旋转并判断进一步训练是否 值
得。只有当预览结果看起来不错

时,Balanced 或 Quality 才值得投
入时间。

P3 — Balanced (Classic)

位置

检查器 → 预设区域 → 组别“Classic” → 条目 
“Balanced”。UUID 后缀 …005 。

技术细节

20 000 次 Classic-Densification 迭代,完整 图像分辨
率。Densification 在前 15 000 次迭代中运行, 从第 3 
000 次迭代起 Densify 间隔为 100。在已记录的训练 会
话中是经验上的“甜点”:对于 Horse Full 和 Truck 上的 
经典 Densification,L1 Loss 在 18 000 至 22 000 迭代
之间 稳定下来,继续延长训练在低于 Quality (P4) 的水
平上不会 带来明显改进。在 M3 Ultra 上,200 张图像通
常 30–60 秒, 1 000+ 张图像 5–8 分钟。

简单地说

“不错的折中”。多数场景使用此预
设已经看起来 不错,而无需等待一
个小时。如果您打算在某处展示

最终结果 (社交媒体、网站、客户
演示),通常足够。只有当您要放大
到 Splat 模型内部或需要表面纹理
的细节时,才值得跃升到 P4 Quality 
或 P7 MCMC。
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P4 — Quality (Classic)

位置

检查器 → 预设区域 → 组别“Classic” → 条目 
“Quality”。UUID 后缀 …003 。

技术细节

35 000 次 Classic-Densification 迭代,搭配 V546 
的“Opacity Decay” (HTGS, Eurographics 2025):每次 
Densify 循环后,所有现存 Gaussians 的 Opacity 乘以
一个 < 1.0 的因子,这能让已变得不活跃的 Gaussians 
在 Pruning 中被可靠地移除,因而在相同迭代数下达到比
经典 35 000 次 运行好 14 % 的 L1 Loss。SSIM-Loss 
已启用 ( ssimWeight=0.05 )。 在 M3 Ultra 上,200 张
图像通常 2–4 分钟。在 NeRF-Blender (Lego、Chair、
Drums) 上交付最终 L1 ≈ 0.023 —— 是 560+ 已记录
实验中最好的 Classic 变体。注意:需要约 3–5 GB GPU 
内存;在 8 GB 系统上 P3 是更安全的选择。

简单地说

最好的经典变体。提供清晰的纹理

和精细的 几何,在物体拍摄 (一尊
雕塑、一把椅子、一只花瓶) 上尤
其 出色。而在大型户外场景或房间
中,与 Balanced 相比差异 几乎不可
察觉 —— 在那里,切换到 MCMC 预
设 (P6–P8) 或 Capture-Class 预设 
(P9–P12) 比从 P3 跳到 P4 更值得。 
若想要 Classic 家族的绝对上限,请
选用 P5 Ultra Detail。

P5 — Ultra Detail (Classic)

位置

检查器 → 预设区域 → 组别“Classic” → 条目 “Ultra 
Detail”。UUID 后缀 …008 。

技术细节

约 35 000 次 Classic-Densification 迭代 —— 质量 矩
阵 (2026-06-10) Held-out 测评的优胜者。在全部三个
受测的 Mip-NeRF-360 场景上,Ultra Detail 在相近的挂
钟时间下, PSNR 比内置的 MCMC“Quality”预设 (P8) 
高出约 +0.94 dB。 因此它是 Classic 组别中最强
的 Quality 预设,也是 RadianceKit 所交付的最锐利的 
Classic 变体。在 M3 Ultra 上,通常与 P4 Quality 处于
相同时间区间 (200 张图像 2–5 分钟),但需要稍多 GPU 
内存;在 8 GB 系统上 P3 仍是更安全的选择。

简单地说

最锐利的 Classic 级别,也是我们
质量测试的 Held-out 优胜者:在真
实场景上比 MCMC“Quality”变体
高出约一分贝 —— 而等待时间相
近。如果您想用久经验证的经典 
Densification 获得 最高细节保真
度,并且有足够的 GPU 内存,这就
是首选。若内存 不足或您需要尽
可能小的导出文件,请保持使用 P4 
Quality 或一个 MCMC 预设。
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P6 — Preview (MCMC)

位置

检查器 → 预设区域 → 组别“MCMC” → 条目 
“Preview”。UUID 后缀 …006 。

技术细节

60 000 次 MCMC-Densification 迭代 (3DGS-MCMC, 
NeurIPS 2024),Cap 为 100 000 Gaussians。MCMC 
用 Markov 链蒙特卡洛重定位替代启发式的 Clone/Split 
逻辑:已死亡的 Gaussians 通过 Sigmoid 加权的采样
深度被重新放置,从而产生 可控且可复现的 Gaussian 数
量。Cap 在 100K 处硬性封顶 —— 这能节省内存和渲染
时间,代价是细节减少。在 M3 Ultra 上, 200 张图像通
常 5–8 分钟。适合作为“MCMC 功能测试” —— 有助于
在 P7 或 P8 投入更多时间之前,判断从 Classic 切到 
MCMC 是否值得。

简单地说

类似 P2 Preview,但采用较新的 
MCMC 方法。 通常会得到比 
Classic 变体更紧凑、分布更均
匀的 Splat 云。 对场景的初步
评估,5–8 分钟通常已足够。如
果您喜欢预览 结果,下一步是 
P7 (Balanced) 或直接 P8 (Quality 
MCMC)。

P7 — Balanced (MCMC)

位置

检查器 → 预设区域 → 组别“MCMC” → 条目 
“Balanced”。UUID 后缀 …007 。

技术细节

120 000 次 MCMC 迭代,Cap 为 150 000 Gaussians。
MCMC 的中间级别 —— 几乎是 P8 Quality 的最终 
Gaussian 数,但仅 60 % 的迭代。在已记录的训练会话
中, Horse Full 上 L1 Loss 经验上为 0.026–0.028,相比 
P8 的 0.0246 大约高 7 %,但等待时间仅一半。在 M3 
Ultra 上, 200 张图像通常 8–15 分钟。使用一种方法,将
有效的 Gaussian Cap 按输入 SfM 点云的点密度进行缩
放 (参见第 6 章 中的 T75)。

简单地说

具备相当细节深度的 MCMC,但没有 
P8 的 长时间完整运行。对多数场
景而言已足够,尤其是您想把一次 
MCMC 训练塞进午休时间时。如果
内存吃紧 (例如仅 16 GB 的 M 处理
器),就停在这里 —— P8 需要更多 
GPU 内存。
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P8 — Quality (MCMC)

位置

检查器 → 预设区域 → 组别“MCMC” → 条目 “Quality”。
UUID 后缀 …004 。

技术细节

200 000 次 MCMC 迭代,Cap 为 150 000 
Gaussians,SSIM-Loss 0.05,MCMC-Noise-Decay 覆
盖 80 % 的迭代。在 560+ 实验中的 Best-Single-Run-
L1:Horse Full 上 0.0238,在 3 次试验上平均 0.0246 (相
比同场景下 P4 的 0.0230)。MCMC 同时减少 71 % 的 
Gaussians (150K 对 ~524K) —— 当您打算在网络上交
付结果时这非常关键,因为更小的 云会产生显著更小的导
出文件。在 M3 Ultra 上,200 张图像 通常 20–35 分钟;
在 1 000+ 张的图像集上更多是 1–2 小时。 当需要在最
小最终大小下获得最高图像质量时是最佳选择。

简单地说

最好的 MCMC 变体。提供非常干
净、紧凑的 Splat 云 —— 当您打算
稍后将结果作为 Web 3D 查看器嵌
入 或作为文件分发时非常理想 (在
视觉质量可比的情况下, 文件比 P4 
Quality 更小)。但您需要耐心 —— 
在大型拍摄上 要等待超过一个小
时。最好将其安排为“过夜”运行。
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图 28  CAPTURE CLASS 组展开显示全部四个精心策划的真实拍摄预设 — Drone / 
Aerial (MCMC, 40K iters, Cap 1.5 M)、360° Walkaround (MCMC, 40K, Cap 1.5 M)、360° 

Walkaround (High Detail) (Hybrid, 40K, Cap 1.5 M, 可选启用) 和 Photo / Object (Hybrid, 40K, 
Cap 1.5 M)。此组位于最上方,也是新手模式中唯一可见的组别。

图中所示  检查器中 CAPTURE CLASS 组已展开 —— 自 v1.6 起的首要预设组别,也是新手模式
中唯一 显示的组别。每个条目都是针对一种具体拍摄方式 (无人机、360° 漫游、 照片物体)、
在真实社区素材上凭肉眼验证过的配方,而不是针对学术 测试集优化出的数值。单击选择会将
存储的训练配置写入当前状态。
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P9 — Drone / Aerial

位置

检查器 → 预设区域 → 组别“Capture Class” → 条
目“Drone / Aerial”。UUID 后缀 …010 。

技术细节

面向建筑和景观的空中与无人机环绕拍摄的 Capture-
Class 预设。MCMC-Densifier,40 000 次迭代,Cap 1.5 
百万 Gaussians,SSIM-Loss 0.5 加上 Edge-Aware 项 
0.1。 关键在于权重 0.003、比例阈值 6 的各向异性
惩罚 —— 这是 对付无人机素材常产生的典型针状伪影的
“意大利面杀手”。 在一次真实的 DJI 4K 无人机飞越 
Pensford 高架桥的拍摄上 验证 (凭肉眼检查,而不仅是
指标)。

简单地说

用于空中拍摄 —— 环绕建筑的无
人机飞行、 飞越景观、沿着外墙拍
摄。强力的各向异性惩罚清除掉无

人机 素材爱产生的针状或意大利面
状伪影。如果您的素材是从地面 拍
摄的,更适合 Photo / Object 或一个 
Classic 预设。

P10 — 360° Walkaround

位置

检查器 → 预设区域 → 组别“Capture Class” → 条
目“360° Walkaround”。UUID 后缀 …011 。

技术细节

面向 360° 漫游视频的 Capture-Class 预设。 MCMC-
Densifier,40 000 次迭代,Cap 1.5 百万 Gaussians, 
SSIM-Loss 0.5 加上 Edge-Aware 项 0.1,温和的各向异
性惩罚 (权重 0.001,比例阈值 15)。人物和天空遮罩已启
用。该预设 期待一段 360° 等距柱状视频,它会在训练开
始前被内部重投影 为约 90° 宽的透视裁切。在使用自拍
杆拍摄的 8K 360° 漫游上 验证 (Monument 场景,凭肉
眼检查)。

简单地说

用于 360° 漫游视频 —— 您手
持 360° 相机或 自拍杆穿过一
个房间或绕着一个物体行走。

RadianceKit 会自行 把球面全景分
解为正常视角,并把路人和天空遮罩
掉。要在同一 素材上获得最高锐
度,可以额外尝试 High-Detail 变体 
(P11)。
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P11 — 360° Walkaround (High Detail)

位置

检查器 → 预设区域 → 组别“Capture Class” → 
条目“360° Walkaround (High Detail)”。UUID 后缀 
…013  (可选启用)。

技术细节

面向追求最高细节的 360° 漫游视频的可选启用 
Capture-Class 预设。Hybrid-Densifier (经典绝对梯度
的 Clone/Split + MCMC 噪声 + Relocation),40 000 次
迭代, Cap 1.5 百万 Gaussians,各向异性惩罚 0.0015、
比例阈值 15, SSIM-Loss 0.2、Edge-Aware 项 0 —— 
即锁定的“r50” Screen-Split 配方。在 360° 素材上,它
在 PSNR、LPIPS 和 可见的彩纸状伪影上击败标准的 
MCMC 预设“360° Walkaround” (P10),而且只用约三分
之一的 Splat 数量。它有意作为可选项 并列于 标准 
360 预设,直到在更多场景上得到验证。

简单地说

标准 360 预设 (P10) 更锐利的替代:
更多细节、 更少彩纸状伪影、文件
明显更小。它有意并列存在而非取

代 —— 目前仅在屈指可数的几个
场景上得到确认。如果您的 360° 
漫游 拍摄得很干净,请先尝试此预
设,并将结果与 P10 比较。

P12 — Photo / Object

位置

检查器 → 预设区域 → 组别“Capture Class” → 条
目“Photo / Object”。UUID 后缀 …012 。

技术细节

面向由清晰单张照片 (非视频) 组成的物体
环绕的 Capture-Class 预设。Hybrid-t1-Densifier 
(带 Relocation), 40 000 次迭代,Cap 1.5 百万 
Gaussians,SSIM-Loss 0.5 加上 Edge-Aware 项 0.1,温
和的各向异性惩罚 (权重 0.001,比例 阈值 15),Opacity 

Decay 0.9995 每 50 次迭代,无 遮罩。在 163 张高分辨
率 41-MP 的骨架照片上验证 (凭肉眼 检查)。少量视图 
(至多约 600) 会保持在 Hybrid 崩溃阈值之下。

简单地说

用于由清晰单张照片组成的物体拍

摄 —— 您绕着 一尊雕塑、一个模
型、一件产品用相机拍照而不是录

像。无遮罩, 因为清晰的照片通常
有干净的背景。对于视频来源,请改
用一个 360° 或 Drone 预设。
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P13 — 平衡(混合)

位置

检查器 → 预设区域 → 组别“Hybrid” → 条目 “平衡(混
合)”。UUID 后缀 …009 。

技术细节

20 000 次迭代,采用混合 (Hybrid) Densification 策略: 
经典的梯度驱动 Clone/Split 把容量放到损失需要的
位置,MCMC 的 SGLD 噪声持续探索,死亡的 Gaussians 
会被重新安置而不是在 剪枝中丢失。Opacity Decay 
(V546) 取代了 Opacity 重置;各向 异性惩罚 (权重 
0.001,比例阈值 15) 抑制针状 Splats。Gaussian 上限
随场景缩放 (基础 150K,场景感知 ×3.0)。在五个场
景上与 同等预算的纯 MCMC 对比验证:平均 +0.45 
dB PSNR,同时 Gaussians 减少 20–30 % (stonehenge 
+1.23、family +0.82、 garden +0.47 dB)。在 M3 
Ultra 上,200 张图像通常 5–10 分钟。

简单地说

获得最终结果的一个强有力的首选:
细节比 MCMC 预设更锐利,文件大
小相近,而训练时间只是 P8 的一
小部分。 如果您只有时间进行一
次质量运行,且没有任何 Capture-
Class 明显匹配,请从这里开始。经
典预设仍更适合快速测试;当您
的 场景明显属于这些拍摄方式之
一时,Capture-Class 预设 (P9–P12) 
才是首选。

何时使用哪个预设?

场景 初次测试 主运行

新图像功能测试,< 30s P1 Quick —

由清晰单张照片组成的物体

环绕

P2 Preview P12 Photo / Object

单物体扫描 (视频),< 500 
张

P2 Preview P4 Quality 或 P8 Quality 
MCMC

360° 漫游视频 P6 Preview MCMC P10 360° Walkaround (锐
利:P11 High Detail)

空中 / 无人机环绕、风景 P6 Preview MCMC P9 Drone / Aerial

Web 交付 (小、紧凑) P2 P8 Quality MCMC (同等质量
下最小文件)

短时间内获得锐利细节、紧

凑导出

P2 或 P6 P13 平衡(混合)

最高细节保真度、Classic 
策略

P3 或 P6 P5 Ultra Detail

印刷、营销、完整细节 P3 或 P6 P4 Quality (Classic) 或 P5 
Ultra Detail
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快速对比

预设 策略 迭

代

Max-
Gs

渲染比例 典型 时间 (200 张图,M3 Ultra) Q-Sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 s —

P2 Preview Classic 5 000 ∞ 0.5× 2–3 min —

P3 BalancedClassic20 000 ∞ 1.0× 30–60 s —

P4 Quality Classic35 000 ∞ 1.0× 2–4 min V546 
HTGS

P5 Ultra 
Detail

Classic ~35 
000

∞ 1.0× 2–5 min Matrix 
Δ+0.94 

dB

P6 Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 min —

P7 Balanced 
MCMC

MCMC 120 
000

150 
K

1.0× 8–15 min —

P8 Quality 
MCMC

MCMC 200 
000

150 
K

1.0× 20–35 min V544a

P9 Drone / 
Aerial

MCMC40 000 1.5 
M

1.0× 10–25 min 肉

眼 / 
高架

桥

P10 360° 
Walkaround

MCMC40 000 1.5 
M

1.0× 10–25 min 肉

眼 / Monument

P11 360° 
Walkaround 

(High 
Detail)

Hybrid40 000 1.5 
M

1.0× 10–25 min 肉眼 
(可选
启用)

P12 Photo / 
Object

Hybrid40 000 1.5 
M

1.0× 10–25 min 肉

眼 / 
骨架

P13 
平衡

(混
合)

Hybrid 20 000 150 
K

1.0× 5–10 min Matrix 
Δ+0.45 

dB
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自定义预设

通过预设区域 (第 2 章中的 I1) 中的 Save… 按钮, 您可以将当前训练配置保存为自己的预设。
自定义预设不属于 “Built-in”,可以重命名、导出 (为 JSON)、通过拖放共享、复制 和删除。十
三个内置预设 P1–P13 不受删除按钮的影响。

经验法则: 如果您对某个预设做了修改且打算多次复用 —— 开启 Sky-Dome、对特定场景类提
高 SSIM 权重、不同的迭代次数 —— 请将该变体保存为自定义预设。这样下次运行时您一眼就
能看出 这是一个与默认配置不同的设置。 </content> </invoke>
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章

第 8 章 — 导出格式

图 29  新手模式中的导出格式选择 — 六个格式卡片

图 30  在 Bjoern 的花束场景 5K 迭代训练后实时显示的导出格式网格 — 全部六个卡片均有动态
大小计算 (PLY 742 KB 已选中、SPZ 74 KB、 glTF 708 KB、.splat 96 KB、Orbit Video ~Zero 

KB、Web Viewer 133 KB),右侧的导出历史已含一个已保存的 PLY

图中所示 (2 991 Gaussians、SH degree 3,Bjoern 的合成 Blender 花束作为 IP 干净的

测试集): 每个格式卡片下方的尺寸数据 是从当前 Gaussian 数量和格式开销实时计算出的 —— 
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并非硬编码。 由 2 991 个 Gaussians (SH degree 3) 得到:742 KB PLY、74 KB SPZ (通过
量化缩小约 10×)、708 KB glTF (带 KHR_​gaussian_​splatting 扩展,因此与 PLY 几乎等同)、
96 KB .splat (压缩的每 Gaussian 24 字节格式)。Orbit Video 显示“~Zero KB”,因为大小只有
在 MP4 编码完成后才知道。Web Viewer (133 KB) 将独立的 HTML 文件与嵌入 的 WebGL 
查看器以及压缩的 Splat 数据打包在一起 —— 由于查看器 开销而大于纯 .splat。右侧的导出历
史列出已完成的 PLY 导出 (“training_20260527T211321Z.ply, 743 KB, 23:13”),带格式标签 
和“在 Finder 中显示”操作。

完成的训练交付一个 Gaussian-Cloud —— 一组数十万到数百万个 3D 高斯分布的集合,
它们共同重建场景。RadianceKit 提供十种将该 点云写入磁盘的方式。其中六种是纯 3D 数据
格式 (PLY、Compressed PLY、SPZ、SOG、glTF、.splat),一种将点云与现成的 HTML 查看
器 一起打包 (Web Viewer),一种将一段轨道相机运动渲染为 MP4 文件 (Orbit Video),另外
两种不导出 Gaussian 内容,而仅导出 SfM 结果 (相机位姿和粗略点云),供其他训练流水线复用 
(transforms.json + COLMAP-Workspace)。

何时该选哪种格式取决于目的。要无损归档完整数据,使用 PLY。 要在自己的页面上使用 Web 
查看器,通常 .splat 或内置的 Web Viewer 就够。如果文件必须最小,则 SPZ 或 SOG 值得
考虑。要在 Nerfstudio、Postshot 或 Brush 中复用 SfM 结果,transforms.json 和 COLMAP-
Workspace 是正确的方法。

所有导出功能都位于“Export”菜单中,以及新手模式向导的最后一步。 多数格式完全符合沙盒
要求,可在 App Store 版本中工作。仅 SOG 需要外部二进制 ( cwebp ),它在 App Store 构建中
未必存在 —— 详情参见 E4。
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E1 — PLY (.ply)

位置

菜单栏 → Export → 3D Formats → Export PLY… 
(⌘E)。 新手模式:向导步骤 Export → 格式卡片“PLY”。 

大小: 通常 100 % (参考值)。兼容性: SuperSplat、
PolyCam、所有 3DGS 查看器。

技术细节

PLY 是 3D Gaussian Splatting 的标准存储 格式。
RadianceKit 写出一个具有标准化 3DGS 属性布局的
二进制 小端文件:每个 Gaussian 包含三分量位置、三个
始终为零的法线、 三个 DC-SH 系数 ( f_dc_0..2 ) 作
为基础 RGB 颜色,然后最多 45 个进一步的 SH 系
数 ( f_rest_0..44 ),按 Kerbl-2023 论文定义的 转置 
Channel-Major 顺序排列 (先所有 R 通道系数,然后是所
有 G,然后是所有 B),后接 Logit-Opacity (原始的 pre-
Sigmoid 值)、 三个对数空间尺度,以及一个 wxyz 四元
数旋转。最大导出的 SH 阶 会被截断到用户期望值与实
际学习到的阶之间的最小值;默认是 3 (45 个剩余系数)。
在写入之前,会用 64 位整数计算 Payload 大小, 以捕获
极大点云的溢出。文件以原子方式写入,在大点云情况下
会 短暂占用双倍磁盘空间。

简单地说

这是“原始文件”。最大的文件、最
高的兼容性、 没有损失。如果您
不知道该选什么格式,就选 PLY —— 
它能在几乎 所有 3DGS 工具中打
开。100 万 Gaussians 视 SH 阶不
同约为 200 到 800 MB。如果文件
太大,看看 E2 (compressed PLY) 或 
E3 (SPZ)。
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E2 — Compressed PLY (.ply)

位置

菜单栏 → Export → 3D Formats → Export 
Compressed PLY…。 新手模式:格式卡片“Compressed 

PLY”。 大小: 约为 PLY 的 10–20 % (5 到 10 倍压缩)。 

兼容性: SuperSplat、PlayCanvas-Engine、基于 Web 
的 查看器。

技术细节

PLY 格式的 PlayCanvas 变体,带分块量化。 Gaussians 
被分成 256 个一组。每个分块在 Header 中分别存
储 位置、Scale 和颜色的 Min/Max 边界;每个 Gaussian 
相对于这些 边界引用其值,并被压缩为 32 位:位置
和尺度采用 11-10-11-Bit 打包,旋转采用 2-10-10-10-
Bit“Smallest-Three”四元数, 颜色采用 8-8-8-8 RGBA。
较高的 SH 系数每分量仅用 8 位量化 (每 Gaussian 
shCoeffCount * 3  个 uchar)。格式本身仍然是 

ASCII-Header-PLY,因此原则上可以用 PLY 工具验证,但 
Vertex 属性被声明为 uint  字段。SH 阶默认为 0 (无
剩余系数),以最大化 压缩 —— 也可以显式选择更高的 
SH 阶。

简单地说

节省空间的 PLY 变体。与普通 PLY 
的引擎 兼容性相同,但小 5 到 10 
倍。SuperSplat 和 PlayCanvas 原
生 读取它。对于 Web 部署几乎总
是优于普通 PLY。量化造成的质量 
损失通常视觉上无法察觉,除非场景
包含极高频的细节。
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E3 — SPZ (.spz)

位置

菜单栏 → Export → 3D Formats → Export SPZ…。 新

手模式:格式卡片“SPZ”。 大小: 约为 PLY 的 10 % (小 

90 %)。 兼容性: Niantic Scaniverse、Niantic Spatial 
Fields、 MetalSplatter。

技术细节

Niantic 的 SPZ-v2 格式。位置打包为 24 位定点 (约 
0.25 mm 分辨率),尺度在对数空间中量化为 8 位, 旋转
量化为 8 位 Smallest-Three (v2 中仅保存 xyz,w 由解
码器 从四元数范数推导出),透明度量化为 sigmoid 化的 
8 位值。 DC-SH 使用 SPZ 特有的打包公式 (dc_​raw * 
0.15 * 255 + 0.5 * 255) 存储,较高的 SH 频段使用 
5 位 (Band 1) 或每系数 4 位 (Band 2-3)。 整个打包二
进制 Blob 然后用标准 gzip (RFC 1952) 压缩,得到一个 
gzipped 容器格式,带有魔术字节 1f 8b 。RadianceKit 
为此调用 系统 gzip ,因为 Apple 内置的 zlib API 
会产生专有的 Apple Framing, 与 Spatial Fields 或 
MetalSplatter 中的 SPZ 读取器不兼容。 系统 gzip  
即使在 macOS 沙盒中也可启动。

简单地说

最小的标准文件。如果您熟悉 
Niantic 的 Scaniverse —— 那就是
这个应用使用的格式。非常小,非
常适合 移动应用加载。在 Niantic 
自家的云查看器 (Spatial Fields) 中 
可直接使用。比相同数据的 PLY 小
约 90 %,且对多数场景在视觉上 几
乎无法区分。
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E4 — SOG (.sog)

位置

菜单栏 → Export → 3D Formats → Export SOG…。 新

手模式:格式卡片“SOG”。 大小: 约为 PLY 的 5–6 % (15 

到 20 倍压缩 —— 最小的选项)。兼容性: PlayCanvas-
Engine、 SuperSplat-Editor。

技术细节

“Spatially Ordered Gaussians” —— 一种 PlayCanvas 
格式,将点云作为多个 Lossless-WebP 图像以 GPU 就
绪方式存储。首先所有 Gaussians 按 3D Morton 码 
(30 位 Z-Order,每轴 10 位) 进行空间排序,这为后续
渲染器中的缓存 局部性带来好处。然后位置使用对
称对数变换 (以获得更好的动态 范围) 量化为 16 位
值,并分为两张 RGBA 图像 ( means_l.webp  存低 8 位,
means_u.webp  存高 8 位)。旋转以 3×8 位加 2 位 

Mode 的 Smallest-Three 在一张 RGBA 图像中编码 
(Mode 落在 Alpha 中,值为 252 + largest )。尺度和 
DC-SH 各用一个 256 项 码本量化 (按所有值的百分位
分布),索引落在 scales.webp  和 sh0.webp  中。这五
张图像加上一个含码本和边界的 meta.json  被打包进
一个 ZIP 文件 (自定义编码器,因为沙盒阻止系统 zip ), 
并以 .sog  后缀保存。

沙盒注意: SOG 是唯一需要外部二进制的格式
选项。 WebP 编码阶段从 /​usr/​local/​bin/​cwebp 
或 /​opt/​homebrew/​bin/​cwebp 调用 cwebp 。如果找
不到 cwebp 二进制,代码会回退到原始 PNG 编

码 —— 但:PNG 回退在 SuperSplat 中不能工作。 
在 App Store 版本中,根据构建变体评估可用性;在 
Developer 版本中,必须通过 Homebrew 安装 cwebp 
( brew install webp )。

简单地说

所有 3DGS 格式中最小的,明显
小于 SPZ。 但是:需要 Mac 上的 
cwebp  工具,因为 RadianceKit 
本身无法 生成所有图像格式。通
过 Homebrew 安装一次,然后一切
都能运行。 在 App Store 版本中可
能无法完全工作 —— 如果导出时
得到 PNG 而非 WebP,文件就无法直
接在 SuperSplat 中打开。不使用 
Homebrew 的用户改用 SPZ (E3)。
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E5 — glTF (.glb)

位置

菜单栏 → Export → 3D Formats → Export glTF…。 新

手模式:格式卡片“glTF”。 大小: 与 PLY 相当。兼容

性: 带 KHR_​gaussian_​splatting 扩展的 glTF 查看器 
(Khronos 草案 标准)。

技术细节

按照 KHR_​gaussian_​splatting 扩展规范 写出一个自含
的 .glb  二进制文件 (无单独的 bin 文件附件)。 位
置存为常规 glTF 的 POSITION  顶点数据 (float3),所有
其他 属性 (旋转 float4、尺度 float3、Opacity float、
SH 系数 float3 × shCoeffCount) 位于额外的顶点属性
中,并通过扩展引用。 重要:glTF 使用右手 Y-up 坐
标系,COLMAP/3DGS 使用 Y-down/Z-forward。 因此
导出器对 X 轴施加 180 度旋转 —— 位置被改写为 
(x, -y, -z) , 四元数被调整为 (w, x, -y, -z) 。这
样在 glTF 查看器中得到几何 正确、手性正确 (无镜
像) 的呈现。JSON 和二进制块按照 GLB 标准 要求填充
到 4 字节对齐。

简单地说

3D 数据的 Khronos 官方标准格
式,其中新鲜 出炉的扩展面向 
Gaussian Splat。优势:glTF 在所有
大型 3D 引擎 (Babylon.js、Three.js、
Unity、Unreal) 中广泛使用。劣势: 
该扩展在 2026 年仍处于草案阶段,
许多查看器尚不能识别。主要 在以
下情况下有意义:您要将 Splat 数据
集成到已有的 glTF 流水线, 或正在
编写一个已经支持 glTF 的查看器。

E6 — Splat (.splat)

位置

菜单栏 → Export → 3D Formats → Export .splat…。 

新手模式:格式卡片“.splat”。 大小: 每 Gaussian 正

好 32 字节。兼容性: gsplat.js、基于 Web 的查看器 
(antimatter15 参考实现)、大多数 浏览器中的 3DGS 演
示。

技术细节

antimatter15 的 .splat  格式 —— 每 Gaussian 32 字
节,无头部,无间接寻址。每个条目的布局: 3 × float32 位
置 (世界坐标),3 × float32 Scale (从内部缓冲区 的对数
空间 exp 变换得到),4 × uint8 RGBA 颜色 (DC-SH 系
数 按 SH_C0 = 0.282...  缩放并截断到 [0,255]),4 × 
uint8 四元数 (w,x,y,z,归一化后以 128 + 128*q  编码
到字节范围)。仅保存 DC-SH —— 较高的 SH 频段被丢
弃。这使格式极其紧凑,但代价是 丢失反射或镜面高光时
的视角相关颜色变化。写入顺序正是点云的 索引顺序 
(无空间排序),Web 查看器如 gsplat.js  在此基础上 
渲染。

简单地说

当您要在自己的 Web 查看器中
用 gsplat.js  显示 Splat 时的
首选格式。非常紧凑 (32 字节/
Gaussian),但 没有更高的 SH 阶 
—— 因此没有依视角变化的闪亮反
射或细微颜色 变化。对多数 Web 
应用而言不成问题,因为 DC 颜色已
完全足够, 缺失的视角依赖性几乎
察觉不到。
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图 31  在 Firefox 中打开的 Web Viewer — Bjoern 的花束 Splat 被渲染, 周围环绕相机标记球,顶
部可见浏览器标签栏,无需 CDN/服务器设置。 独立的 flowers-01.html  直接通过 Finder 双
击在默认浏览器中 打开 — 嵌入的 WebGL2 程序立即渲染 Gaussian 点云,无需网络 或服务器。花

束周围的黑色标记是训练相机,可选显示。 鼠标拖动旋转,滚轮缩放。

E7 — Web Viewer (.html)

位置

菜单栏 → Export → Media → Export Web Viewer…。 

新手模式:格式卡片“Web Viewer”。 大小: Splat 数据 
base64 编码 (≈ 4/3 开销) + 约 5 KB HTML/JS 外壳。

兼容性: 任何支持 WebGL2 的现代浏览器 (所有桌面、
iOS 15+、Android 5+)。

技术细节

将 Gaussian 点云连同一个完全内联的 WebGL2 渲染器
打包进一个单独的 .html  文件。没有 CDN 依赖, 没有 
WASM,没有第二个文件。点云在内部先编码为 .splat  
二进制 (与 E6 相同的 32 字节逻辑),然后 base64 内联,
再用 atob  在 浏览器中解码。内置渲染器执行自己的 
WebGL2 排序、鼠标轨道控制 以及每帧的 CPU 排序;整
个 JS 代码 (着色器、数学、循环) 在输出 HTML 中可
见。存储到渲染器边界的坐标轴约定与 E5 完全相同: 位
置 (x, -y, -z) ,四元数 (w, x, -y, -z) 。可选地可
以 显示品牌叠加 (免费版开关)。由于一切都是内联的,该
文件甚至可以 直接从 file:/​/​ 协议工作 —— 测试时不
需要本地 Web 服务器。

简单地说

一个单独的 HTML 文件,您可以通过
邮件 发送给某人,或在网页中嵌入。
在 Finder 中双击,浏览器就会 用鼠
标旋转显示您的场景。不需要上传

到云、不需要第二个文件、 不需要
服务器。非常适合客户演示、作品

集、邮件附件。劣势: 由于 base64 
编码,文件比纯 .splat  大约三分
之一 —— 对于 非常大的场景,因此
值得单独托管 .splat  文件并配
合标准 查看器使用。
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图 32  从 flowers-01.mp4 中提取的单帧 — Bjoern 的花束侧面渲染, 带相机标记的白色平台
可见,黑色背景 (默认视口背景,可在设置中 更改)。相机沿参数化轨道围绕场景旋转 (Elevation 
与 Distance 固定,Yaw 旋转),典型时长 6–10 秒,30 或 60 fps。 帧分辨率可通过 VideoPreset 从 

480p 缩放到 8K。

E8 — Orbit Video (.mp4/.mov)

位置

菜单栏 → Viewport → Record Turntable Video 或 菜
单栏 → Export → Media → Export Orbit Video…。新
手模式: 格式卡片“Orbit Video”,带 3–30 秒时长滑块。 

大小: 取决于时长、分辨率、码率。 兼容性: 所有平台 
(H.264 和 HEVC 是 Apple 标准)。

技术细节

沿参数化轨道相机运动渲染 Gaussian 点云, 并通
过 AVAssetWriter 将每帧编码为 MP4 或 MOV 文件。
轨道 配置控制旋转速度 (圈数)、距离、Elevation、
FOV、时长以及 Ease-In/Out 因子。轨道视频导出通过 
RadianceKit 自己的 ForwardPass 进行,并带完整的 SH 
求值 — 与软件内视口 逐像素一致 (WYSIWYG)。每帧将
世界对齐矩阵 (由渲染器计算, 将内部坐标旋转到 Y-up 
轨道世界中) 与相机相乘,然后应用 一次相机约定翻转 
(camFlip: 轨道 Y-up → COLMAP Y-down)。 离屏渲染
目标通过 IOSurface 拉入 CVPixelBuffer 用于编码器。
编码器支持 H.264 和 HEVC、 可配置的码率以及从 
480p 到 8K 的分辨率。在第一帧之前,渲染器 等待 200 
毫秒,以便完成初始 Splat 排序。此导出是 GPU 受限的 
—— 在 8K 和数百万 Gaussians 下,每帧渲染时间为数
秒,因此 6 秒视频可能需要 10–30 分钟的总渲染时间。

简单地说

一个现成的 MP4 文件,内容是围绕
您场景的 旋转动画。非常适合社
交媒体、营销、展示。您可以设

置时长 (3–30 秒)、旋转方向和速
度。该文件可直接嵌入 YouTube、 
Instagram、PowerPoint 以及任何
其他地方。有时较慢,因为 应用必
须完整渲染每一帧 —— 对于 8K 视
频,根据 Gaussian 数量 可预计 5 到 
30 分钟。
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E9 — SfM Transforms (transforms.json)

位置

菜单栏 → Export → Photogrammetry → Export SfM 

(transforms.json)…。 大小: 通常 1–10 KB (仅位姿 

+ 内参,无图像, 无 Gaussians)。兼容性: nerfstudio、
Brush、gsplat、 OpenSplat、Meshroom、所有现代
前馈 3DGS 训练器。

技术细节

写出 nerfstudio 的 transforms.json  格式, 含一个
相机位姿列表加共享内参。每个相机的视图矩阵 
(RadianceKit 内部:World-to-Camera,COLMAP 约定) 
被求逆, 然后镜像相机本地的 Y 与 Z 基向量,以转换到 
nerfstudio 约定 (OpenGL 风格,相机沿 -Z  观察, +Y  
朝上)。最终的 4×4 矩阵作为按行嵌套的 Double 数组
写入每帧的 transform_matrix  字段。内参存储在顶
层 (焦距 x/y、主点 x/y、图像宽/高、 camera_​model = 
"OPENCV",加上畸变系数 k1, k2, p1, p2 ) —— 除非导
出器检测到多个不同的内参集,此时它们会按帧写入。 图
像路径相对于 JSON 文件写作 images/​<filename>;用
户必须 建立一个同级 images/​ 文件夹并放入训练照片。

简单地说

这个 JSON 文件描述了每张照片中
相机站在 哪里以及看向何处。文件
单独看很小且无用 —— 它需要与
原始图像 一起放在一个文件夹中使
用。Nerfstudio、Brush 和其他一些
训练器 正好读取这种格式,您可以
借此将 RadianceKit 的 SfM 结果交
给 其他工具,而无需在那里重新计
算相机重建。在大型场景中可节省 
数小时。

138 / 167



R A D I A N C E K I T 第 8 章 — 导出格式

E10 — COLMAP Workspace (sparse/0/)

位置

菜单栏 → Export → Photogrammetry → Export SfM 

(COLMAP Workspace)…。 大小: 三个二进制文件共
计通常 4–8 MB —— points3D.bin  占主导 (稀疏点云
的每个 3D 点一行), images.bin  和 cameras.bin  各

远小于 100 KB。 兼容性: COLMAP 本身、Nerfstudio、
Postshot、Meshroom、 任何期待 COLMAP sparse/​ 
目录的工具。

技术细节

写出标准 COLMAP sparse/​0/​ 布局, 包含三个二进制
文件: cameras.bin 、 images.bin 、 points3D.bin 。 
格式参考是 COLMAP 官方文档。 cameras.bin  包含去
重后的内参 列表 (具有相同内参 + 图像尺寸的相机会被
合并为单个条目); 使用的相机模型为 OPENCV  (Model 
4),包含 fx/fy/cx/cy 加四个 畸变系数 k1/k2/p1/p2。
images.bin  列出每张图像的位姿 ( wxyz  四元数加平
移),后接相机 ID 和文件名;不保存 2D-3D 对应关系。
points3D.bin  包含 SfM 点云,带位置、颜色 (0-255 

RGB) 以及重投影和轨迹长度的默认值。所有数据以
小端方式写入。 在 RadianceKit 中重新导入通过文件菜
单 →“Import COLMAP/Metashape Workspace…”完成 
(参见 SfM 后端章节中的 Q3)。

简单地说

官方的 COLMAP 格式。如果您要
在 Postshot、 Nerfstudio 或其他支
持 COLMAP 的软件中继续训练,
这就是路径。 三个小文件加上原
始图像,目标程序会像 COLMAP 本
身就是源 程序一样接受它。比 
transforms.json (E9) 被更多程序
理解, 但同时稍微不那么便捷,因为
是二进制而非文本。

何时选择哪种格式?

目标 格式

自有页面的 Web 查看器 E7 Web Viewer (.html)

使用 gsplat.js  的 Web 查看器 E6 Splat (.splat)

在 Postshot / Nerfstudio 中复用流水
线

E9 transforms.json + E10 COLMAP Workspace

SuperSplat 编辑 E1 PLY 或 E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

最大压缩 E4 SOG (需要 cwebp)

营销 / 社交视频 E8 Orbit Video
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快速对比

格式 扩展名 沙盒 大小 (1M Gauss) 最佳用途

E1 PLY .ply 是 ~250 MB 归档、最高 
兼容性

E2 Compressed 
PLY

.ply 是 ~40 MB Web + 
SuperSplat

E3 SPZ .spz 是 (gzip 子
进程)

~40 MB Niantic + 移
动

E4 SOG .sog 有条件 
(cwebp)

~20 MB 最大 压缩

E5 glTF .glb 是 ~250 MB Khronos 流
水线

E6 Splat .splat 是 ~32 MB gsplat.js 
Web 查看器

E7 Web 
Viewer

.html 是 ~45 MB 独立的 浏览
器文件

E8 Orbit 
Video

.mp4 / .mov 是 可变 社交/营销

E9 SfM Transforms .json 是 ~5 KB 位姿传递

E10 
COLMAP Workspace

目录 是 ~4–8 MB 位姿传递 (二
进制)

大小列是 100 万 Gaussians、SH 阶 3 的大致参考值。 真实值随场景的可压缩性变化;SH 阶 0 
会将 PLY/glTF 缩小约 4 倍。
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章

第 9 章 — SfM 后端

图 33  专家模式下检查器中带有 Camera Alignment 选择器的界面 (Apple Photogrammetry / 
Native (Beta))

图 34  Native (Beta) 已激活的检查器 — Camera Alignment 选择器选中 第二个选项,其他训练配
置参数均未更改

图中所示  检查器中的 Camera Alignment 选择器是一个分段控件,提供两个选项 — Apple 
Photogrammetry (App Store 构建的默认选项,完全符合沙盒要求) 和 Native (Beta) 
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(RadianceKit 自有的 FAST+BRIEF+GLOMAP 流水线后端,于阶段 3.8/3.9 开发,截至 2026 
年 5 月)。Native (Beta) 仅在环绕轨道场景中得到验证, 在 ≥1 000 帧时比 Apple 
Photogrammetry 更快,但尚未满足阶段 3 §5 质量门 (finalLoss ≤ 0.0115) — 因此带有 Beta 
标签。 来自 Metashape、COLMAP 或其他摄影测量软件的外部 SfM 结果可以 另外通过文件
菜单导入 (Q3 COLMAP 文本格式、Q6 Workspace 导入) — 选择器不会切换,但导入的位姿将
替换 SfM 结果。

SfM 是 Structure from Motion 的缩写。软件会根据一组 重叠的照片,为每张图像在共同的 
3D 坐标系中重建相机的位置和视线方向。 在此过程中会生成一个粗略的 3D 点云,用于初始化 
Gaussian Splatting 训练。SfM 结果是实际训练的输入,对后续的图像质量有决定性影响。

RadianceKit 提供五种 SfM 途径:两种内置后端 (Q1 Apple Photogrammetry、 Q4/Q5 
Native)、两种来自外部工具的导入路径 (Q3 COLMAP 文本格式、 Q6 二进制 Workspace 导
入) 以及 Q2 COLMAP 二进制 (仅在 App Store 之外 的 Developer 构建中可用)。哪种合适取
决于场景类型 (围绕物体的环绕、 室内、无人机飞行) 以及外部软件是否已经提供了重建。

Q1 — Apple Photogrammetry

位置

专家视图 → 检查器 → 训练配置 → Camera Alignment 
选择器,条目“Apple Photogrammetry”。

技术细节

封装了 Apple 内置的摄影测量框架,该框架最初 是为 
Object Capture 开发的。Apple 在内部通过专有流水线
提取特征 (步骤未公开),通过多视角匹配进行验证,并
在 Apple Silicon Neural Engine + GPU 上求解 Bundle 
Adjustment。该后端完全符合 App Store 要求 (无外部
二进制、Sandbox=true、设备端) ,但仅提供相机位姿 
和粗略点云 — 没有轨迹长度或重投影误差等诊断指标。
按 Apple 的建议,可扩展到数百张图像。在线性无人机飞
行或大型户外场景中 超过约 500 帧时,可重现地观察到
崩溃或单个相机被静默丢弃。

简单地说

这是最简单的方法。放入图像,应用
程序进行计算。 对于经典的物体扫
描效果非常好 — 例如您围绕一件
家具或一座雕塑 拍摄 50 至 200 张
照片时。但在拍摄风景的无人机

飞行或非常多的图像 (超过 500 张) 
时,Apple 的方法容易变得不稳定。
对于此类场景, 请测试 Native 后端 
(Q4/Q5),或者在 Metashape 中计算
相机 并通过 Workspace 导入 (Q6) 
加载。

高级用户

Q2 COLMAP 二进制 — 将外部 COLMAP 程序作为子进程启动,因此在 App Store 版

本 (沙盒) 中 不可用。仅在 App Store 之外 的 Developer 构建中工作。要获得 COLMAP 
提供的质量,App Store 版本中有 Workspace 导入 (Q3 或 Q6):在外部使用 COLMAP 或 
Metashape 计算 SfM,然后加载结果。
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Q3 — COLMAP 文本格式 (Metashape / ETH3D)

位置

菜单“File → Import COLMAP / Metashape 
Workspace…” (Cmd+⇧+I) 或拖放包含 sparse/​0/​
cameras.txt 的文件夹。

技术细节

读取标准化的 COLMAP 文本导出 — sparse/​0/​ 子文
件夹中的三个文本文件 cameras.txt 、 images.txt 、 
points3D.txt  — 并转换为内部 SfM 结果模型。格
式定义与 COLMAP 二进制导出相同,只是用 ASCII 
而非二进制。Agisoft Metashape、 RealityCapture、
PolyCam 以及 ETH3D 基准测试都以这种布局输
出。 解析器与二进制解析器共享相机模型检测 (所有
常见模型:SIMPLE_PINHOLE、 PINHOLE、OPENCV、
OPENCV_FISHEYE、FULL_OPENCV)。对注释行和空
行 具有鲁棒性。在测试中可扩展到约 1 400 个相机 
(ETH3D Tunnel) 而不出问题。

简单地说

如果您已经使用 Metashape、
RealityCapture 或其他商业照片 
3D 软件工作并导出了结果 — 
您可以将该导出 直接加载到 
RadianceKit 中,而不需要应用程序
自己重新计算。 这可以节省数小时
的等待时间。只需通过文件菜单加

载整个文件夹 或将其拖入窗口。
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Q4 — Native SfM (增量式)

位置

专家视图 → 检查器 → 训练配置 → Camera Alignment 
选择器,条目“Native (Beta)”。增量式是该后端的默认
模式 — 检查器中没有单独的 Mapper 选择器。通
过 CLI 可以使用 --native-sfm  或 --sfm-mapper 
incremental 显式设置模式。

技术细节

整套 SfM 流水线的自主 GPU 加速实现: FAST+BRIEF 
特征 或 通过 CoreML 的 SuperPoint+LightGlue (配
合 --coreml-features ),接着是 Hamming-KNN 匹
配、RANSAC 基础矩阵、轨迹构建、初始对选择、双
视图 Bootstrap (F→E 加 DLT)、 带 PnP 注册和多视角
三角化的贪婪增量 Mapper,最后是通过 Cholesky 求解
的 Schur 化简 Levenberg-Marquardt 加 Huber Loss 
和解析雅可比 的 Bundle Adjustment。完全符合 App 
Store 要求:无外部二进制、 Sandbox=true。配合阶段 
3.10 交付的 R2 崩溃检测器:如果应用程序 注册的输入帧
少于 60 %,或者每相机点数低于 13,则自动回退到 全局 
Mapper (Q5)。经验上在环绕/转盘场景上很干净;在更一
般的 运动 (无人机飞行、几何复杂的室内空间) 上成功率
较低 — 但检测器 会捕获这些情况。可可靠扩展到约 
200 个相机,更高需要明显更长的 运行时间。

简单地说

将 Apple 的优势 (App Store 兼容、
环绕拍摄快速) 与额外的诊断值
相结合。在您像做 Object Capture 
那样围绕主体行走时 特别有效。在
更复杂的拍摄 (无人机飞行或起居
室) 中,RadianceKit 会自动识别此
方法不奏效,并切换到全局方法。标
记为“Beta”, 因为仍在测试中 — 对
于简单的物体扫描,标准推荐仍然是 
Apple Photogrammetry,对于要求
较高的户外集则是 Workspace 导
入 (Q3 或 Q6)。
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Q5 — Native SfM (全局)

位置

当增量 Mapper (Q4) 触发崩溃检测器时 (注册的输入帧
少于 60 %,或每相机点数低于 13),自动调用。 仅可通过 
CLI --sfm-mapper global 手动强制启用。在检查器中, 
全局方法没有单独的选择器可访问 — 由应用程序自行决
定何时切换。

技术细节

原生流水线的全局变体。先进行 特征提取 + 匹配 (与 
Q4 相同),然后对所有已验证的对进行相对位姿 估计,接
着是旋转平均 (在世界坐标系中同步所有相机旋转) 和 平
移平均 (基于矩阵无关的稀疏公式的 LSQR,以避免在大
量相机时 出现整数溢出)。原则上可扩展到约 5 000 个
相机,但实际上超过几百 个相机后质量下降 — K-1351 上
的阶段 3.8 §5 验收门测量结果是 finalLoss 0.07,而目
标是 0.0115。被作为“回退层”:在增量 Mapper 退化时启
用,但本身不再接受质量检验。

简单地说

原生引擎的备用路径。当较快的增

量路径 失败时自动调用。能提供
可用的结果,但在非常大或困难的场
景中, 通常不如您从 Metashape 或
外部 COLMAP 安装中得到的那么精
确。 如果 Native 成为您的标准工
作流,在此类情况下值得绕道使用 
Workspace 导入 (Q3 或 Q6)。

Q6 — Metashape / COLMAP 文本 Workspace 导入 (阶段 Q7)

位置

文件菜单 → “Import COLMAP / Metashape 
Workspace…” (Cmd+⇧+I)。拖放包含 sparse/​0/​
cameras.{bin,txt} 和 images/​ 的文件夹。

技术细节

自动检测通过拖放或 Open 面板 选择的文件夹是否
符合三种 COLMAP Workspace 布局之一 (sparse/​0/​、
sparse/​ 或根目录),以及重建是二进制 ( cameras.bin ) 
还是文本 ( cameras.txt )。二进制路径使用 COLMAP 
二进制解析器,文本路径使用 ETH3D 加载器 — 两者
都生成 相同的 SfM 结果模型,流水线的其余部分 (导
入图像、启动 MCMC 训练) 与来源无关。图像通过
应用程序沙盒书签系统以 security-scoped 方式打开,因
此导入在 App Store 版本中也能工作。 特别针对“重
用 Metashape 导出而无需重新计算重建”的情况。 文件
菜单条目中提到的检测会在所选文件夹不是可识别的 
Workspace 时在应用日志中发出警告。

简单地说

专门面向 Metashape 用户的功
能。 如果您拥有 Metashape 或 
RealityCapture 的许可证并在那里
完成了 相机重建,您可以直接将导
出文件夹拖到这里并立即开始训

练。 在大型场景中可节省数小时
的计算时间,因为 RadianceKit 不会 
自己执行 SfM。
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何时使用哪种后端?

场景 推荐后端

物体扫描,50–200 张照片 Q1 Apple Photogrammetry

大型户外 / 无人机 / >500 张
图

Q6 Workspace 导入 (在 Metashape 或 COLMAP 中计算,然后
加载)

已有 Metashape/
RealityCapture 导出

Q6 导入 (无需 SfM)

ETH3D / 学术 COLMAP 文
本集

Q3 COLMAP 文本导入

严格符合 App Store + 环绕
场景

Q4 Native 增量

Q4 失败 Q5 Native 全局 (自动)

ETH3D 基准数据 Q3 (autotest precomputed)

快速对比

后端 App Store 沙盒 外部 二进制 最佳用途 最大 
~Cams

Q1 Apple 
PG

✅ ✅ — Orbit-
Object

~300

Q2 
COLMAP 

Binary

❌ (仅 
Developer 
构建)

— colmap/glomap Outdoor 
large

~5 000

Q3 
COLMAP 
文本导入

✅ ✅ — Bench rigs ~1 500

Q4 
Native 增
量

✅ ✅ — Orbit-
Object

~200

Q5 
Native 全
局

✅ ✅ — Q4 回退 ~1 351

Q6 Workspace 
导入

✅ ✅ — Metashape 
复用

按 来源
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章

第 10 章 — 新手模式

新手模式 (英文: Simple Mode,⌘1) 是为所有第一次重建 3D Gaussian Splatting 场景的用户
提供的引导式工作流。它不会显示 一整列检查器字段,而是带您依次完成四个步骤:首先导入照
片或视频 并选择质量预设,然后运行处理流程 (SfM + 训练),接着可以在 3D 预览中审视完成的
场景,最后导出为您需要的格式。窗口顶部的细长 进度条始终显示您当前所处的步骤。

与同时显示所有控制面板的专家模式 (⌘2) 相比,新手模式会隐藏未使用 的选项,在图像数量过
少或质量过差时给出校验警告,并且在每个步骤 只提供当前状态下有意义的按钮。您可以随时
在新手模式和专家模式之间 切换 (⌘1 / ⌘2) ,所有状态 — 已导入的图像、所选预设、正在运行 
的训练、完成的点云 — 都会保留,在另一个模式下立即可用。

Z1 — 导入 (选择图像与预设)

图 35  新手模式步骤 1 — 图像导入前的空拖放区,顶部面包屑导航 (导入 → 图像质量 → 相机 → 训
练 → 预览 → 导出),格式标签 JPG/PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP

图中所示  面包屑导航 (导入步骤激活) 显示四步工作流。左侧的拖放区带三个 CTA: “Browse 
Files” (NSOpenPanel)、“Try Sample Scene” (内置演示)、“Download Sample Photos 
(~427 MB)” (Mip-NeRF360 flowers 子集)。下方的格式标签 列出所有可接受的文件类型。右
侧 “Imported Files” 显示计数 “0 images” 与空状态 “No files imported yet”。底部为质量预
设选择器 (默认: Preview) 与 “Start Processing” (在没有图像时禁用)。
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第一步是给软件提供图像素材。可以通过将文件拖到中间大的虚线框中、 点击 “Browse Files” 
按钮,或点击随附的示例场景。右侧会出现一个列表, 显示所有已导入的图像及其分辨率与文件
大小;在下方的悬浮工具栏中, 您可以选择质量预设,并通过 “Start Processing” 启动流水线。校
验警告 (图像 < 3 张或 < 10 张时为红色,10–19 张时为橙色) 会提示您 软件是否预期能得到有
意义的重建。

C-01 ProgressIndicator (步骤进度条)

位置

工作流上方,始终可见。

技术细节

在整个流水线 (图像质量 → SfM → 训练) 上方显示 一条
水平进度条,各阶段所占比例为: 图像质量占 0–5 % (阶
段 3.11,非常短) 、SfM 占 0–30 %、训练占 30–100 %。 
旁边显示状态文本和按阶段命名的百分比 (“SfM 41 %”、 
“Training 12 500/20 000”),这样用户不会把表面上的回
退 “SfM 41 % → Training 25 %” 误读为错误 — 进度条
显示的是整个 流水线的进度,而不是子阶段。ETA 只有在
测得足够的训练速度后 才会开始计算 (通常在前 100 次
迭代之后)。专家模式中的同一进度条 也用于检查器上
方。

简单地说

顶部的细长条是您穿越工作流的地

图。 它不仅告诉您软件正在做什
么 (对齐相机、训练运行中 ……) ,还
告诉 您整体已经完成了多少。这种
分配是有意为之: 相机计算占据进
度条 的前三分之一,真正的训练占
据后两个三分之一 — 否则就会显
得 SfM 结束后进度突然回到零。所
以您可以放心地往后靠,看一眼这
条 进度条就能知道大致进度。旁边
的文字告诉您当前是处于 SfM 阶段 
(例如 “SfM 41 %”) 还是训练阶段 
(例如 “Training 12 500/20 000”), 
这样数字就不会令人迷惑。如果还

没看到 ETA,说明训练才刚开始 — 
软件需要先测到足够的速度才能给

出估计。

C-03 DropZoneView (拖放区域)

位置

导入步骤的左侧,大的虚线矩形带符号。在新手模式 中显
示标签 “Drop photos or a video here”。

技术细节

拖放区域,当拖拽项悬停在上方时,符号会短暂跳动 并
改变背景色。接受 JPG、PNG、TIFF、HEIC、MP4、
MOV、PLY、SPZ、 .splat、.radiancescene 包以及目
录。按类型路由: 图像被收集并按 顺序传入,视频触发
帧采样路径,Splat 文件直接打开预览,Scene 包 被读入。
目录被枚举,所有包含的图像都会被导入。安全范围书
签 (Security-scoped Bookmarks) 在沙盒环境下被正确
获取与释放。 不支持的扩展名会以警告横幅显示 5 秒。

简单地说

大的虚线区域是第一步的主控件。

直接把照片 或视频拖进去,或者整
个文件夹 — 软件会收下它认识的
所有内容, 其余的忽略。当区域变
蓝、图标短暂跳动时,说明软件识别
到了拖拽。 松手后导入立即开始: 
图像会进入右侧的列表,视频会自
动触发帧采样 步骤,而已经训练好
的 .ply / .spz / .splat  文件
会直接打开预览。 如果某个格式完
全不匹配 (例如 PDF 或 BMP),顶部
会出现简短提示 — 软件不会默默
吞掉未知素材。
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C-05 Browse Files 按钮

位置

拖放区域内,显著按钮。

技术细节

打开 macOS 文件对话框的按钮,支持多选,文件类型 为 
JPG、PNG、TIFF、MP4、MOV、文件夹以及软件自有
的 Scene 格式。 结果 URL 受安全范围保护,并通过与拖
放相同的导入路径转发。如果用户 选择了文件夹,会递归
枚举其中的图像。

简单地说

如果您觉得拖放不方便,只需点击
这个按钮, 在 macOS 文件对话框中
导航到您的照片。您可以同时选

择多个文件 (按住 ⌘ 点击单个图
像) 或选择整个文件夹 — 软件会递
归搜索文件夹 中所有支持的图像
类型。在拍摄文件嵌套在子文件夹

中时 (例如 “shoot-day1/”、“shoot-
day2/”) 特别方便 — 点击主文件夹 
即可。功能上这个按钮做的事和拖

放完全相同;选您觉得方便的方式即
可。

C-06 Try Sample Scene 按钮

位置

拖放区域内,仅在软件包内包含示例场景且尚未导入 图
像/Splat 时显示。

技术细节

仅在以下条件同时满足时出现: (a) 软件包中存在 
sample-scene.splat 、 .spz  或 .ply  ; 并且 (b) 还
未导入任何 图像/视频且没有点云。点击后会加载现成的
点云 (优先最小格式 — .splat  ~3 MB、 .spz  ~1.4 
MB、回退到 .ply  ),并在 400 ms 后 将相机硬编码到
示例场景原始元数据的位姿,以提供有美感的入场视角。

简单地说

如果您第一次启动软件,只是想看看
最终效果 是什么样 — 点这里。它
会打开一个已训练好的鲜花场景,您
可以立即 旋转和导出,而无需软件
进行任何计算。相机已预设到美感

视角,所以 您一开始就能看到漂亮
画面。在尝试自己的拍摄之前,这是
无风险体验 3D 操控和导出步骤的
完美方式。一旦您导入自己的图像,
这个按钮就会 自动消失 — 它只在
项目完全空白时才会显示。

C-07 Download Sample Photos 按钮

位置

拖放区域内,紧挨 “Try Sample Scene”;相同的 可见条
件。

技术细节

触发下载 (来自仓库 github.com/​bkindler/​
radiancekit-sample-photos),约 427 MB, 包含 960 
张全分辨率帧,并导入软件。下载期间按钮被禁用。进度
显示 在顶部进度条上,作为独立阶段标记 “Downloading 
X %” — 因为这个阶段保留自己的 0–100 % 刻度,不会
与后续的 SfM 阶段重叠。

简单地说

与示例场景相同,只是给的是源照片
而非最终 结果。这样您可以亲自运
行一遍完整流水线,看看 SfM 与训
练在您的 Mac 上实际花多长时间。
下载比较大 (大约半张 DVD = 427 
MB),但只 下载一次 — 之后照片就
在本地,您可以用不同预设任意重新
启动 流水线。下载过程中,顶部进
度条会显示百分比形式的当前下载

进度, 便于估计何时开始。建议使
用快速 WiFi 或有线网络 — 否则 
427 MB 拉起来会比较慢。
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C-09 Quality Presets 选择器

位置

导入覆盖层的悬浮底部工具栏,在开始按钮左侧。

技术细节

标签为 “Quality” 的控件,按类别 (Classic / MCMC / 
Custom) 分组可用预设。内置预设按类别分组;分段标题
硬编码。 自定义预设仅在存在时可见。锁定状态: 不
在免费列表 (Quick + Preview) 中的预设,若用户未购买,

名称后会带 “🔒” 后缀; 选中后选择器会跳回 Preview 并
自动打开购买窗口。选中时应用 预设,这会替换整个训练
配置。

简单地说

这里您选择软件计算的精度与时

长。“Quick” 和 “Preview” 无需购
买即可使用,几分钟内就能得到
初步结果 — 非常适合测试您的
图像是否有意义。“Balanced” 和 
“Quality” 需要 完整版,可显著提供
更干净的模型,但耗时从分钟变成小
时。MCMC 是 另一种策略,使用更
少的 Gaussian Splat — 当您想以
紧凑形式导出 模型或放到网上时
很合适。带小锁图标的预设是高级

预设;如果在未授权 时点击,选择器
会跳回 Preview 并自动打开购买窗
口。经验法则: 始终 先用 Preview 
启动,看一眼结果,再决定是否值得
跑更长的过程。

C-10 Start Processing 按钮

位置

导入覆盖层的悬浮底部工具栏,在预设选择器右侧。

技术细节

按钮在既无图像也无视频导入时保持灰色。点击后启动 
流水线,并将阶段状态机切换为 图像质量 → SfM → 训练 
顺序。按钮本身 没有进一步状态;正在运行的处理流程会
以独立的处理画面呈现。

简单地说

“开始” 按钮。只要它是灰的,就说
明还缺少 输入图像或视频。一旦您
拖入了照片,它就会变为可用,点击
它即可 依次启动 SfM 与训练。从
那一刻起软件接管整个流程,您会
自动跳到 处理画面 (Z2)。无需再做
任何点击 — 训练结束后软件才会
回到预览 画面 (Z3)。如果您改变主
意,之后还可以随时通过 Cancel 中
止。
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C-11 Video Sampling 滑块

位置

右侧图像列表,仅在导入了视频 (而非图像) 时可见。

技术细节

滑块范围 0.5 fps – 30 fps,步长 0.5。变更时会 更
新帧密度,并根据密度与视频长度计算目标帧数 (至
少 10 帧)。 滑块位于图像列表之外,因为列表项会阻
挡滑块的鼠标事件。 滑块下方显示计算出的目标帧
数 (“247 frames”) 与视频长度 (“1m23s video”)。工具
提示警告: “Doubling the density doubles the number 
of frames and increases SfM time by ~100%.”

简单地说

如果您导入的不是照片而是视频,这
个滑块 决定了软件从视频中提取多
少单帧。帧数越多 = 质量越好,但计
算时间 线性增长。对 30 秒的环绕
视频来说,5 fps (150 帧) 是不错的
起点; 对 1 分钟的拍摄,3 fps 通常就
足够。滑块下方实时显示当前设置

会 得到多少帧 — 这样您能立即看
到是否落入 100–300 帧的合理区
间。 如果结果不理想,将滑块右移
再试一次;但帧率翻倍,SfM 时长也
大致 翻倍。

C-12 Clear All 按钮

位置

右侧图像列表,右下角;仅在已导入图像时可见。

技术细节

红色按钮。点击会打开标题为 “Clear all imported 
files?” 的确认对话框,信息为 “N images will be 
removed.”。确认后 清空所有已导入的图像/视频、暂存
目录、点云、训练状态、SfM 结果 及所有缓存;阶段回
到导入。点 Cancel 则全部保留。对话框默认指向 非破
坏性路径 (破坏性按钮标为红色)。

简单地说

如果想彻底从头开始,点这里。确认
问题之所以 出现,是因为删除会丢
弃当前所有的导入,以及可能已经计
算出的相机 和训练结果 — 无法撤
销。当您想完全更换图像素材,或
在开始新项目 前清掉旧项目时,这
个操作合适。注意: 单独移除某一
张图像需要通过 右侧列表 (见下一
项),不是通过这个按钮。您硬盘上
的文件不会被 删除 — 软件只是丢
掉了对它们的引用。

C-13 File List ForEach (单图删除)

位置

右侧图像列表,每个条目。

技术细节

带左滑删除的导入图像列表。每张图像一行,显示 图标、
文件名、分辨率 (“1920 × 1080”) 与文件大小 (格式化
为 KB/MB)。分辨率来自元数据缓存,从图像头异步填充,
以避免阻塞 UI。 删除操作支持典型的 macOS 左滑删
除 (在某一行上用触控板向左滑动) 以及在选中行时按 
Delete 键。提示: 带显式减号按钮、Backspace 与 ⌘Z 
撤销的扩展图像删除路径仅在专家模式的项目导航器中

提供 — 新手模式里依然只是左滑删除。

简单地说

右侧的列表为每张导入的图像显示

分辨率与文件 大小 — 一眼就能看
出您是否把高分辨率与低分辨率素

材混在了一起。 要单独移除某张图
像,在触控板上用两指向左滑动 — 
就像 iOS 邮件那样 — 或选中后按 
Delete。软件不会删除文件本身,只
是把它 从当前项目中移除。如果您
想要真正的减号按钮或 ⌘Z 撤销,请
切换到 专家模式 (⌘2),那里的项目
导航器中有提供。新手模式中刻意

保持 简单的左滑模式。
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C-15 Validation Warnings (三级阈值)

位置

图像列表下方,Clear All 按钮上方。

技术细节

基于已导入图像数量的三级连续阈值 (仅在有图像 且无
视频时激活): - < 3 张图像: 红色横幅 (红色八角形),文本 
“At least 3 images are required. Camera alignment 
cannot be computed from fewer images.” - 3–9 张
图像: 红色横幅,文本 “With fewer than 10 images, SfM 
often fails and the trained scene tends to overfit 
[…]. 15–20 images minimum recommended; 30+ for 
object captures.” - 10–19 张图像: 橙色横幅 (警告三
角形), 文本 “Workable, but quality usually improves 
with 20+ images and good coverage around the 
scene.”

从 20 张图像起横幅消失。阈值硬编码,基于 560+ 次训
练实验的经验。

简单地说

软件会查看您导入了多少张图像,并
给出彩色 评估。红色意味着: 大概
率不会成功 — 要么 SfM 无法计算
相机, 要么训练会在过少素材上过
拟合。橙色意味着: 可能行得通,但
别指望 顶级质量,因为算法在图像
之间找到的重叠较少。没有横幅则

意味着: 条件良好,素材足够。如果
您想要真正干净的模型,目标定在围
绕主体 均匀分布的至少 30–50 张
拍摄 — 室外场景或大空间时可以
更多。 即便有警告您也能启动,但
不要惊讶于 SfM 无声中断或模型出
现破洞。

C-16 COLMAP Workspace 检测

位置

拖入文件夹时 — 不是可见按钮,而是识别逻辑。

技术细节

当拖入目录时,会检查其中是否存在三种典型 
workspace 布局之一: sparse/​0/​cameras.bin、sparse/​

cameras.bin 或根目录 直接 cameras.bin 。如果命中,
标准图像枚举被中止,而是打开模态 对话框,询问用
户是使用现有重建还是用 Apple Photogrammetry 重
新 处理图像。文本格式 workspace (cameras.txt) 与 
ETH3D 导出走相同 路径。详见第 9 章后端 Q6。新手
模式与专家模式效果相同。

简单地说

如果您之前用 Metashape、
RealityCapture 或 COLMAP 工作
过,并已在那里运行过相机计算,可
以直接把导出文件夹 拖到这里。
RadianceKit 会根据内容自动识
别它是 COLMAP workspace (检查 
sparse/​0/​、 cameras.bin  等),
并询问您是接管已有的计算 还是
自行重新计算。接管在大场景下可

省下数小时等待,因为 SfM 被 完
全跳过 — 训练立即开始。文本
格式 workspace (cameras.txt) 与 
ETH3D 导出也会被识别。该功能在
新手模式与专家模式中均可用; 更
多细节见第 9 章后端 Q6。

何时进入下一阶段?

当 (a) 至少导入了一张图像或一个视频,且 (b) 校验横幅为橙色或 消失时,即可点击 Start 
Processing。当横幅为红色时软件仍允许您 启动,但很可能很快就需要再次中止处理流程。建
议: 至少 20 张图像, 清晰,相邻拍摄之间有显著重叠,与主体距离大致相同。在启动前 选择一

152 / 167



R A D I A N C E K I T 第 10 章 — 新手模式

个与您时间预算匹配的预设 — 30 张图像配 Quick 预设几分钟 就能跑完,Quality 则更可能需要 
1–2 小时。

Z2 — 处理 (SfM + 训练)

图 36  Z2 SfM 阶段 — 大圆环中显示阶段图标 “Structure from Motion” 与 41 %,顶部状态条显
示 “SfM 25 %”,右下角 Cancel 按钮

SfM 阶段 (相机对齐中): 大进度环显示子阶段进度 (此处为当前 Apple Photogrammetry 会话
的 41 %)。状态文本 “Aligning cameras…” 在左上。面包屑导航将 “Cameras” 标为当前阶段。 
顶部状态条显示整体流水线进度 (25 %) — SfM 占据条的前半部分。 背景中漂浮的线框相机暗
示正在估计位姿。

图 37  Z2 训练阶段 — 阶段图标 “Training Gaussians” 与 6 %,顶部 实时指标 (Training: 
400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33s,底部 Pause/Cancel
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训练阶段 (Gaussian 优化中): 子阶段图标切换为 “Training Gaussians”,百分比按所选预
设计算迭代 (此处 400 / 5 000 对应 Preview 预设 = 阶段的 8 %)。实时指标行显示 Loss 值 
(0.1642)、 每秒迭代次数 (138.7 it/s) 与 ETA (33 s)。流水线整体进度在此阶段 从 50 % 攀升
到 100 %。Pause 按钮 (而非 SfM 阶段的仅 Cancel) 允许 之后 Resume;Cancel 则丢弃训练
结果并返回 Z1。

流水线一旦运行,软件就会隐藏导入覆盖层,显示全屏的处理画面。 中间运行一个大型进度
环 (220 × 220 像素),带阶段图标、状态文本 和百分比;背景中一段淡雅的 Splat 动画象征
性地可视化正在进行的 计算。左上方可展开信息面板,显示训练与 SfM 的实时指标。底部 提供 
Pause/Resume、Cancel,出错时还有 Retry 按钮。

C-18 SplatTrainingView (背景动画)

位置

进度环背后的全屏背景,中止或出错时隐藏。

技术细节

装饰性动画,根据流水线进度 (0…1) 渲染逐渐增多 的
小型动画 Splat 粒子。数据源是一个计算得到的进度
值,SfM 阶段 映射到 0–0.2,训练映射到 0.2–1.0 (图像质
量映射到 0–0.05)。 这样训练运行时 Splat 视觉上 “构
建” 起来。纯装饰性 — 显示并不 反映当前训练的真实中
间结果 (那是专家模式中的实时预览)。出现 Cancel 或
失败时隐藏,只保留状态环。

简单地说

背景中跑着一段由跳动点组成的小

动画,这样 计算期间画面不至于太
空。这不是您真正的 3D 模型 — 那
要在训练 结束后,在 Z3 步骤里才能
看到。但动画的密度变化与训练进

度类似, 您可以借此粗略感受训练
的推进程度。开始时只有少数点可

见,接近 结束时背景明显变得更密 
— 是百分比之外一个不错的视觉指
示。 如果动画让您觉得分心 (例如
想在后台同时做别的事),可以切换
到 专家模式,那里这个动画被去掉。

C-19 大进度环

位置

处理画面中央,220 × 220 像素。

技术细节

两个重叠环: 外圈是淡化的轨道环,内圈是填充的 进度环,
描边为强调色或红色 (出错时红色)。环内有阶段图标 
(训练 为大脑、SfM 为相机、视频抽帧为胶片、图像
质量为闪光) 、阶段 标题以及实时动画的百分比,使用 
32 点圆角字体。处理运行时图标 会轻柔脉动。显示以 
30 Hz 定时器平滑插值至当前真实进度 — 采用恒定爬升 
(0.0003/帧) 加比例分量 (差值的 4 %) 以及软上限 (设
定为下一个预期里程碑的 80 %, SfM 来自硬编码的里程
碑表)。 这样即便真实 SfM 更新每隔数秒才发生一次,进
度看起来也是流畅的。

简单地说

中央的大环是您在软件计算时的主

显示。它会 平滑地填充,即便真实
计算更新每隔几秒才到一次 — 给
您一种 “事情在发生” 的感觉,而不
是盯着一个冻结的百分比看好几分

钟。 中间的符号会变化,取决于当
前是抽取帧 (胶片图标)、对齐相机 
(相机图标),还是训练 Gaussian (大
脑图标)。百分比指的是当前 子步
骤 — 整体流水线进度看顶部的细
长条。出错时环会从蓝变红、 图标
停止脉动,这样您能立即注意到出问
题了。
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C-22 Info 按钮 (显示指标)

位置

处理画面左上角,32 × 32 像素。

技术细节

带材质背景的简单按钮。切换信息面板的显隐。 图标
在 Info 圆形描边与填充之间切换 (激活时为填充)。柔和
的淡入 动画。工具提示为 “Show detailed processing 
metrics”。

简单地说

默认情况下画面刻意保持简洁 — 
只看到那个 大进度环,其余信息不
显示。如果您作为技术兴趣较强的

用户想更精确 了解正在发生什么 
(哪一次迭代、Loss 是多少、有多
少 Gaussian), 就点击左上角的 i 图
标。底部会弹出一个小面板,显示所
有实时数值。 再点一次就收起。这
个设置不会持久化 — 每次新的训
练运行,面板 都会重新隐藏,这是有
意为之,以免让新手感到不安。

C-23 Info Panel (实时指标)

位置

处理画面左下,仅当 showProcessingInfo == true 时可
见。

技术细节

带超薄材质背景的两列面板。左列: 阶段特定的信息行 
— SfM 显示状态文本与百分比;训练显示迭代次数、合
并 Loss、L1 Loss、D-SSIM Loss、Gaussian 计数 (橙
色)、速度 (it/s) 、已用时间、 计算的 ETA、SH 度数与
学习率。右列: 状态文本、时间信息字符串、 内联 Loss 
图表 (见 C-28) 与可发现性提示 (见 C-32)。所有值都
从 训练状态中读取,每一次训练 tick 都会更新。

简单地说

信息面板显示所有实时数值,这些在
专家模式 下会持续显示在检查器侧
边栏中: 当前迭代、Loss 值 (越小
越好)、 Gaussian 数量、速度、估计
剩余时间、SH 度数与学习率。右
侧还跑着 一条极小的 Loss 曲线,可
一眼看出训练方向是否正确。当训

练变得 缓慢时,看这里会有帮助 — 
Loss 不再下降或 ETA 不再减少都
暗示 有问题。如果 Loss 爆炸 (突然
变得巨大) 或显示 NaN,说明训练已 
不稳定,Cancel + Retry 或切换到其
他预设会是合理选择。

155 / 167



R A D I A N C E K I T 第 10 章 — 新手模式

C-25 Pause/Resume 按钮

位置

底部导航栏,仅在训练阶段 (不在 SfM) 且处理进行中时
显示。

技术细节

带边框按钮。按状态调用 Pause 或 Resume。 标
签在 “Pause” (带暂停图标) 与 “Resume” (播放图
标) 之间切换。 SfM 阶段不显示该按钮,因为 Apple 
Photogrammetry 不具有暂停语义。 暂停状态完整保留
迭代、Gaussian 状态与优化器动量 — Resume 从 之前
停下的地方继续。

简单地说

训练运行期间,您可以随时暂停并稍
后继续。 当您想在 Mac 上同时做
其他需要大量 GPU 的事情 (例如视
频剪辑、 游戏测试或另一个软件的
渲染导出) 时会很有用。点 Pause、
做您的事、 再点 Resume,训练会
从原本的位置继续。迭代计数、

Gaussian 数量和 优化器动量都被
完整保留,暂停状态不会让您损失
任何质量。SfM 阶段 不提供 Pause 
— Apple Photogrammetry 没有暂
停功能,紧急情况下 只能用 Cancel。

C-26 Cancel 按钮

位置

底部导航栏,在处理 (SfM 或训练) 运行期间可见。

技术细节

红色带边框按钮。打开标题为 “Stop and discard 
progress?” 的确认对话框,按钮 “Discard Progress” 
(破坏性) 与 “Keep Running” (取消)。确认后会设置 
cancel 标志、结束训练任务、 必要时结束 SfM 子进
程,并在 JSONL 日志中写入带 cancel 状态的 summary 
行。与 Pause 不同,训练缓冲与状态会被丢弃。

简单地说

中止按钮。与 Pause 不同,这是最
终性的 — 如果之后想重新开始,处
理会从头跑,之前训练过的所有迭代
都会丢失。 当您预设选错了、训练
太慢,或者软件明显在产生垃圾结果
且您不想等 时,适合使用。在真正
中止前软件会通过确认对话框再问

一次,以免您 不小心损失数小时计
算。如果您只是想短暂中断,请改用 
Pause。
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C-27 Retry 按钮

位置

底部导航栏,在流水线失败时可见 (SfM 状态以 “SfM 
failed” 开头,或训练处于错误状态)。

技术细节

强调色按钮。重新启动整个流水线。启动前会检查 是
否仍有已导入的图像/视频。之前的错误日志保留在 
JSONL 目录中; 新的运行会以当前时间戳写入新的日志
文件。

简单地说

如果 SfM 或训练以错误信息中
断,可以在这里 重试。有时确
实有效,因为许多步骤 (RANSAC、
Densification) 含有 随机成分,第一
次失败时第二次可能成功。整个流

水线会重新从头跑 SfM 和训练,并
写入新的 JSONL 日志文件。如果
第二次仍然失败, 通常是输入图像
有问题 (数量太少、重叠太少、运
动模糊、光照差); 那时用 Back 返
回并更换素材。提示: 同时查看
训练日志 (Help → Open Training 
Logs) ,那里更详细地记录了具体在
哪一步 出问题。

C-28 内联 Loss 图表

位置

信息面板右列,仅在训练且历史非空时可见。

技术细节

紧凑绘图区域 (高 40 像素),将 Loss 历史作为 1 像素宽
的线条以强调色绘制。数据按有限值过滤 (NaN 保护, 针
对不稳定训练)。最小/最大值在整个历史上计算 — 因此
图表会 自动缩放到值域。最新 Loss 值显示在图表右上
方。历史本身在每次 训练 tick 时由软件状态积累 (通常
每 100 次迭代)。

简单地说

一条极小的 Loss 曲线,让您一眼看
到训练是否 “收敛” (线条向右下方
下降) ,或者是否卡住或爆炸 (线条
平直或上升)。 健康训练的曲线开
始陡降,然后逐渐变平 — 这是预期
的走势, 类似半衰曲线。图表会自
动缩放到当前值域,这样训练后期的
微小改进 也能保持可见。如果线
条突然蹿升或冻结,这是个不错的信
号,说明 出了问题 — 要么素材有问
题,要么换个预设更合适。该图表位
于 信息面板中,通过左上角的 i 图标
展开。

157 / 167



R A D I A N C E K I T 第 10 章 — 新手模式

C-32 可发现性提示 (专家模式提示)

位置

信息面板右列底部,仅在训练且新手模式下 可见。

技术细节

带眼睛图标的小一行,文本 “Switch to Expert Mode 
(⌘2) for live splat preview”,采用柔和色调与 10 点字
体。 非交互元素,仅作提示。点击无反应 — 用户必须实
际按 ⌘2 或点击 菜单 Mode → Expert Mode。

简单地说

一个含蓄的提示,告诉您在专家模
式下, 训练运行期间能在视口中实
时看到您 3D 模型的当前中间版本。
新手 模式刻意把这个隐藏,以保持
界面安静 — 但很多用户根本不知
道 有这个功能,所以我们在这里温
和地提一下。按 ⌘2,训练会在后台 
继续运行,您可以同时看着模型在眼
前逐步成形。这也是一个很好的 工
具,可以在几千次迭代后就估计结果
是否值得,或者是否应当中止 重来。
⌘1 随时把您带回新手视图。

何时进入下一阶段?

训练成功完成后,软件会自动切换到 Z3 (预览) — 您无需点击。 底部导航栏会从 Pause/Cancel 
切换为 Back 按钮 (返回到导入) 与 Export 按钮 (前进到导出)。出错时 (红色错误消息、阶段
图标为 X) 则显示 Retry,您需要决定是再启动一次,还是用 Back 回到导入 更换素材。

Z3 — 预览 (旋转 3D 模型)

图 38  新手模式预览步骤,带 3D 查看器
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图 39  Z3 训练完成后的预览 — 合成 Blender 花束已重建,顶栏显示 “Training complete — 
3,022 Gaussians in 13s”,底部 Back 与 Export 按钮

图中所示  面包屑导航将 “Preview” 标为 当前阶段。全屏 3D 视口渲染已训练完成的花束场
景 (合成 Blender 测试集,60 帧子集来自 960 张半球相机)。顶部状态栏: “Training complete 
— 3 022 Gaussians in 13 s” — 显示最终 Gaussian 数与训练时长。在视口中拖动可旋转相机 
(偏航/俯仰); 滚轮沿视线方向缩放。左下角 “Back” 按钮返回 Z2 用于 Resume 或 Re-Run;右
下角 “Export” 主按钮跳到 Z4。

训练完成后软件自动落入预览。这里您可以在全屏 Metal 视图中看到 您的最终 Gaussian 
Splatting 模型,并用鼠标和触控板旋转、缩放 和平移。视口上方覆盖一个小型控制面板,提供相
机控制与信息 — 自动旋转、训练统计、Reset 按钮。在进入下一步 (导出) 之前, 建议从不同角
度审视模型,以确认重建是干净的。

C-36 SplatViewportView (3D 主视图)

位置

预览步骤的全屏背景。

技术细节

基于 Metal 的 3D 视口,渲染完成的点云。 渲染器
是 RadianceKit 自己的 ForwardPass 光栅化器 — 即训
练期间已经用于渲染 Splat 的同一个 — 因此是真正的 
WYSIWYG (所训练的内容会被以完全相同的方式显示和
导出)。基于 tile 的渲染管线,具有顺序无关透明度。如果
渲染器无法初始化 (例如系统不支持 Metal) ,会改为显示
带 “Metal not available” 文本的黑色背景。 视图忽略安
全区,因此模型可延伸到窗口边缘。

简单地说

主视口。这里您看到自己照片重建

出来的最终 3D 模型,在 GPU 上实时
渲染。左键点击并拖动以旋转。滚

轮或 两指触控板手势缩放。右键或 
⌘+拖动平移。模型由数万个半透
明 3D 椭球 (“Gaussian”) 组成,以照
片真实感重建您的场景 — 每一个
都有训练学到的位置、方向、形状

和颜色。在 Mac 不支持 Metal 的极
少数情况下,您看到的是带提示信息
的黑色背景 — RadianceKit 严格需
要支持 Metal 的 GPU。
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C-37 CameraControlsOverlay (控制覆盖层)

位置

视口上方,悬浮。

技术细节

紧凑的 UI 覆盖层,包含自动旋转 (Turntable)、 Reset 相
机、背景选择 (Gray/Black/White)、Save Screenshot、 
切换 Info Panel 的按钮。绑定到相机参数 (距离、方位
角、俯仰、 目标、FOV) 并控制自动转盘。训练运行时 
(用户在专家模式下想看 视口同步) ,覆盖层会额外显示一
行紧凑的训练状态。

简单地说

模型上方的小悬浮栏。这里您可以

启动自动 旋转 (模型自动转动,适合
截图与短演示) ,通过 Reset 把相机 
重置到初始位置 (在您迷路时) ,切
换背景 (灰色用于中性、黑色 用于
最大对比度、白色用于明亮模型) ,
以及直接截图 (保存到  /Pictures) 。
在您想从特定角度展示某个细节时

很方便,无需把 整个模型导出。自
动旋转也是一个很好的测试,看模型
从各个方向 是否都好看,或者是否
有缺少拍摄导致的 “薄弱面”。

C-38 Export 按钮 (导航栏)

位置

Z3 中的底部导航栏。

技术细节

带标签 “Export” 和分享图标的强调色按钮。点击 触发
切换到 Z4。在此之前,父视图会检查是否解锁了完整版 
— 如未解锁,会显示锁定视图而非导出阶段 (见 U-06)。

简单地说

当您对结果满意时,点 Export 即可
进入最后 一步,选择格式并保存。
未购买完整版时,您会落入带锁屏提
示和 购买按钮的画面 — 软件不会
硬塞完整版给您,但导出是高级功
能 之一。完成购买后软件会以解锁
状态继续,您会直接进入熟悉的 导
出阶段。如果改变主意,可以通过 
Back 按钮回到预览继续把玩 模型。

何时进入下一阶段?

在导出前,完整旋转模型一圈并检查: 您在输入图像中覆盖到的所有 区域是否都存在?是否有漂
浮的 “Floater” (自由漂在空中的 Gaussian Splat 云) ?背景/天空看起来是干净的还是糊掉的? 
严重问题只能通过重新训练修复 — 通过更多图像、不同的预设, 或在专家模式中通过 Floater 
Reduction 设置。
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Z4 — 导出 (选择格式并保存)

图 40  新手模式导出步骤,带格式卡片

图 41  Z4 导出卡片 — 6 种格式 (PLY 742 KB 已选,SPZ 74 KB, glTF 708 KB,.splat 96 KB,Orbit 
Video,Web Viewer 133 KB), 右侧 Export History 显示已导出的 PLY

图中所示  面包屑导航将 “Export” 标为当前 阶段。左侧 “Choose Export Format” 卡片网格列
出全部六个选项: PLY (标准 3DGS,742 KB,含完整 SH 系数 — 此处带蓝色对勾被预选)、 SPZ 
(压缩 3DGS 格式,比 PLY 小约 90 %,74 KB)、glTF (带 KHR_​gaussian_​splatting 扩展,708 
KB)、.splat (通过 antimatter15 的 Web 查看器兼容,96 KB)、Orbit Video (场景的 360° 
MP4,实时计算 大小)、Web Viewer (带内嵌 3D 查看器的独立 HTML,133 KB)。 大小由当前 
Gaussian 数与格式开销实时计算。右侧 “Export History” 列出已完成的导出,带格式标签、文
件名与时间戳 — 点击在 Finder 中显示。左下方主 CTA: “Export PLY (3DGS Standard)” 并带 
Gaussian 副标题 “2,991 Gaussians · SH degree 3”。

在最后一步,您从 6 种导出格式 (PLY、SPZ、glTF、.splat、Orbit Video、Web Viewer) 中通
过两列卡片网格选择,点击 Export 并在 macOS 对话框中选择保存位置。右侧运行一个所
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有已完成导出的历史 列表 — 卡片选择时每张卡片下方立即显示估计文件大小,这样您可以 例如
在希望放上网时优先选 SPZ (小),在希望导入其他软件 (SuperSplat、Postshot、通过插件的 
Blender) 时优先选 PLY (大且完整)。

C-39 两列格式网格

位置

导出步骤的左侧主区。

技术细节

两个弹性列、12 点间距的卡片网格。遍历新手模式 所提
供的格式 — 是完整格式列表的过滤子集,只包含 6 个最
重要的 格式: PLY、SPZ、glTF、.splat、Orbit Video、
Web Viewer。 Compressed-PLY 与 SOG 仅在专家模
式中提供。

简单地说

一个带 6 种格式的卡片网格,
涵盖新手模式 下相关的选项: 
PLY (其他 3D 工具的标准格式)、
SPZ (用于 Web 的 压缩变体)、
glTF (官方 Web3D 标准)、.splat (用
于 antimatter15 的 Web 查看器)、
Orbit Video (可直接展示的 MP4) 
与 Web Viewer (自带内嵌 3D 播
放器的独立 HTML 文件)。这样您
能覆盖 90 % 的使用 场景。如
果您需要某种较少使用的格式 
(Compressed-PLY 或 SOG 用于 极
端压缩),请切换到专家模式,那里全
部 8 种格式都可用。这里的 紧凑选
项是有意的,以免新手被丰富的选项
吓到。

C-40 Format Card 按钮

位置

网格中的每张卡片。

技术细节

带卡片布局的简单按钮: 顶部图标 (例如 PLY 为文档
压缩、SPZ 为档案盒、Orbit Video 为视频图标)、格
式名作 标题、描述文字 (截至 2 行) ,下方为估计文件大
小 (由格式、Gaussian 数与 SH 度数实时计算,并格式化
为 KB/MB)。点击时选中该格式。 选中的卡片会获得
强调色背景、强调色边框,右上角带勾。工具提示 为格式
描述。

简单地说

每个格式一张卡片。点击其一,它
会以强调色 和对勾突出显示,下
方的导出按钮文字也会随之变化 
(“Export PLY”、 “Export SPZ” 等)。
每张卡片显示合适的图标、名称、

两行简要说明 以及当前训练结果
下估计的文件大小。大小有助于您

合理选择 — 如果想通过邮件发送
结果,选最小的变体 (通常是 SPZ 
或 .splat) ; 如果想在其他 3D 软
件中继续工作,选兼容性最好的格
式 (通常是 PLY) 。把鼠标悬停在卡
片上时,工具提示会给出更详细的描
述, 便于在您对格式差异不清楚时
参考。
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C-41 Video Duration 滑块

位置

格式网格下方,仅当选择了视频格式 (Orbit Video 或 
Social Video) 时显示。

技术细节

滑块范围 3–30 秒,步长 1 秒,绑定到软件状态中的 视频
长度。最大宽度 300 像素。仅当选中视频格式时显示。
在非视频 格式时滑块完全从视图中移除 — 没有死空间。

简单地说

如果您选择 Orbit Video 作为导出
格式, 可以在这里决定时长。3 秒 = 
非常快的旋转,30 秒 = 慢而安静地 
绕您的模型一圈。对社交媒体短视

频 (Instagram、TikTok) 来说, 通常 
6–10 秒是最理想 — 既足够展示模
型,又不会让观众跳过。 做演示或
作品集视频时不妨用 15–20 秒。该
滑块仅在选中视频格式时 出现;对 
PLY 或 SPZ 等文件格式它没有意义,
会被隐藏。

C-42 Export 按钮

位置

格式网格下方 (若选择视频则在 Duration 滑块下方)。

技术细节

大的强调色按钮。标签: “Export {格式名}”,带分享 图标。
点击时打开 macOS 保存对话框,带格式对应的扩展名
与默认文件名 “scene.{ext}” ;确认后将导出写入所选 
URL。在没有训练结果或已有 导出正在进行时禁用。

简单地说

点击、在 macOS 对话框中选择
保存位置, 完成 — 软件会以所
选格式将文件写入指定位置。默

认名为 “scene.{扩展名}” (例如 
“scene.ply” 或 “scene.spz”) ,您可
以在 对话框中自由更改后再保存。
按钮在没有训练结果时为灰色 (在
导出 步骤中不应发生,因为否则您
根本不会到这里) ,或在另一个导出 
正在运行时为灰色。导出运行时下

方会出现进度显示;软件保持可 操
作,您可以同时准备下一个导出。

C-43 Export Progress Bar

位置

Export 按钮下方,仅在导出运行时可见。

技术细节

进度显示,最大宽度 300 像素,下方为说明文字 
“Exporting… N %”。值从 0 到 1,并在写入期间更新 — 
PLY 按 10 000 Gaussian 一块更新,SPZ 在量化后一次
性更新,Orbit Video 按帧间隔更新。

简单地说

导出运行时您在这里看到进度条和

百分比。 PLY 通常几秒内就完成,因
为文件就是直接以二进制方式写

入。SPZ 稍长 一些,因为数据会被
量化和压缩。Orbit Video 是最耗
时的导出 — 每一帧都需要重新渲
染;视分辨率和长度而定,可能要一
分钟甚至 更久。导出期间软件保
持可操作,您可以同时准备下一个格
式,或在 视口中继续操作。
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C-44 Export Error Display

位置

进度条下方,仅在最近一次导出出现错误时可见。

技术细节

带警告图标和错误文本的红色一行。红色 8 % 背景 
透明度,圆角。最大宽度 400 像素。常见错误原因: SOG 
期望系统 PATH 中有 cwebp  (不符合 App Store) ;磁盘
已满时的写入错误; 保存目标位于沙盒许可范围外时的沙
盒错误。

简单地说

如果导出失败,这里会以红色显示
问题的简短 明文描述。原因通常
很直接 — 磁盘没空间、目标文件
夹无写入权限, 或目标位置在沙盒
许可范围之外。特别是 SOG 格式,
可能出现系统 缺少 cwebp  的情
况;此时 SOG 无法使用,您必须改用 
SPZ。如果错误 消息不清楚,请查看
日志目录 (Help → Open Training 
Logs),那里 更详细地说明了出错原
因。万不得已时,换一个保存位置常
有奇效 — 例如桌面。

C-46 Export History List

位置

导出步骤的右侧。

技术细节

导出历史列表 (持久化为 UserDefaults 中的 JSON, 每
次成功导出后维护)。每行显示格式徽章 (小,强调色)、
时间戳 (HH:mm)、文件名 (单行截断) 与格式化的文件
大小。点击某行会在 Finder 中打开并选中该文件。空状
态: “No exports yet”。

简单地说

您之前导出的列表 — 格式、时
间、文件名、 大小,按时间顺序排
列。点击某行,该文件会在 Finder 
中高亮显示, 您无需自己穿越文件
夹导航。当一小时后您还需要上一

个导出但忘了 保存到哪儿时很方便 
— 历史会记住这些。如果您从未导
出过任何 东西,这里会显示友好的 
“No exports yet” 提示。该列表能
在软件 重启后保留,因为它存放在 
UserDefaults 中。

C-48 History 上下文菜单 (右键)

位置

右键点击 History 行。

技术细节

每个列表项的上下文菜单含两个动作: “Reveal in 
Finder” (在 Finder 中选中该文件,与单击效果相同) 
与 “Copy Path” (将完整文件路径作为文本放入剪贴板)。
后者对拖入 其他软件或传递给命令行很有用。

简单地说

右键点击 History 条目会打开一个
小菜单, 含两个动作。“Reveal in 
Finder” 与普通单击一样 — 打开 
Finder 并选中文件,这样您立即就
能看到它。“Copy Path” 把完整文
件路径 放入剪贴板,这样您可以粘
贴到 Terminal 命令、其他软件或
笔记中。 当您想把导出转给别人,
或在使用路径输入的其他程序中打

开时 特别方便。功能上是小而有用
的细节,沿用了 Mac 典型的操作模
式。
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工作流何时算完成?

一次成功的导出之后,您的 3D 模型作为文件落到硬盘上,History 里多出一条记录。没有 
“Done” 按钮 — 您可以任意追加不同格式 的导出,无需重新训练。如果想回到预览 (例如再检查
一下某个相机 视角),用底部导航栏的 Back 按钮。如果想完全开始一个新场景, 通过 Back 一路
回到 Z1 并使用 Clear All,或通过 File → New Project (⌘⇧N)。

切换到专家模式

随时按 ⌘2 或选择 Mode → Expert Mode ( M8 )。所有状态都会保留: 已导入图像、所选预设、
运行中或完成的训练、完成的点云、Export History,甚至当前所处的阶段。专家模式中显示
的不是四步阶段, 而是带约 150 个控制面板的完整检查器侧边栏。特别地: 项目导航器 (见第 2 
章) 提供扩展的图像操作 (减号按钮、Backspace 删除、 ⌘Z 撤销、Quick Look 预览) ,训练运
行期间在视口中的实时预览, 以及所有 Loss、MCMC、Densification 与 Mip-Splatting 参数。 
⌘1 切回新手模式 — 同样不会丢失任何状态。

常见问题

为什么我的 Start Processing 按钮一直是灰的?

您还没有导入图像或视频。请至少把一份文件拖到拖放区,或者使用 “Browse Files”。一旦右侧
图像列表至少有一个条目,按钮就会激活。 (在仅有 1–2 张图像时虽然能启动,但 SfM 会直接以
错误终止 — 参见红色校验横幅。)

为什么我的 Export 按钮被锁定?

新手模式中有两个层级: (a) 当训练流水线还未完成且您没有结果时, 按钮被禁用 — 您必须先完
成 Z2。(b) 当您还未购买完整版 (PurchaseManager.hasAccess == false) 时,您看到的不是
导出阶段, 而是带锁图标和 “Unlock Full Version” 按钮的锁屏视图,它会打开 购买窗口。Quick 
与 Preview 预设可免费训练,但导出属于高级功能。

为什么我无法选择某个预设?

您可以选择 — 但如果在未购买完整版时点击高级预设 (Balanced、 Quality、MCMC 系列),选
择器会自动跳回 Preview 并打开购买窗口。 Quick 与 Preview 是唯一可免费使用的预设。

为什么我把图像拖入拖放区,它却仍然是空的虚线灰色?

很可能是 UTI 类型不匹配。软件接受 JPG、PNG、TIFF、HEIC、MP4、 MOV 以及软件自有

的 Splat 格式。其他图像格式 (BMP、GIF、WebP、 RAW 格式) 不被识别。如果您确信自己
的图像类型应当 被支持,请检查文件名扩展名 — 软件主要按扩展名,而非按文件内容 判断。

为什么我只有 30 张图像,SfM 却跑这么久?

Apple Photogrammetry 并不线性扩展 — 在某些图像组合 (带复杂 纹理的室内、运动模糊、
光照差) 下,所需时间远超图像数量预示 的程度。如果 SfM 在 30 张图像下 10+ 分钟仍未结束,
请中止并 更换更好的素材再试,或切换到专家模式尝试 COLMAP/Native SfM (⌘2 → 检查器 → 
Camera Alignment)。

在哪里能找到我的训练日志?
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Help → Open Training Logs (⌘⇧L)。这会打开 ~/​Documents/​RadianceKit/​Logs/​。每一次
训练会话都会写入一份 带时间戳文件名的独立 JSONL 文件 — 第一行是配置,其后每 100 次迭
代写一行 progress,最后一行是带最终 Loss 与 success 标志 的 summary。
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